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Picarro Notices 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product that 
has been designed and manufactured to provide reliable performance. 

This User Manual (UM) is an important part of your purchase as it will help familiarize you 
with the system and explain the numerous features that have been designed into it. 
Please read this manual thoroughly before using your Picarro system. 

Please contact Picarro or your authorized Picarro distributor should you have questions 
regarding specific applications or if you require additional information. 

DISCLAIMER AND RESERVATION OF RIGHTS 
Picarro has prepared this manual solely for the information and use by its customers as a 
guide for the selection, installation, operation, and maintenance of the products described. 

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO 
PRODUCTS, PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO 
DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE OR USE OF 
PICARRO PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Picarro reserves the right to change or update the contents of this manual and the 
specifications of its products at any time, without notice. Picarro has endeavored to include 
information that is current and accurate as of the date of the publication or revision of this 
document, but Picarro does not guarantee that this document is error free or that it is 
accurate with regard to any particular specification. 

Picarro expressly reserves all intellectual property rights, including all intellectual property 
rights relating to any product described in this manual. This document does not grant any 
license, express or implied, by estoppel or otherwise, to any intellectual property rights of 
Picarro or any third party. 

PATENTS 
The products described in this manual are subject to Picarro patents and patents pending. 
Information about Picarro patents applicable to these products is available at 
www.picarro.com/company/patents 

TRADEMARKS 
Picarro and the Picarro logo are trademarks of Picarro, Inc. 
ChemCorrect™ is a trademark of Picarro, Inc. 
Windows® is a trademark of Microsoft Corporation 
Swagelok® is the trademark of Swagelok Company 
Snoop® is a registered trademark of Swagelok Company 
. 
Copyright ©2024 Picarro, Inc. All rights reserved.

https://www.picarro.com/company/patents
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READ BEFORE USING THIS MANUAL 

This manual includes information on how to install the water analyzer in its most 
common configuration (analyzer with vaporizer). For other configurations (autosampler, 
SDM, IM, MCM, CWS), please refer to those manuals directly: 

• A0340 Autosampler User Manual (PN 40-0094) 

• A0325 Autosampler User Manual (PN 40025) 

• A0211 High-Precision Vaporizer User Manual (PN 40-0044) 

• A0214 MCM User Manual (PN 40022) 

• A0213 Induction Module-CRDS Setup User Manual (PN 40033) 

• A0101 SDM User Manual (PN 40-0005) 

• A0217 Continuous Water Sampler Installation and User Manual (PN 40-0003) 

Please note that the High Throughput Vaporizer was discontinued in December 2013. 
Picarro continues to support these vaporizers in the field, but they are no longer 
manufactured. If you require installation instructions for the High Throughput Vaporizer, 
please refer to an earlier version of this manual.  

For information on Picarro’s measurement technology, see APPENDIX E – Introduction 
to CRDS Technology. 

Be selective when following the manual by only referring to the sections relevant to your 
configuration of interest. To start, choose one of the setups in the table below based on 
your configuration. 

Refer to Table of Contents to find the location of any of the chapters described below. 

SETUP USE CASE SETUP CHAPTER 
Basic Water 
Analyzer 

This mode is used to 
measure ambient vapor 
which does not require 
any calibration with 
liquid standards. 

See section 4.5 Basic Water Analyzer 
Setup. This setup requires a CRDS 
analyzer.  

Dual Mode This mode is used for 
measurement of 
ambient vapor coupled 
with automated injection 
of liquid calibration 
standards. The 
measurement mode 
alternates between 
analyzing ambient 
vapor and liquid 

See section 4.6 Dual Mode Setup. 
This setup requires A0211 High 
Precision Vaporizer, A0912 Dual Mode 
Configuration hardware and software 
for vapor calibration and an 
Autosampler. This mode uses high 
precision method for liquid calibration. 
Each injection cycle takes 9 minutes. 
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SETUP USE CASE SETUP CHAPTER 
standards based on a 
user defined sequence. 

Manual 
Mode 

This mode is used for 
semi-automated 
measurement of liquid 
water samples with 
maximum precision. 

See section 4.7 Manual Mode Setup. 
The setup requires an A0211 High 
Precision Vaporizer. User manually 
injects samples after prompt. The 
control of the vaporizer and the analysis 
of liquid samples are automated. Each 
injection cycle takes 9 minutes. 

Picarro 
Autosampler 
and High 
Precision 
Vaporizer 
(A0211) 

This setup is used for 
automated injection of 
liquid waters. It consists 
of two modes that utilize 
the same hardware: 
High Precision Mode 
and High Throughput 
Mode. 

See section 4.8 Picarro Autosampler 
and High Precision Vaporizer 
(A0211) Setup. The setup can operate 
in five measurement modes: High 
Precision*, High Throughput*, 
Standard**, Express**, and Survey**.  
High Precision* (same as Standard 
Mode): Measures liquid water samples 
with maximum precision. Liquid 
samples are automatically injected and 
analyzed. Each injection cycle takes 9 
minutes. 
High Throughput*: Used for faster 
measurement of liquid water samples 
with good precision. Liquid samples are 
automatically injected and analyzed. 
Each injection cycle takes 4 minutes. 
High Precision and High Throughput 
Coordinator Modes operate in the exact 
same fashion except that the steps of 
sample preparation and analysis are 
faster in the high throughput 
coordinator mode. 
Standard** (same as High Precision 
Mode): Used to measure liquid water 
samples with maximum precision. This 
coordinator must be run in either the 
“iH2O N2” mode or the “iH2O Air” 
mode. Automatically injects and 
analyzes liquid samples. Each injection 
cycle takes 9 minutes. 
Express**: Used for faster 
measurement of liquid water samples 
with good precision. This coordinator 
must be run in either the “iH2O N2” 
mode or the “iH2O Air” mode. 
Automatically injects and analyzes 
liquid water samples. when using the 
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SETUP USE CASE SETUP CHAPTER 
Express coordinator, we recommend 10 
injections, the first 6 injections take 1.5 
minutes each, while the last 4 injections 
take 5 minutes each. The first 7 
injections will be discarded to achieve 
the optimal memory reduction. 
Survey**: Used for super-fast 
measurements of large sample batches 
at moderate precision and enables 
more efficient sample sorting. By 
manually rearranging samples 
accordingly, one can reduce the 
memory effect between adjacent 
sample. Automatically injects and 
measures liquid samples. This 
coordinator must be run in either the 
“iH2O N2” mode or the “iH2O Air” 
mode. 
*Only available without Coordinator 
software upgrade 
**Only available with Coordinator 
software upgrade 
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1. Introduction 

1.1 Intended Use 
The L2140-i isotopic water analyzer measures concentrations of δ18O, δ17O, δ2H 
and 17O-excess using Picarro’s patented Cavity Ring-Down Spectroscopy 
(CRDS).  

The L2130-i isotopic water analyzer measures concentrations of δ18O and δ2H.  

The analyzer can be deployed for monitoring applications in a lab or in the field, 
allowing in-situ analysis of trace and ambient amounts of isotopic water.  

 
NOTE 

In this manual δ2H is used to represent deuterium. However, δD may be found in 
the software or result files. 

1.2 System Overview 
Analyzer 
Figure 1 shows the analyzer front and back panels. More detailed information on 
panel features, functions, and connections are in section 4, Hardware 
Installation and Setup. 

 

Figure 1: L2140-i, L2130-i Front Panel 

Soft Power 
Button  

USB Port  
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Figure 2: L2140-i, L2130-i Back Panel 

A2000 Vacuum Pump 
The A2000 vacuum pump (Figure 3) is used to maintain cavity pressure inside the 
analyzer. The pump should be connected and running whenever the analyzer is in 
use. 

   

Figure 3: A2000 Vacuum Pump – Side Views 

  

Main 
Power PC and 

Communication Ports 

Sample Inlet and 
Vacuum Ports 

Com/Valve/ 
Optional Ports 

WLM 
Purge Port  
(optional) 
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1.3 Analyzer Specifications 
Table 1: L2140-i, L2130-i Specifications 

Parameter Specification 

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS) 

Weight: Analyzer 
Weight: Pump 

20.4 kg (45 lbs.) – Should be lifted by two people. 
A2000: 6.5 kg (14.4 lbs)  

L2130-i / L2140-i Analyzer 
Dimensions 

Depth: 44.5 cm (17.5”) 
Width: 43.2 cm (17.0”) 
Height: 19.1 cm (7.5”) 
Height without Feet: 17.8 cm (7.0”) 

Dimensions – A2000 Pump Length: 34.5 cm (13.6”) 
Width: 15.5 cm (6.1”) 
Height: 22 cm (8.7”) 

Ambient Humidity Range < 85% RH non-condensing 

Ambient Temperature Range Vapor Sample: -10 °C to 45 °C (14 °F to 113 °F) 
Liquid Sample & System Operation: 10 °C to 35 °C 
(50 °F to 95 °F)  
Storage: -10 °C to 50 °C (14 °F to 122 °F) 

Maximum Altitude  
(During operation) 

3,048 m (10,000 ft) 

Front/Rear Clearance Front: 15.3 cm (6”); Rear: 15.3 cm (6”) 

Sample Pressure 300 to 1000 torr (40 to 133 kPa) 

Sample Flowrate ~40 sccm at 760 torr (101 kPa) 

Required Accessories Included: Pump (external), keyboard, mouse 
Supplied by Customer: LCD monitor 

Operating System 
Data Outputs 

Windows 10  
RS–232, Ethernet, USB, Analog (optional) 0-10 V 

L2130-i/L2140-i Power 
Requirements 
Startup Power 
Steady-state Power 

100 – 240 VAC; 50/60 Hz (auto-sensing) 
<375 W at start-up, (analyzer and pump) 
120 W (analyzer) 
150 W (A2000 Pump) 

Minimum Rated Circuit 
Current (Amperes) 

10A @ 115 VAC 
5A @ 230 VAC 

Liquid Ingress Protection None 
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1.4 Acronyms 
This manual includes various acronyms. For definitions, see below:  

Table 2: Acronyms, Formulas, Units, and Symbols 

Acronym Definition 

atm. atmosphere; unit of pressure, equal to atmospheric pressure at sea level. 
1 atm. = 14.69595 psi (101.325 kPa)  

cm centimeters  

CRDS Cavity Ring-Down Spectroscopy  

CWS Continuous Water Sampler 

DAS Data Acquisition System (the analyzer) 

DIO 

Digital Input and Output Between the analyzer and the autosampler. DIO 
Tells the Autosampler to prepare for an injection, and to perform an 
injection. Additionally, DIO is the place where the autosampler notifies that 
an injection has been made. 

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm) 

GUI Graphical User Interface  

H2O Water, Water Vapor 

IM Induction Module 

kPa Kilopascal; unit of pressure; 1 kPa = 0.145 PSI 

MCM Micro-Combustion Module 

mm millimeters  

OD Outside Diameter 

ppb parts per billion  

ppm parts per million  

PSI (psi) Pounds per Square Inch 

RH Relative Humidity 

SCCM Standard cubic centimeters per minute 

SDM Standards Delivery Module 

SST Stainless Steel 

UM User Manual 
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Acronym Definition 

WLM 
Purge 
Port 

Wavelength Monitor Purge Port. The Port on the analyzer the dry gas 
connects to. This keeps the spectroscopy accurate. 

“ (as in 
1/4”) Inches 

°C Degrees Celsius  

‰ Per mil 

1.5 Text Conventions 
The following conventions are used in the manual. 

• Italic text identifies screen names and emphasizes important text or certain 
features. 

• Bold Italic text identifies section reference links. 

• Bold text is for actions to take (such as clicking on a UI button), caution 
and warning statements, and text you should type or select in screens. 
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2. Safety 

2.1 Warning Symbols 
Icon notes and warnings are used throughout this manual. The purpose of these 
icons is to provide a visual convention to alert you of essential information. They 
indicate dangers to either the operator or to the analyzer, and other important 
information. 

Table 3: Warning/Information Icon Types 

Icon Description 

 
NOTE 

NOTE is important information that you should be aware of before 
proceeding. 

 
WARNING 

LASER WARNING alerts you of a laser danger. 

 
DANGER 

DANGER indicates an imminently hazardous situation that, if not 
avoided, will result in death or severe injury. 

 
WARNING 

WARNING indicates a potentially hazardous situation which, if not 
avoided, could result in death or severe injury. 

 
CAUTION 

CAUTION alerts user of a potential danger to equipment or to the user. 

 
WARNING 

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to 
electrical energy that is high enough to cause injury or death. 

 
CAUTION 

HOT SURFACE alerts user to potential injury from hot surfaces. 

 
REMINDER 

REMINDER is a helpful hint for procedures listed in the text. 
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2.2 General Safety 
CDRH Certification 
This Picarro analyzer complies with 21 CFR Chapter 1, sub-chapter J, and is 
classified as a Class 1 laser system when all panels and covers are on. 

CE Certification 
This Picarro analyzer complies with European safety standards and the 
instrument is affixed with a CE label. This CE label is located on the back panel of 
the instrument. 

• CE: IEC EN61010-1:2010 (safety) and EN61326-1:2013 (EMC) 
requirements for electrical equipment for measurement, control, and 
laboratory use. 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result in damage to 
the analyzer and render it unsafe to operate. 

 

 
WARNING 

The analyzer is for indoor use only and has an ingress protection rating of IPx-0. 
It is NOT protected against exposure to water including dripping, spraying, 
splashing or immersion. 

 

 
WARNING 

Do not operate in an explosive atmosphere! Do not operate in the presence of 
flammable gases or fumes.  

 

 
CAUTION 

This analyzer contains no user-serviceable components except the particulate 
filter, A0211 Vaporizer injection port septum, CPU fan, and A2000 vacuum pump 
diaphragms and valves. To order user-replaceable parts and access video 
replacement instructions, see section 17, Maintenance.  

Do not attempt other repairs; instead, report all problems to Picarro Customer 
Service or your local distributor. Please contact Picarro if you have any 
questions regarding the safe operation of this equipment. 

 

 
CAUTION 

Do not replace the mains supply power cord with an inadequately rated cord. 

 

 
WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 
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CAUTION 

Equipment Damage: Exceeding gas inlet pressure or temperature specifications 
could result in damage to the instrument. In the case of higher input pressure or 
flow, configuring a sampling bypass manifold system is recommended. 

Use a ‘tee’ at the gas inlet and exhaust the remainder of the gas stream 
appropriately. 

 

 
WARNING 

The inlet gas connector on the back panel of the analyzer, and its immediate 
vicinity, runs hot during operation of the analyzer. Take care when connecting 
gas lines or working at the rear of the instrument to wear protective gloves or 
avoid contact with these surfaces. 

 

 
CAUTION 

Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum 
line, or the AC power to the External Vacuum Pump while analyzer is operating. 
Damage may be caused by current surges if power is applied while attaching or 
removing cables. 

 

 
WARNING 

This analyzer weighs 20.4 kg (45 lbs). Use the technique described below (or 
follow your local regulations) when lifting the analyzer. 

a. Before lifting, inspect the unit for slippery substances or sharp edges. 
b. Lift with two people, one on each side of the analyzer. 
c. Crouch down and stay close to the unit. Always keep your back as 

straight as possible.  
d. Position your feet for sturdy balance. Lift with your legs, not your back.  
e. Do not twist the back while carrying the unit. Rotate direction with hip 

joints.  
f. Lower the unit by bending at the knees.  

2.3 Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an embedded 3B 
laser in accordance with EN 60825-1:2014. Do not to open the enclosure where 
this label is placed; there are no user serviceable parts inside. 

The following Laser Safety Label is affixed to the outer cover of the analyzer. 

 

Figure 4: Laser Safety Label – Affixed to Outside Cover of Analyzer 
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WARNING 

The laser is a Class 3B when exposed.  
Only operate or service this device in accordance with the instructions in this 
guide, and only open the device in an approved laser safe service area using 
appropriate laser-safety glasses. 

The following Laser Safety Label (Figure 5) is affixed to the inside of the 
analyzer: 

 

Figure 5: Laser Safety Label – Affixed to Inside of Analyzer 

 
WARNING 

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure. 
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3. Unpacking 

3.1 Inspect the Shipping Boxes 
Picarro products are inspected and tested before leaving the factory. Their 
packing containers have been designed to keep the equipment safe from damage 
during transit. 

Inspect the condition of the boxes upon arrival. The larger box includes the 
analyzer and most of the accessories. Even if the outer box shows damage, the 
inner box holding the analyzer will protect the instrument under most 
circumstances. 

If the equipment is damaged, photograph the damage and contact Picarro (email 
pictures if possible) as soon as possible. 

 
NOTE 

Keep all packing materials so the instrument can easily be returned Picarro (if 
necessary) or transported to another location. 

3.2 Unpack Components 
While unpacking each shipping box: 

• Inspect each item to ensure it is not damaged.  

• If items are missing, contact Picarro. 

• Keep the shipping materials to reuse when transporting the analyzer. 

• Contact Picarro for options on transporting systems to remote labs. 

 
WARNING 

The analyzer weighs 20.4 kg (45 lbs). Use the technique outlined on Page 23 
when lifting or moving the analyzer.  
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Figure 6: L2140-i, L2130-i Shipping Box Contents 

Table 4: Box One: Analyzer and Accessories 

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, and 
communications hardware and firmware to perform all 
gas handling, spectral collection, and analysis. 

AC Power Cable (1) A power cable with connectors appropriate to your 
country is provided. Note: The analyzer automatically 
adjusts to local voltage.  

Nut (1) and Ferrules (2) For connecting input line to analyzer gas INPUT.  

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

Keyboard and Mouse (1) Set, Keyboard & Mouse Combo (Monitor not included) 

USB Flash Drive (1) Contains backup software. 

Spare Fuses (3) 5x20, 6A, 250V 

Document Packet (1)  Includes this user manual and certificate of compliance. 

USB 
Backup 
Software 

Analyzer 

A2000 
Pump to 
Analyzer 
Vacuum 
Hose 

A2000 Vacuum 
Pump 

User Manual 
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Table 5: Box Two: A2000 Vacuum Pump and Accessories 

Item (qty) Description 

A2000 Vacuum Pump (1) Provides vacuum required for sample gas sequencing 
into and out of the analyzer. 

AC Power Cable (1) A power cable with connectors appropriate to your 
country is provided. 
Note: The vacuum pump voltage must be selected. 
See Pump Voltage Setting in section 4.4.  

Pump Manual (1)  Detailed instructions for pump. 
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4. Hardware Installation and Setup 

4.1 Items/Tools Required 
• Analyzer and accessories included in shipment 

• Pump and accessories included in shipment 

• Peripherals and accessories included in the shipment according to your 
order 

• 5/8” open end wrench 

• 11/16’’ open end wrench 

• Power cords for analyzer, pump, and peripherals 

4.2 Installation Safety 
Read this safety section in its entirety before proceeding. 

 
WARNING 

Two-person lift required: The analyzer weighs 20.4 kg (45 lbs). When lifting the 
analyzer, use the technique described on page 23 (or follow your local 
regulations).  

 

 
CAUTION 

When the analyzer is being integrated to an external system, the safety of that 
system is the responsibility of the assembler of that system.  

 

 
WARNING 

Equipment Damage: Do not attach electrical power to or start the analyzer until 
after attaching and turning on the External Vacuum Pump. Do not disconnect the 
vacuum line while the analyzer is running. Failure to do so could result in 
damage to the optics. 

 

 
WARNING 

Picarro sells certain USB enabled devices, such as GPS, which are approved for 
use. Do not connect USB hubs or unauthorized USB devices (except flash 
drives, mice, and keyboards) to the USB ports. Unauthorized USB devices may 
interfere with the normal functioning of the analyzer. 

 

 
Warning 

When using compressed gases, follow all appropriate safety conventions, 
including use of eye protection, physical restraint of cylinders, etc. 
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CAUTION 

Lines connected to the 1/4” Swagelok sample inlet connector must not exceed 
5 PSIG of pressure. Picarro recommends 2 to 3 PSIG of pressure. 

 

 
CAUTION 

During installation, do not position the analyzer so that it is difficult to operate 
the electrical disconnecting device (such as an emergency off (EMO) switch or 
breaker). 

 

 
CAUTION 

When working with hazardous gases, remove the pump exhaust muffler, adapt a 
tube to the vacuum pump exhaust port and direct the exhaust to a safe place for 
venting the mixture of sample gases. For instructions, see APPENDIX C – 
Setting up Contained Exhaust Flow. 

 

 
CAUTION 

Use the AC power cables supplied with the analyzer or a similarly rated cable. 
Check with Picarro technical support if you have questions about power cable 
replacement. An inadequately rated power cable can result in equipment 
damage. 

 

 
CAUTION 

Cords shall be RATED for the maximum current for the equipment and the cable 
used shall meet the requirements of IEC 60227 or IEC 60245. Cords certified or 
approved by a recognized testing authority are regarded as meeting this 
requirement. The connector type used should be: IEC320 C13. 

 

 
CAUTION 

Equipment Damage: It is imperative that the analyzer have adequate ventilation 
and/or cooling to maintain the ambient temperature below 35 °C when operating. 
Do not place the pump or the instrument in any enclosure without providing 
adequate forced air flow. 
Do not plug or block any perforations in the chassis of the instrument. Do not 
put anything near the instrument that will impede the air flow. Failure to provide 
adequate airflow, especially clearance at the front and rear panels, to ensure 
proper airflow and/or cooling to the analyzer will result in overheating of the 
analyzer causing a shutdown and potential damage. There should be 6” (15 cm) 
of clearance in the front and back of the analyzer. 

To determine if the ventilation is adequate in an enclosure, monitor the temperature of 
the air near the instrument and adjust ventilation so that the ambient temperature is 
within specification. As a guide, the ambient temperature of the air around the 
instrument cannot exceed the specifications listed below. 

Thermal Specifications Min Max Description 

Ambient Operating 
Temperature 

10 °C 35 °C Worst-case environmental limits 
(unless otherwise specified) 
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CAUTION 

If the analyzer has been stored at less than 10 °C (50 °F), allow the components 
to equalize to room temperature before starting the installation process. 

4.3 Ventilation Considerations 
The instrument and pump require adequate ventilation in order to function 
properly. Do not plug or block any perforations in the chassis of the instrument. 
Don’t place anything near the instrument that will impede the air flow.  

4.4 Pump Voltage Setting 
Set the A2000 vacuum pump input voltage to the correct level for your area by 
rotating the voltage selector switch located on the side of the pump next to the 
fuse holder (Figure 7). 

 

Figure 7: Vacuum Pump Voltage Selection 

4.5 Basic Water Analyzer Setup 
This basic water analyzer mode is used to measure ambient vapor which does not 
require any calibration with liquid standards. This setup includes an L21x0-i 
analyzer, A2000 pump, and related accessories.  

Refer to Figure 8 through Figure 10 below. 

1. Remove the analyzer and the external vacuum pump from their 
respective shipping containers. 

2. Place the analyzer on a cart or table. 

3. Place the external vacuum pump near the analyzer on a cart, table, or 
on the floor. 

4. Unpack the analyzer accessories (vacuum line, manual, and certificate 
of compliance).  

Store the certificate of compliance in a safe place. It may be required if 
you contact Picarro for service or questions. 

Input Voltage Selector 
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5. Remove the caps from the analyzer SAMPLE inlet and VACUUM 
connection ports. Save the caps so they can be reinstalled when the 
analyzer is stored, moved or shipped.  

6. Remove the caps from the pump vacuum inlet. Save the caps for reuse 
in case the analyzer and pump is stored, moved, or shipped. 

7. Connect the provided vacuum line between the analyzer port labeled 
VACUUM and the pump vacuum inlet (Refer to Figure 8). 

Hand tighten the nut, then make an additional 1/4 turn with an 11/16” 
wrench. 

8. The exhaust port of the external vacuum pump has a muffler attached 
for noise reduction. If desired, attach a tube to the pump exhaust port 
and direct it to a safe place for venting the mixture of sample gases for 
air/N2 and H20. For instructions, see APPENDIX C – Setting up 
Contained Exhaust Flow 

9. Connect a monitor to the HDMI monitor port on the analyzer’s back 
panel. Once powered up, the analyzer will detect the connection and 
adjust the resolution to match the monitor. 

10. Connect a mouse and keyboard to a pair of USB ports. 

11. Check that the A2000 pump voltage input switch is set correctly. 

12. Ensure the power switch on both the analyzer pump are set to OFF. 

13. Attach the power cable to the analyzer and pump.  

This completes the basic analyzer installation. 

 
NOTE 

The analyzer has a universal power supply that automatically adjusts to power 
sources ranging from 100-240 VAC, 47 to 63 Hz, 10 A max. 

 

 
NOTE 

The A2000 pump does not automatically adjust to power sources. If using the 
A2000 vacuum pump, ensure its input voltage is set to the correct level for your 
area by rotating the voltage selector switch located on the side of the pump next 
to the fuse holder (see Figure 7). 
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Figure 8: Basic Water Analyzer Setup with A2000 Pump 

Sample Gas Inlet Connection (SST Tubing) 
If your analyzer is supplied with connectors for stainless steel tubing, follow these 
steps. 

1. Use 1/4” OD SST tubing and connector sets to connect from sample
source to the sample inlet.

2. Place the two ferrules inside the nut as shown below.



Hardware Installation and Setup   

L21x0-i Inst/Op Manual  P/N 40035 Rev. G 33 

 

Figure 9: Orientation of Inlet Nut and Ferrules 

3. Loosely connect the nut to the INLET on the back panel of the analyzer, 
being careful not to let the ferrules fall out. 

4. Insert the tubing into the back of the nut and through the ferrules, 
feeding it in as far as possible without deforming the tubing. 

5. Hand tighten the nut. 

6. Using a 9/16" wrench (not included), tighten the nut 1-1/4 turns. 

When reconnecting SST tubing: 

1. Inspect the ferrules. If you see any damage, replace the ferrules and 
follow the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer 
sample inlet. 

3. Using a 9/16" wrench, tighten the nut 1/6 of a turn (60°). 

Electrical Connections 
Refer to Figure 10 and its callout list below for connection points. 

 

1 

2 

15 14 13 9 16 12 

 

11 

4 

10 

6 

8 9 

5 

18 

16 17 

3 

7 
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1. External Vacuum Pump Port 
2. Gas Sample Inlet 
3. WLM Purge Port (optional) 
4. USB 3.0 Ports (4 qty.) 
5. Display Port 
6. HDMI 2.0 Monitor Port 
7. COM 2 Port 
8. COM 1 Port 
9. DVI-I Video Monitor Port 

10.  USB 3.0 Ports (2 qty.)  
11.  Ethernet Ports – RJ-45 (2 ea) 
12.  Audio In/Out Ports 
13.  AC Power Input and Power ON Switch 
14.  Valve Control Port (Solenoid valves) 
15.  DIO (Only for PAL autosampler connection) 
16.  COM 3 Port (Connected but typically not used.) 
17.  Analog EIC Output (Optional upgrade) 
18.  USB for Logic Board (Not connected) 

Figure 10: Annotated Back Panel Diagram 

4.6 Dual Mode Setup 
Refer to Figure 11, Figure 12, and Figure 13 below. 

Dual mode is used for measurement of ambient vapor coupled with automated 
injection of liquid calibration standards. The measurement mode alternates 
between analyzing ambient vapor and liquid standards based on a user defined 
sequence. 

Dual Mode setup requires an A0211 High Precision Vaporizer, an A0340  (or 
A0325) Autosampler, and A0912 Dual Mode Configuration hardware and 
software for vapor calibration. Dual mode uses a high-precision method for 
liquid calibration. Each injection cycle takes 9 minutes. 

1. Carefully unpack the peripheral boxes and prepare the facility.  

2. Review the section, Installation Safety before proceeding .  

3. Install the analyzer and its external vacuum pump per the instructions in 
sections 4.1 through 4.5). 

4. Install the Autosampler and Vaporizer.  

Refer to the Installation chapter in the A0340 Autosampler User Manual 
(PN 40-0094) or A0325 Autosampler User Manual (PN 40025) for 
detailed installation instructions.  

5. Attach the vaporizer switching valve assembly to the vaporizer inlet 
ports labelled Purge and Sample 2 (Figure 11 and Figure 12). 

6. Attach the switching valve wire pair to the connector with the red/white 
wire pair that is attached to the Vap Valves cable connector. 

7. Attach the Zero Air gas line  (shown as copper line in Figure 11) to Tee 
section of the vaporizer switching valve assembly. 

8. Sampling tubing for measuring ambient water vapor should be 
connected to the top of the solenoid valve with the intake line routed 
outdoors. 
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Figure 11: Vaporizer Switching Valve Assembly Connected to Vaporizer 

 

Figure 12: Connections to Back of Vaporizer 

From Zero Air dry gas 
source, (Zero Air is used 
for Dual Mode for ambient 
measurements). 
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Figure 13: Dual Mode Setup and Connections (Vaporizer Switching Valve 
Included) 

 

  

Vaporizer 
3-way 
Switching 
Valve 

Cable Assembly 
for Vaporizer 
Valve and 
Switching Valve 
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4.7 Manual Mode Setup 
Refer to Figure 14 below. 

This mode is used for semi-automated measurement of liquid water samples with 
maximum precision. 

The setup requires an A0211 High Precision Vaporizer. The user manually 
injects samples after prompt. The control of the vaporizer and the analysis of 
liquid samples are automated. Each injection cycle takes 9 minutes.  

1. Inspect the boxes of Picarro products before opening. Carefully unpack 
the boxes and prepare the facility.  

2. Please review the important safety notes before continuing on with the 
installation. See the section, Installation Safety.  

3. Install the analyzer and its external vacuum pump per the instructions in 
sections 4.1 through 4.5). 

4. Place the vaporizer on top of the analyzer using feet of 0.5” (13 mm) 
thickness to set it to the appropriate height. Align the Inlet port 
(analyzer) with the delivery port of the vaporizer. 

5. Attach a (N2 or Dry Air) Gas line to the vaporizer and the analyzer (see 
section 5, Water Analyzer Dry Gas Supply Setup). 

6. Attach the hose at the vaporizer’s vacuum port and connect it to the 
second External Vacuum Pump. Attach the power cable to the External 
Vacuum Pump, but keep the power switch off. 

7. Connect the vaporizer and the analyzer using a Valve Cable and the 
gas delivery port from the vaporizer (see VAPORIZER TO ANALYZER 
CONNECTIONS). 

8. Check the Power Connections to the Machines: Make sure all power 
cables are attached to the power outlets on the analyzer, Vaporizer, and 
two External Vacuum pumps. However, keep the power switch off.  

9. Carefully slide the complete system into position: Small movement of 
the components relative to one another is OK. However, do not overly 
force the system. Check for obstacles if the unit does not slide easily.  

10. Plug all the power cables (including the one for the monitor) into a 
power supply. Switch ON the components in the following order 

a. External Vacuum Pumps (for both the analyzer and the 
vaporizer). 

b. Everything else. 
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Figure 14: Manual Mode Setup and Connections 

4.8 Picarro Autosampler and High Precision Vaporizer 
(A0211) Setup 
This setup is used for automated injection of liquid waters. It consists of two 
modes that utilize the same hardware: High Precision Mode (same as Standard 
Mode) and High Throughput Mode. 

Refer to Figure 15 below. 

1. Inspect the boxes of Picarro products before opening. Carefully unpack 
the boxes and prepare the facility.  

2. Please review the important safety notes before continuing on with the 
installation. See SAFETY.  
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3. Install the analyzer and its External Vacuum Pump (see analyzer and 
Vacuum Setup). 

4. Install the Picarro Autosampler (see Installation | Picarro Autosampler 
chapter in the A0340 Autosampler User Manual (PN 40-0094) or A0325 
Autosampler User Manual (PN 40025).  

5. Supply dry gas to the analyzer (see WATER ANALYZER DRY GAS 
SUPPLY SETUP). 

6. Carefully slide the complete system into position: Small movement of 
the components relative to one another is OK, as the units are well 
locked. However, do not overly force the system: check for obstacles if 
the unit does not slide easily. 

7. Power up the system: Plug in all the power cables (including the one for 
the monitor) into the appropriate power supply. Switch ON the 
components in the following order: 

a. External Vacuum Pumps (for both the analyzer and the 
vaporizer). 

b. Everything else  

 
NOTE 

The software to operate the instrument will start automatically after the 
operating system has loaded. The user interface will appear a few seconds after 
the instrument software starts. See “Startup Procedure” in section 7 Basic 
Operation. 

 

 
NOTE 

As the instrument is starting up, it is normal for there to be a delay in reporting 
data. This can take several minutes depending on how long it takes for the 
internal temperature to reach its operating point, and it is normal during this 
time for some concentration readings to be negative or constant.  

Additionally, the data selection pull down menus will not be populated with the 
appropriate items until data is being reported in the graph. This is typically less 
than 30 minutes, but depending on ambient temperature, the analyzer can take 
up to 2 hours to stabilize. 

 

 
NOTE 

Remember that for the SDM operation, the Vaporizer temperature should be set 
to 140°C. For all the other coordinator modes, the temperature should be set to 
110°C. 
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Figure 15: Picarro Autosampler-High Precision Vaporizer Setup and Connections 
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5. Water Analyzer Dry Gas Supply Setup 
The Picarro L2140-i and L2130-i analyzers each can work in many configurations, 
allowing a wide application of the analyzer. This section describes how to set up 
the dry gas supply for all these configurations. Find the section in this chapter that 
relates to your setup and then complete the dry gas supply installation steps.  

• Manual Mode Setup: See Dry Gas Configuration A 

• Picarro Autosampler – High Precision Vaporizer (A0211) Setup: See 
Dry Gas Configuration A 

• Picarro Autosampler – High Throughput Vaporizer (A0212) Setup: 
See Dry Gas Configuration B 

• Basic Water Analyzer Setup:  No dry gas supply necessary 

• Dual Mode Setup: See Dry Gas Configuration C 

• Induction Module Setup: See A0213 Induction Module to CRDS Setup 
User Manual (PN 40039) 

• SDM Setup: See A0101 Standards Delivery Module CRDS Setup User 
Manual (PN 40-0005) 

5.1 Dry Gas Configuration A 
Refer to Figure 16: Dry Gas Configuration A. 

You will need a dry gas supply for the analyzer and the vaporizer. You can 
purchase the pressure regulator kit numbers A0921 or A0923 from Picarro. If you 
have already purchased a dry gas kit from Picarro, you will need the following 
additional supply.  

• Dry gas supply of 10-60 psi (4 bar), which is stepped down to 2.5 psi 
before being connected to the CRDS analyzer.  

 
NOTE 

The A0921 regulators come with CGA connectors, which may not be compatible 
with gas tanks used in your region. 

Below, you will find a complete part list and diagram on how to connect dry gas to 
the water analyzer.  

1. Attach the (N2 or Dry Air) Gas Line to the analyzer: Attach a Gas line 
from the “WLM Purge” Port on the analyzer to the N2 Regulator, which 
connects to a (nitrogen or dry air) gas cylinder.  

2. To connect 1/4” dry gas tube to the Wavelength Monitor Purge (WLM 
Purge) Port on the analyzer, use the Push Connector that is attached to 
the port. The connector is in two pieces: The Outer Flap and the Inner 
Flap.  

https://store.picarro.com/A0921-N2-Dry-gas-kit-for-Lxxxx-analyzer
https://store.picarro.com/A0923-Zero-air-dry-gas-kit-for-Lxxxx-analyzers
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3. To connect the tube to the port, simply push the tube into the connector 
and then pull the tube back. If there is a space between the inner flap 
and the outer flap, this means that the tube is locked to the port. Do not 
twist and turn. To take the tube out of the port, push the Outer Flap in 
against the Inner Flap, and while doing this, pull out the tube. This will 
cause the gripping mechanism to release from the tube.  

 

1. Q1-14B-580 Air Liquide Scott Regulator 
2. SS-OGM2-S2-A Swagelok Toggle Valve  
3. SS-T2-S-028-20 Swagelok 1/8" OD stainless steel tubing 
4. SS-200-3 Swagelok 1/8" stainless steel Tee union 
5. SS-400-R-2 Swagelok 1/8" (adapter fitting) to 1/4" (tube fitting) Reducing Union 
6. 5033K31 McMaster-Carr 1/4" OD PTFE tubing 
Additional tools and parts are required, some others recommended. For the complete list, 
click the following link. https://picarro.box.net/shared/static/r19c3z8etk.pdf 

Figure 16: Dry Gas Configuration A 
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https://picarro.box.net/shared/static/r19c3z8etk.pdf
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4. Attach the Gas (N2 or Dry Air) Line to the Vaporizer: Using either output 
from a (nitrogen or dry air) gas cylinder (should be at a pressure of 2.5 ± 
0.5 psig (0.17 ± 0.03 bar)) or from the gas supply/regulator, attach the 
gas line to the open third leg of the gas line that connects the vaporizer 
purge and the sample ports (that is shipped connected to the vaporizer). 

 
Above is an N2 Regulator: The semi-transparent tube on the left is routed to the ‘WLM Purge” 
Port on the analyzer. The copper-colored tube on the top left comes from the ‘Purge’ and the 
‘Sample’ ports on the Vaporizer. The copper-colored tube on the bottom right goes to the (N2 
or Dry Air) Gas Cylinder. 

Figure 17: Gas Regulator 

 
 
 

Figure 18: Vaporizer and Analyzer Connections 

Gas and electrical connections 
at rear of vaporizer  

WLM purge port located 
at analyzer back panel 
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5.2 Dry Gas Configuration B 
The gas connection for the Dual Mode setup is similar to the Dry Gas 
Configuration A except that it also has a Vaporizer Switching Valve. Follow the 
Dry Gas Configuration A, but also connect the Vaporizer Switching Valve to the 
back of the Vaporizer according to the schematic and images below. 

           

Figure 19: Dry Gas Configuration B 

Vaporizer 3-way 
Switching Valve 

Cable Assembly 
for Vaporizer 
Valve and 
Switching Valve 
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Figure 20: Vaporizer Switching Valve Connected to Vaporizer 
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5.3 Dry Gas Configuration C 
For the SDM setup, you only need to supply dry gas directly to the CRDS 
analyzer (Figure 21). 

  

 

Figure 21: Dry Gas Configuration C 

To connect a 1/4” dry gas tube to the Wavelength Monitor Purge (WLM Purge) 
Port back of the analyzer, use the Push Connector attached to the port.  

The connector is in two pieces: The Outer Flap and the Inner Flap. To connect the 
tube to the port, simply push the tube into the connector and then pull the tube 
back.  
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If there is a space between the inner flap and the outer flap, this means that the 
tube is locked to the port. Do not twist and turn. To take the tube out of the port, 
push the Outer Flap in against the Inner Flap, and while doing this, pull out the 
tube. This will cause the gripping mechanism to release from the tube.  

Wavelength Monitor Purge Defined 
Why do the Picarro isotopic water analyzers (L21x0-i) have a wavelength 
monitor (WLM) purge?  

The WLM purge acts to fill the warm box of your analyzer with dry gas. The warm 
box houses the WLM which is part of the analyzer’s laser targeting control loop. 
The WLM itself enables us to precisely control the wavelength of light being 
injected into the cavity. Within the warm box there is a distance of about 10 cm 
which is an open path, i.e., the laser light is seeing the ambient atmosphere at 
45°C (the temperature at which the warm box is held). Because water is such a 
strong absorber, and in the case of our isotopic water systems, the laser is 
specifically tuned to a frequency of water absorption, this open path segment may 
result in decay of the light prior to entering the WLM. As a result, the performance 
of the WLM could vary as ambient conditions change. We elect to dry the gas 
seen by the laser in the warm box such that any potential decay due to water 
absorption is limited.  

Should I always have dry gas purging the WLM or can I leave it open? 

At ambient temperature and pressure, drying the gas that enters the WLM is not 
essential; however, it is recommended for humid environments and does require a 
significant amount of gas. If you have access to a zero air or N2 tank, such as the 
tank being used as the dry gas source for your vaporizer (High Precision or High 
Throughput Vaporizer), we recommend adding a T to the line and feeding both 
your vaporizer and WLM purge with the same dry gas source. You can also 
purchase a dry gas kit from us with the necessary regulator and fittings to connect 
a N2 tank (part # A0921) or zero air tank (part # A0923) to your system. If you are 
operating your analyzer in a very humid environment, such as above 3% water 
content (30,000 ppm), we always recommend dry gas be supplied to your WLM 
purge. Without this dry gas supply, you may experience more drift in the analyzer.  

Does the gas used for the WLM purge need to be the same as matrix gas for 
the cavity? 

No, the gas that is used to purge the WLM can differ from the matrix gas seen by 
the cavity. Picarro isotopic water analyzers have two modes of operation; air and 
N2 (use the “Picarro Mode Switcher” to switch between the two). If, for example, 
you are using the SDM and operating in air mode, you can use N2 to purge the 
WLM. The opposite is also fine. If you’re running from a tank, you’ll typically use 
the same gas for convenience.  
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6. Vaporizer to Analyzer Connections 

6.1 Valve Controller Cable 
Attach the 15 pin end of the grey valve cable to the port labelled Vap Valves on 
the vaporizer and connect to the port labelled VALVES on the analyzer (third 
connector from the left at the bottom row of the analyzer). 

6.2 Gas Line Connection 
1. (With Autosampler): If an Autosampler is integrated with your system, 

carefully align the analyzer and the autosampler relative to each other 
such that the gas delivery line hanging from the vaporizer is aligned with 
the inlet port of analyzer. Do not bend the delivery port in the process.  

If the delivery port is not horizontally aligned with the analyzer inlet port, 
gently move the position of the vaporizer on the autosampler by loosening 
the mounting clamps and retightening them after alignment. 

2. (Without Autosampler): If an Autosampler is not used with your 
system, attach the feet to the vaporizer underside or place an object 
under to level the vaporizer outlet connection to the analyzer inlet.  

3. Follow the images below and connect the gas line from the vaporizer to 
the analyzer as follows. 

a. Remove the insulation box.  

b. Remove the Philips screws of the insulation box visible in Figure 
22 (two on each side) and remove the box to allow for easier 
connection to the analyzer inlet.  

c. Attach the connector to the analyzer inlet and tighten, making 
sure the 1/16 line goes nice and straight into the aluminum guide 
(this will become clear to the installation technician with the 
insulation box removed.)  

d. Move the vaporizer forward, leaving enough space to reinstall the 
insulation box. 

e. Install the insulation box, then carefully push the autosampler (if 
used) and/or vaporizer forward so that there is no gap between 
the insulation around the vaporizer outlet and the analyzer.  
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Figure 22: Vaporizer to Analyzer Sample Port Initial Connection 

 

 

Figure 23: Tightening Vaporizer to Analyzer Connection 

 

Before connecting, 
remove Insulation Box 
(two screws each side). 
This allows for easier 
access when making the 
connection. 
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7. Basic Operation 
This section explains how to operate the analyzer using the GUI. It describes system 
startup, shutdown, and recovery procedures, desktop features. GUI Functions are 
detailed in section 9, CRDS Data Viewer Functions. 

Before continuing, review the important safety notes in the Safety section. 

 
CAUTION 

If one accidentally over-saturates the instrument with water, it is very important 
to NOT turn the instrument off. Rather, let the instrument pull either room air or 
dry air/ N2 through for a few days to dry out the cavity until the instrument can 
make normal measurements again. If the instrument is turned off right after the 
accident, water will condense and contaminate the cavity rendering it useless 
with a very costly cavity repair required for the instrument to operate correctly.  

 

 
CAUTION 

Always turn on the external pump before powering up the analyzer. This ensures 
a safe start-up sequence. Failure to do so could result in damage to the cavity 
optics. 

7.1 Startup 
1. Make sure the pump vacuum hoses are connected between the 

analyzer and its pump, and the Vaporizer and its pump. 

 
CAUTION 

Always turn on the external pump that is attached to the analyzer before 
powering up the analyzer. This ensures a safe start-up sequence. 

2. Verify the power cables to vacuum pumps are plugged in. 

3. Switch power on at the pumps. 

4. Verify the power cable to the analyzer is plugged in. 

5. At the analyzer back panel, press the main power switch to the ON (“I”) 
position. 

6. If needed, press the round Soft Power button on the front panel. The 
indicator LED will illuminate green. 

The software will start automatically, and the analyzer will display a CRDS 
Software Loading Status window (Figure 24), then the CRDS Data Viewer 
window (Figure 25) once loading is complete. Data Viewer features are 
detailed in section 9.1.  
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Figure 24: Startup; Software Loading Sequence 

The analyzer will not begin producing data until the cavity temperature and 
pressure have reached their operational set points. A message will be displayed 
in the Status Log window of the data viewer (see Figure 25, bottom panel) when 
each set point is reached. An explanation of the most common status log 
messages can be found in section 9.10, Analyzer Status Log. 

In the case of the L21x0-i analyzer, these are 80°C and 50 Torr. Warm up 
typically takes about one hour. By design, the cavity pressure will not start to 
decrease until the cavity temperature is close to its set point. Ideally, the analyzer 
is open to room air during the warm up, i.e., there is nothing attached to the “Gas 
Inlet” on the rear of the analyzer. This is desired because ambient water vapor will 
provide a good signal for the Picarro Wavelength Monitor (WLM) which provides 
the frequency control for the spectral measurement.  

 
NOTE 

The WLM purge is an optional feature and is not required. It is recommended 
when operating the instrument in a humid environment. For more information, 
see section Wavelength Monitor Purge Defined. 
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If the analyzer is without a signal for a prolonged period of time (i.e., it is left on 
dry gas for multiple hours to days), the frequency axis of the analyzer can get lost 
resulting in incomplete spectra. If you notice an increase in measurement interval 
or data drop outs after a period of idle time on dry gas, simply disconnect and turn 
off your dry gas source. The instrument will stabilize after a period of measuring 
room air. 

Data will be saved automatically once the analyzer starts to produce data. The 
data in the GUI is the continuous real time read out from the analyzer. User data 
is stored in: 

C:\Userdata\DataLog_User \YYYY\MM\DD, where Y=year, M=month, D=day. 
Further details can be found section 13 File Management. 

 

Figure 25: GUI/Data Viewer Screen 

7.2 Shutdown 

 
CAUTION 

A flow of clean, relatively dry gas should always be directed to the instrument 
for several minutes prior to shutting down. Trapping a high-moisture content 
gas sample in the cavity can cause condensation damage to the mirrors as the 
instrument cools from its operating temperature. 
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CAUTION 

Equipment Damage: If you accidentally over-saturate the instrument with water, 
it is important that you do not turn the instrument off. Instead, let the instrument 
pull either room air or dry air/ N2 through for a few days to dry out the cavity - 
until the instrument can make measurements normally again. If the instrument is 
turned off right after the accident, water will condense and contaminate the 
cavity rendering it useless. 

 

 
CAUTION 

Do not turn off the pump or disconnect the vacuum line while the instrument is 
operating. 

 

 
CAUTION 

If you have trouble turning off the analyzer software, do not use the Windows 
Task Manager to kill the process(es). Instead, double-click on the “Stop 
Instrument” icon in the Diagnostics folder on your desktop and select the default 
option to stop the software with the drivers running. See Figure 26 below. 

Flow Clean, Dry Gas 
1. With the pump still running, switch to a source of clean, dry gas at the 

sample inlet and allow it to run until the water channel reading on the 
GUI falls below 0.2% (2000 ppm). This will prevent any damage from 
condensation to the cavity surfaces. This dry gas may be from a tank 
(target 2-3 PSIG pressure) or from a desiccant column like the Drierite 
column, C0360, sold on store.picarro.com). 

Shutdown 
2. Click on the Shutdown button located on the left side of the Data 

Viewer window. 

3. A window will pop-up (Figure 26) prompting the user to confirm the 
shutdown. Once confirmed, the analyzer software and hardware will turn 
off. (Note: If three options are given on an older instrument, choose the 
“For Shipment” option.) 

4. Manually turn off the pump(s) and dry gas (only if system requires it). 

 

Figure 26: Shutdown Confirmation Pop-Up Dialog 
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After clicking Yes to confirm, the analyzer software, then the computer 
OS will shut off after a few minutes. Leave any dry gas or desiccant 
attached to the inlet during this process. 

5. When the instrument fans audibly turn off, and when the green power 
button light on the front of the instrument turns off, shut off the pump(s) 
manually from the rocker switch located on the pump. 

7.3 Analyzer Restart after Electrical Power Outage 
If power to the analyzer is cut-off for any reason the analyzer will cease operation. 
However, when the power is reapplied, the analyzer will restart automatically, the 
Picarro software tools will properly close out previous files and open new files for 
data collection so that previously collected data, instrument diagnostics and other 
parameters recorded up to the time of power outage are retained. 

If short power outages are common in the user location, Picarro recommends 
using an uninterrupted power supply (UPS) to protect the data stream and the 
health of the cavity. 

7.4 Desktop Icons and Folders 
The following icons and folders related to analyzer operation are populated on the 
Windows desktop. 

 

 

     
Example only: number varies by analyzer 

model. 

 

Figure 27: Desktop Icons and Folders 
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Desktop Icons 
• Autosampler: Launches the Autosampler UI software for managing 

sample processing tasks. 

• Start Instrument: If the instrument software is already running, this 
restarts the software. If the instrument software has been shut down, this 
starts the software. 

• Coordinator Launcher (not present on all configurations): Clicking on 
this icon opens a window that allows you to choose the proper coordinator 
to operate peripheral modules on certain analyzers.  

• Picarro Mode Switcher (not present on all configurations): When 
clicked, a window opens (Figure 28) that allows you to switch between 
various measurement modes. Most analyzer models are configured for 
one mode and may not include the Mode Switcher. If the analyzer has 
multiple modes, this allows the user to switch between them easily. 

 

Figure 28: Picarro Mode Switcher 

• Picarro Controller: When clicked, opens a useful diagnostic panel 
(Figure 29 below) allowing the user to see the analyzer’s internal 
temperatures, pressure, and spectroscopy in real time. This program has 
user-accessible functions but should not be used to change instrument 
parameters without the direction of Picarro support.  

 

  

Available L21x0-i 
Measurement 
Modes 
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Figure 29: Picarro CRDS Controller Window 

• Picarro Computer Icon: The Windows Computer Icon is renamed to the 
analyzer serial number. 

• Data file Viewer: When clicked, a window opens that allows you to 
convert between *.dat and H5 data files and to make various graphical 
representations of your data over time periods longer than what is 
available in the software buffer. The instructions on using the Data File 
Viewer software are described in APPENDIX B – Data File Viewer. 

Switching Between Measurement Modes 
The Picarro Mode Switcher allows users to operate the analyzer in various 
modes. Switching between measurement modes is accomplished with a few easy 
steps: 

1. Activate the mode switcher interface by double-clicking the Picarro 
Mode Switcher icon on the desktop (Figure 28). 

2. To switch modes, click the drop-down menu, select the desired 
measurement mode, and then click the launch button. 

3. Confirm your selection when prompted by the confirmation dialog box. 
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4. The analyzer software will then re-start in the new measurement mode. 
There is no need to turn off the vacuum pump(s) or any other 
peripherals during this process 

Post-Process ChemCorrect 
ChemCorrect software is now included in all Picarro water isotope analyzers. The 
software allows post-acquisition analysis of discrete sample data generated by the 
coordinator. For more information, see section 12 ChemCorrect™ Software. 

Picarro Utilities Folder 
• Data Recal: When clicked, a window opens that allows you to recalibrate 

your data based on known, certified data. 

• Setup Tool: When clicked, a window opens that allows you to edit various 
settings for your analyzer (See APPENDIX A – Setup Tool and 
Communication for information. 

• Data file Viewer: (see above) 

Diagnostics Folder 
• Stop Instrument: When clicked, a window opens that allows you to turn 

off the analyzer in an emergency event. Upon clicking on this icon, the 
following window will pop up. Please see section 7.2, Shutdown to shut 
down the analyzer under normal circumstances. 

 

Figure 30: Stop CRDS Software Pop-up 
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8. Measurement Setup Modes 

8.1 Dual Mode Setup 
Dual mode is used for measurement of ambient vapor coupled with automated 
injection of liquid calibration standards. This setup requires A0211 High Precision 
Vaporizer, A0912 Dual Mode Configuration hardware and software for vapor 
calibration, and an Autosampler. Each injection cycle takes 9 minutes. 

Operation 
1. Before continuing, review the important safety notes in the Safety 

section.  

2. Make sure the hardware setup is complete and the system turned on in 
the correct sequence. 

3. Once turned on, the main CRDS Data Viewer of the analyzer will open 
automatically on the desktop screen. To understand all the functions of 
the main CRDS Data Viewer, see the section: CRDS Data Viewer 
Functions. A sequence of start-up messages will also appear in the 
Status Log Message window of the main CRDS Data Viewer. For 
definition, see the section: Common Status Log Messages. 

4. Make sure the temperature of the High Precision Vaporizer stabilizes at 
110°C by viewing the read out on the front of the vaporizer. 

 
NOTE 

Before starting measurements, ensure you are in the correct measurement 
mode. Select the measurement mode that matches the dry gas supplied to your 
Vaporizer (either N2 or zero air). See the section Switching Between 
Measurement Modes for instructions. 

 
5. Make sure the Picarro Autosampler software is running, that the 

Autosampler has been trained, methods and jobs defined, and samples 
loaded. For detailed setup instructions, refer to the Picarro A0340 
Autosampler User Manual (PN 40-0094) or the Picarro A0325 
Autosampler User Manual (PN 40025). 

6. Double click on the Coordinator Launcher icon on the analyzer’s 
desktop. The coordinator software allows the analyzer to take 
measurements from multiple samples and is used to control the sample 
source and match the corresponding real time read out with the sample 
source. To learn more about the coordinator software (running the 
software, loading sample description, functions of the coordinator 
window), see section 10 Coordinator Software. Choose and launch an 
appropriate coordinator mode from the choices in the drop down menu 
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of the coordinator launcher window. The Dual Mode Setup can operate 
in one coordinator mode.  

7. Once launched, before the Coordinator window opens up, the User 
Editable Parameters window will pop up (as shown below): 

 

Figure 31: User Editable Parameters Window 

This allows measurement of liquid isotopic water standards at fixed time intervals 
during the measurement of the vapor phase to verify calibration. The analyzer will 
run the parameters specified in a continuous loop until exiting from the program 
(i.e., measure 5 liquid injections, 1 hour of vapor, 5 liquid injections, 1 hour of 
vapor, etc.). Measurement will always start with liquid injections.  

• If no liquid samples are to be measured, then enter ‘0’ in the field for 
liquids. It will then measure the vapor continuously. 

• If no vapor samples are to be measured, then enter ‘0’ in the field for 
vapors. It will then run only the liquid samples specified in the Autosampler 
job (see later section for details). 

• If the analyzer is already running and these parameters need to be 
changed it will require exiting and restarting the Picarro coordinator 
software. 

 
NOTE 

Analysis of liquid samples requires that both the coordinator software and 
autosampler job be started. Be sure to start the Autosampler Controller software 
before launching the Dual Mode Coordinator. Once the Autosampler Controller 
software is open, you may start the Dual Mode Coordinator. Once open, click 
“Run” on the Autosampler Controller software. 

Picarro highly recommends matching the “Number of liquid injections for 
calibration” to the injection count set in the Autosampler job. This ensures 
one sample vial is analyzed completely before returning to vapor measurements. 
If two or more liquid calibration standards are used, then “number of liquid 
injections for calibration” can also be an integer multiple of the injection count set 
in the Autosampler job.  

For example, if eight injections each of two liquid standards are to be run every 6 
hours during vapor measurements then enter 16 (8 injections * 2 standards) in the 
first field and 6 in the second field. 
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Be sure there are sufficient liquid standards available because once all the liquid 
samples specified in the Autosampler job have been run and the current vapor 
measurement is complete, the analyzer will wait indefinitely or until a new 
Autosampler job is started.  

 
NOTE 

To calculate the time to complete the autosampler job use the follow formula: 

Cycle time = number injections * 9 min + vapor measurement time 

Assuming 1 standard per cycle, 8 injections, and 6 hours vapor measurement: the 
total cycle time is 432 minutes and consumes 1 vial. The Picarro Autosampler has 
a tray for up to 105 vials. Therefore, one full tray of 105 vials will last 432 * 105 = 
45360 minutes or 31.5 days. Thus, plan on one tray lasting for one month of 
measurements when calibrating every 6 hours. 

Once the injection number and vapor measurement duration parameters have 
been entered, and the ‘OK’ button is clicked, the coordinator window will pop up 
on your desktop. The different software element will indicate whether liquid or 
vapor is being measured.  

8. Once launched, the coordinator will automatically start collecting data. 
The data will also be available in the GUI as pulses. To customize pulse 
analysis or to adjust the peak of pulse data, please see the section 
Pulse Customization located in section 15 Best Practices and 
Operational Tips. 

 

Figure 32: Coordinator Launcher 
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Figure 33: Coordinator Window 

Data 
To learn where to retrieve the data, and to set the frequency of file archival and 
automatic deletion of old files, see section 13 File Management.  

Coordinator Window 

Coordinator Window – Expanded 
to illustrate typical steps and 
additional data 
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To access one’s data remotely, see the section; Remote Data Access in 
APPENDIX A – Setup Tool and Communication.  

For instruction on configuring data file saving details, including which data 
elements are written to data files, digital data output (via serial port or TCP/IP), 
remote data delivery (via email), and general GUI properties, click on the Setup 
Tool icon in the Picarro Utilities folder in the desktop.  

The Picarro water analyzers allow users to archive data using a compressed, 
binary “HDF5” or “h5” format. The Data File Viewer program, which comes 
installed with the hardware, allows one to open and convert h5 files, as well as 
viewing the h5 files as graphs. For more information, see APPENDIX B – Data 
File Viewer.  

The Picarro water analyzers come preinstalled with the ChemCorrect software 
which allows one to screen and quantify contamination in isotopic water samples. 
To post process data using ChemCorrect Software, see section 12.2 Analysis of 
Coordinator Output Files located in section12 ChemCorrect™ Software. 

One may need to adjust the sample injection volume to improve the quality of 
data. See 15.2 Adjusting Injection Volume in section 15 Best Practices and 
Operational Tips.  

8.2 Manual Mode Setup 
Operation 

1. Before continuing, review the important safety notes in SAFETY.  

2. Make sure the hardware setup is complete and the system turned on in 
the correct sequence.  

3. Once turned on, the main CRDS Data Viewer of the analyzer will open 
automatically on the desktop screen. To understand all the functions of 
the main CRDS Data Viewer, see CRDS Data Viewer. A sequence of 
start-up messages will also appear in the Status Log Message window 
of the main CRDS Data Viewer. For definition, see Common Status Log 
Messages. 

4. Make sure the temperature of the High Precision Vaporizer has 
stabilized to 110 °C. 

 
NOTE 

Before starting measurements, ensure you are in the correct measurement 
mode. Select the measurement mode that matches the dry gas supplied to your 
Vaporizer (either N2 or zero air). See section Switching Between Measurement 
Modes for instructions. 

5. Double click on the Coordinator Launcher icon on the desktop. The 
coordinator software allows the analyzer to take measurements from 
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multiple samples and is used to control the sample source and match 
the corresponding real time read out with the sample source. To learn 
more about the coordinator software (running the software, loading 
sample description, functions of the coordinator window), see section 10 
Coordinator Software. Choose and launch an appropriate coordinator 
mode from the choices in the drop down menu. The coordinator window 
will pop up.  

The Manual Mode Setup can operate in one coordinator mode in the L2130-i.  

• Manual Inject: Used for semi-automated measurement of liquid water 
samples with high precision. Requires A0211 High Precision Vaporizer. 
User manually injects samples after prompt. The vaporizer control and the 
analysis of liquid samples are automated. Each injection cycle takes 9 
minutes.  

The Manual Mode Setup can operate in two coordinator modes for the L2140-i.  

• O17 Manual Inject: Used for semi-automated measurement of liquid water 
samples for δ18O, δ17O, δ2H and 17O-excess. Requires A0211 High 
Precision Vaporizer. User manually injects samples after prompt. The 
vaporizer control and the analysis of liquid samples are automated. This 
coordinator must be run in either the “iH2O N2 O-17” mode or the “iH2O 
Air O-17” mode. In this mode the coordinator will output δ17O and  
17O-excess. Each injection cycle takes 9 minutes.  

• Manual Inject: Used for semi-automated measurement of liquid water 
samples with high precision on δ18O and δ2H. Requires A0211 high 
precision vaporizer. User manually injects samples after prompt. The 
vaporizer control and the analysis of liquid samples are automated. Each 
injection cycle takes 9 minutes.  

To learn about all the other coordinator modes supported by the Picarro water 
analyzer (in different setups), see section 10.5 Coordinator Modes Available On 
a Picarro Water Isotope Analyzer.  

6. Once launched, the coordinator will direct the user on when to manually 
inject samples and it will automatically start collecting data. The data will 
also be available in the GUI as pulses. To customize pulse analysis or 
to adjust the peak of one’s data pulses, see the section Pulse 
Customization located in section 15 Best Practices and Operational 
Tips.  

7. The status bars at the bottom of the Coordinator window will allow one 
to know if the analyzer is ready for a manual injection or not. If ready, 
the sample description (if preloaded) will appear. If not loaded, a 
description can be added. Manually inject the sample and then press the 
Injected button in the lower right corner of the Coordinator window. The 
coordinator software will prepare the sample in the vaporizer in high 
precision mode (same as Standard Mode). It will take approximately 9 
minutes until it is ready for the next injection.   
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Data 
To learn where to retrieve the data, and to set the frequency of file archival and 
automatic deletion of old files, see section 13 File Management.  

 To access one’s data remotely, see the section; Remote Data Access in 
APPENDIX A – Setup Tool and Communication.  

For instruction on configuring data file saving details, including which data 
elements are written to data files, digital data output (via serial port or TCP/IP), 
remote data delivery (via email), and general GUI properties, click on the Setup 
Tool icon in the Picarro Utilities folder in the desktop.  

The Picarro water analyzers allow users to archive data using a compressed, 
binary “HDF5” or “h5” format. The Data File Viewer program, which comes 
installed with the hardware, allows one to open and convert h5 files, as well as 
viewing the h5 files as graphs. For more information, see APPENDIX B – Data 
File Viewer.  

The Picarro water analyzers come preinstalled with the ChemCorrect software 
which allows one to screen and quantify contamination in isotopic water samples. 
To post process data using ChemCorrect Software, see section  12.2 Analysis of 
Coordinator Output Files located in section 12 ChemCorrect™ Software.  

One may need to adjust the sample injection volume to improve the quality of 
data. See 15.2 Adjusting Injection Volume in section 15 Best Practices and 
Operational Tips.  

8.3 Picarro Autosampler and High Precision Vaporizer 
Setup 
This setup is used for automated injection of liquid waters. It consists of two 
modes that utilize the same hardware: High Precision Mode (same as Standard 
Mode) and High Throughput Mode. 

Operation 
1. Before continuing, review the important safety notes in SAFETY.  

2. Make sure the hardware setup is complete and the system is turned on 
in the correct sequence.  

3. Once turned on, the main CRDS Data Viewer of the analyzer will open 
automatically on the desktop screen. To understand all the functions of 
the main CRDS Data Viewer, see CRDS Data Viewer. A sequence of 
start-up messages will also appear in the Status Log Message window 
of the main CRDS Data Viewer. For definition, see Common Status Log 
Messages. 
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4. Make sure the temperature of the High Precision Vaporizer has 
stabilized at 110°C by viewing the read out on the front of the vaporizer.  

 
NOTE 

Before starting measurements, ensure you are in the correct measurement 
mode. Select the measurement mode that matches the dry gas supplied to your 
Vaporizer (either N2 or zero air). See the section Switching Between 
Measurement Modes for instructions. 

5. Make sure the Picarro Autosampler software is running, that the 
Autosampler has been trained, methods and jobs defined, and samples 
loaded. For detailed setup instructions, refer to the Picarro A0340 
Autosampler User Manual (PN 40-0094) or the Picarro A0325 
Autosampler User Manual (PN 40025).  

6. Double click on the Coordinator Launcher icon on the analyzer’s 
desktop. The coordinator software allows the analyzer to take 
measurements from multiple samples and is used to control the sample 
source and match the corresponding real time read out with the sample 
source. To learn more about the coordinator software (running the 
software, loading sample description, functions of the coordinator 
window), see section 10 Coordinator Software. Choose and launch an 
appropriate coordinator mode from the choices in the drop down menu 
of the coordinator launcher window. The coordinator window will pop up.  

The Picarro Autosampler – High Precision Vaporizer Setup can operate in 
following coordinator modes:  

For the L2140-i: 

• High Precision (same as Standard Mode): For interfacing with an 
autosampler for highest precision measurements of δ18O and δ2H. This 
coordinator must be run in either the iH2O N2 mode or the iH2O Air mode. 
In this mode the coordinator will not output δ17O and 17O-excess. Each 
injection cycle takes 9 minutes. 

• High Throughput: For interfacing with an autosampler for faster 
measurements of δ18O and δ2H with good precision. This coordinator must 
be run in either the iH2O N2 mode or the iH2O Air mode. In this mode the 
coordinator will not output δ17O and 17O-excess. Each injection cycle takes 
4 minutes.  

• O17 High Precision: For interfacing with an autosampler for highest 
precision measurements of δ18O, δ17O, δ2H and 17O-excess. This 
coordinator must be run in either the “iH2O N2 O-17” mode or the “iH2O 
Air O-17” mode. In this mode the coordinator will output  δ17O and 17O-
excess. 

• Express*: Used for faster measurement of liquid water samples with good 
precision. This coordinator must be run in either the “iH2O N2” mode or 
the “iH2O Air” mode. Automatically injects and analyzes liquid water 
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samples. When using the Express coordinator, we recommend 10 
injections, the first 6 injections take 1.5 minutes each, while the last 4 
injections take 5 minutes each. The first 7 injections will be discarded to 
achieve optimal memory reduction.  

• Standard* (same as High Precision Mode): Used to measure liquid 
water samples with maximum precision. This coordinator must be run in 
either the “iH2O N2” mode or the “iH2O Air” mode. Automatically injects 
and analyzes liquid samples. Each injection cycle takes 9 minutes. 

• Survey*: Used for super-fast measurements of large sample batches at 
moderate precision and enables efficient sample sorting. Automatically 
injects and measures liquid samples. This coordinator must be run in 
either the “iH2O N2” mode or the “iH2O Air” mode.  

*Only available with Coordinator software upgrade 

Survey mode has two use cases: 

• Sample Sorting and Rearrangement: Survey large sample batches and 
use the output values to manually rearrange samples. This will result in 
reducing the memory effect of the followed measurements (either by 
Express mode or by Standard mode). In this use case we recommend 
doing 1 injection per sample, with sample volume of 2.5 µl. Using these 
parameters, measurement time is 95 seconds per sample. 

• Sample Measurement with Moderate Precision: Use the survey mode to 
quickly measure samples with moderate precision. Here we recommend 6 
injections with sample volume of 2.5 µl. The first 3 injections should be 
discarded to achieve acceptable levels of memory. Using these 
parameters, measurement time is reduced to 9.5 minutes per sample.  

For the L2130-i:  

• High Precision (same as Standard Mode): Used to measure liquid water 
samples with maximum precision. This coordinator must be run in either 
the “iH2O N2” mode or the “iH2O Air” mode. Automatically injects and 
analyzes liquid samples. Each injection cycle takes 9 minutes. 

• High Throughput: Used for faster measurement of liquid water samples 
with good precision. This coordinator must be run in either the “iH2O N2” 
mode or the “iH2O Air” mode. Automatically injects and analyzes liquid 
water samples. Each injection cycle takes 4 minutes.  

• Express*: Used for faster measurement of liquid water samples with good 
precision. This coordinator must be run in either the “iH2O N2” mode or 
the “iH2O Air” mode. Automatically injects and analyzes liquid water 
samples. When using the Express coordinator, we recommend 10 
injections, the first 6 injections take 1.5 minutes each, while the last 4 
injections take 5 minutes each. The first 7 injections will be discarded to 
achieve optimal memory reduction.  
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• Standard* (same as High Precision Mode): Used to measure liquid 
water samples with maximum precision. This coordinator must be run in 
either the “iH2O N2” mode or the “iH2O Air” mode. Automatically injects 
and analyzes liquid samples. Each injection cycle takes 9 minutes. 

• Survey*: Used for super-fast measurements of large sample batches at 
moderate precision and enables efficient sample sorting. Automatically 
injects and measures liquid samples. This coordinator must be run in 
either the “iH2O N2” mode or the “iH2O Air” mode.  

*Only available with Coordinator software upgrade 

Survey mode has two use cases: 

• Sample Sorting and Rearrangement: Survey large sample batches and 
use the output values to manually rearrange samples. This will result in 
reducing the memory effect of the followed measurements (either by 
Express mode or by Standard mode). In this use case we recommend 
doing 1 injection per sample, with sample volume of 2.5 µl. Using these 
parameters, measurement time is 95 seconds per sample. 

• Sample Measurement with Moderate Precision: Use the survey mode to 
quickly measure samples with moderate precision. Here we recommend 6 
injections with sample volume of 2.5 µl. The first 3 injections should be 
discarded to achieve acceptable levels of memory. Using these 
parameters, measurement time is reduced to 9.5 minutes per sample.  

 
NOTE 

Analysis of liquid samples requires that both the coordinator software and 
autosampler job be started. Be sure to start the Autosampler Controller software 
before launching the Dual Mode Coordinator. Once the Autosampler Controller 
software is open, you may start the Coordinator. Once open, click “Run” on the 
Autosampler Controller software. 

7. Once launched, the coordinator will automatically start collecting data, 
assuming the Autosampler job has been started. The data will also be 
available in the GUI as pulses. To customize pulse analysis or to adjust 
the peak of pulse data, please see the section Pulse Customization 
located in section 15 Best Practices and Operational Tips. 

 

Figure 34: Coordinator Launcher 
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Figure 35: Coordinator Window 

  

Coordinator Window 

Coordinator Window – Expanded 
to illustrate typical steps and 
additional data 
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Data 
To learn where to retrieve the data, and to set the frequency of file archival and 
automatic deletion of old files, see section 13 File Management.  

 To access one’s data remotely, see the section; Remote Data Access in 
APPENDIX A – Setup Tool and Communication.  

For instruction on configuring data file saving details, including which data 
elements are written to data files, digital data output (via serial port or TCP/IP), 
remote data delivery (via email), and general GUI properties, click on the Setup 
Tool icon in the Picarro Utilities folder in the desktop.  

The Picarro water analyzers allow users to archive data using a compressed, 
binary “HDF5” or “h5” format. The Data File Viewer program, which comes 
installed with the hardware, allows one to open and convert h5 files, as well as 
viewing the h5 files as graphs. For more information, see APPENDIX B – Data 
File Viewer.  

The Picarro water analyzers come preinstalled with the ChemCorrect software 
which allows one to screen and quantify contamination in isotopic water samples. 
To post process data using ChemCorrect Software, see section  12.2 Analysis of 
Coordinator Output Files located in section 12 ChemCorrect™ Software. 

One may need to adjust the sample injection volume to improve the quality of 
data. See 15.2 Adjusting Injection Volume in section 15 Best Practices and 
Operational Tips. 

8.4 Picarro Autosampler and High Throughput 
Vaporizer Setup 
Picarro removed the High Throughput Vaporizer (part number A0212) from the 
price list in December 2013. Since that time, we have not shipped new High 
Throughput Vaporizers; however, we do continue to support High Throughput 
Vaporizers that are in the field. If you own a High Throughput Vaporizer, please 
contact support@picarro.com for operational instructions. They will refer you to an 
earlier version of this manual. 

mailto:support@picarro.com
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9. CRDS Data Viewer Functions 

 
NOTE 

The illustrations shown in this chapter are for example only. What is shown on 
your instrument is dependent on the analyzer model and its configuration which 
may differ from these examples. 

9.1 CRDS Data Viewer Overview 
The features of the Data Viewer shown in Figure 36 are described in the following 
sections. 

 
1. Settings, View, Tools, and Help menus 
2. Alarm Panel 
3. Digital Readouts and Statistics 
4. Instrument Status 
5. Shutdown and Restart Log Buttons 
6. Data Log; Filename, and Path 

7. Status Log Window 
8. Data Source, Data Key, and Precision pull-

down menus for data window content 
9. Axis Auto Scaling 
10. Reset Data Buffer 
11. Data Buffer Level Meter 
12. Data Windows 

Figure 36: Layout of Analyzer Data Viewer 
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9.2 Settings, View, Tools, and Help Menus 

 
 

Figure 37: Menu Toolbar Options 

Settings Menu 
Left clicking on the Settings menu pulls down a menu that has one entry: 
Change GUI Mode from Standard to Service (or Change GUI mode from 
Service to Standard if it is already in service mode).  

This is the access point to a password protected service mode (default password 
is picarro) where additional operational and measurement parameters are 
available in the data keys. Selecting and clicking on this entry opens the Cavity 
Ring-Down Spectrometer Controller. 

View Menu 
This menu item has three entries: 

1. Lock time axis when zoomed/Unlock time axis: When locked, forces 
the two graphs to display the same time scale during zoom. 

1. Show/Hide Statistics: Toggles the measurement statistics display, see 
the section Digital Readouts below. 

2. Show/Hide Instrument Status: Toggles the instruments status display. 
See the section Instrument Status, below. 

Tools Menu 
This menu item has two entries: 

1. User Calibration: Opens the password protected user calibration 
window (default password is picarro).  

Calibration slope and intercept can be entered, and their effects are 
immediately seen in the data. See section 11, Calibration for more 
information. 

2. Show/Hide Sequencer GUI: Toggles the display of the external valve 
sequencer window (user may need to hit alt-tab to bring it to the front).  
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Help Menu 
About: Displays the version number of the instrument. 

9.3 Alarms Panel 
This panel is used to monitor the status of the internal instrument alarms. These 
indicators are gas concentration alarms, such as “H2O Too High/Low” depending 
on instrument configuration. The gas concentration alarm icons are off (grayed) 
when the respective concentrations are below a certain value, and they are 
illuminated red when the respective concentrations are above/below a certain 
value.  

 
CAUTION 

High/low alarm settings are not intended as a safety measure as configured at 
the factory, either with respect to human health or the health of the analyzer. It is 
up to the customer to determine the meaning and level of a “high” or “low” value 
based on their application. 

 

 

Figure 38: Alarm Panel 

To view the alarm set point, click on the Alarm Icon and a dialog box will appear 
indicating the alarm setting and allow the user to enable it or change the setpoint. 

   

Figure 39: Alarm Settings Dialog Box Example 
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Type the value you wish to set the alarm to and click the OK button or Cancel if 
you do not wish to change the alarm value. If you do nothing, the dialog box will 
disappear, and the alarm value will remain unchanged. The units are those that 
appear in the GUI graph.  

9.4 Digital Readouts 
Displays the latest value recorded for the selected Data Key for each Data 
Window. Changing the Data Key changes the Digital Readout as well as the Data 
Window view. If the Show Statistics entry is enabled in the View menu, the 
mean, standard deviation, and slope of the data in the graph is dynamically 
calculated and indicated below the digital concentration readout. These numbers 
change to reflect statistics of whatever data is in the data window. Zooming into a 
section of existing data will show the statistics statically for that time period, while 
the digital readout above the statistics continues to update with the latest value. 
See 9.12, Reset Buffers Button 

Click this button to clear the internal data buffer of the GUI (this clears the current 
data traces from the graphs). This has the effect of clearing all data in the data 
window. Pressing this button has no effect on any of the data log files stored by 
the instrument. 

Graph Zooming for more information. 

 

Figure 40: Digital Readouts Panel 

With Show Statistics 
Enabled 

With Show Statistics 
Disabled 
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9.5 Instrument Status 
If these parameters are enabled through the Show Instrument Status entry in 
the View menu on the main toolbar, digital readouts for Warm Box temperature, 
Cavity Temperature and Cavity Pressure are displayed to the left of the main 
trend graphs. 

 

Figure 41: Instrument Status Panel 

9.6 Shutdown and Stop User Log(s) Buttons 

 

Figure 42: Shutdown/Stop User Log 

Shutdown Button: 
Shuts down the analyzer. See section 7.2, Shutdown for more information. 

Restart User Log(s) Button 
The analyzer automatically records all data collected on the instrument as .dat 
files. These are described further in 13 File Management. 

To start a new data file (time-coded to the current second), click the Restart User 
Log(s) button. The new file name should be visible beneath the button in a few 
seconds. 

Data Log Filename and Path 
The filename and path of the active data log is displayed in this pane. The 
indicator is grayed-out when there is no active data log before gas measurement 
reporting begins. A new file is generated when the instrument starts reading gas 
concentrations, (e.g., “201301Z”) and subsequently at 1 hour increments (e.g., 
“211301Z”, “221301Z”). A new day folder (e.g., “2023\06\01”) will be generated at 
midnight, as will month and year folders at the appropriate times. 
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Figure 43: Data Log Filename and Path Panel 

9.7 Data Window 
The data window displays a graph of any stream of data vs. system time, with a 
format of hh:mm:ss. The user can select which data streams are displayed using 
combinations from the Data Source and Data Key pull down menus. The 
precision displayed can be adjusted using the Precision menu. Auto-Scaling of 
the Y-axis is also available. Clicking any Autoscale button autoscales its Y-axis if 
the plot hasn’t done this automatically. 

  

Figure 44: Data Window Panel 

9.8 Data Source and Data Key Pull Down Menus 
Data Source and Data Key menus (Figure 45) enable selection of the data stream 
that is viewed in the data window.  

• Gas concentrations if ‘instrument Analysis’ (where instrument represents 
the system installed) is selected. 

• Sensor Readings: If “Sensors” is selected, the analyzer’s optical cavity 
pressure or temperature can be viewed, as well as the temperature of the 
electronics of the analyzer (“DASTemp,” not directly controlled), and the 

Data Source, Data Key, Precision and Y-Axis Auto-Scale Controls  
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temperature of the analyzer’s wavelength monitor, indicated as 
“WarmBoxTemp.”  

 

 

Figure 45: Data Source and Data Key Pull Down Menus 

9.9 Precision Pulldown Menu 
Precision default selection is “auto” Click on the pull-down to select the precision 
displayed on the y-axis; between 0 and 4 digits of precision or auto. The currently 
selected precision is displayed during operation. This does not affect the precision 
of the saved data in the data log files or results files. Auto precision is sufficient for 
nearly all applications. 

 

Figure 46: Precision Pull-down Pane 

9.10 Analyzer Status Log 
This window displays instrument status messages, in the following form:  
YYYY-MM-DD HH:mm:ss then ‘Generic message text.’ 

Common Status Log Messages 
Following are the most common messages that appear: 

• Pressure Stabilizing/Locked: Displayed when the valve control system 
begins to allow flow through the analyzer and stabilizes the pressure 
inside the cavity. 

• Temperature Locked: WB (HB): When the temperatures of the 
warmbox (wavelength monitor) and hotbox (cavity) have stabilized.  
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This is typically the longest step in the startup sequence. Startup: 
Depending on ambient temperature, the analyzer and its hotbox 
temperature set point, this step may take as little as 20, or as much as 60 
minutes. Restart: If the instrument is only stopped briefly, this may take a 
few seconds to a few minutes. 

• Preparing to Measure: Spectral scanning has started. Concentration 
measurements will be available in approximately 30 seconds. The 
instrument will continue to scan and report concentration measurements 
until the instrument is shut down. 

• Measuring: This is the normal mode of operation after startup has 
completed. 

 

Figure 47: Analyzer Status Log 

9.11 Data Buffer Level Meter 
The meter to the right of the Data Window (Figure 48) indicates how much of the 
internal memory of the GUI is used to retain historical data collected with the 
instrument. There is an internal limit of a finite number of points. Once that 
number of data points is collected, the buffer is full, and old data is removed from 
the buffer as new data is collected. This buffer affects only the data displayed in 
the data window, not the data stored in any files. This buffer is empty upon 
instrument startup and can also be emptied by pressing the Reset buffers button 
in the lower-right-hand corner of the GUI. 

  

Figure 48: Data Buffer Level Meter and Reset Buffers Button 

Data Buffer 
Level Meter  
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9.12 Reset Buffers Button 
Click this button to clear the internal data buffer of the GUI (this clears the current 
data traces from the graphs). This has the effect of clearing all data in the data 
window. Pressing this button has no effect on any of the data log files stored by 
the instrument. 

9.13 Graph Zooming and Panning 
Zooming In/Out 
To zoom in on a specific region of the graph, move the cursor to the area of 
interest, click/hold the left mouse button, then drag as desired to create a box 
that covers the region of interest (see Figure 49). When the box is drawn, release 
the left button and the boxed area will automatically scale to fill the data window.  

 

Figure 49: Data Graph Zoom Function 

To zoom back out to see all data in the buffer, double-click the left button 
within the graph display. To zoom out indefinitely, right click. Right clicking 
multiple times zooms out further. To auto scale the y-axis of either graph, use the 
auto-scale buttons below the graph.  

To Zoom the X and Y axes: hold down the control button and move the cursor 
up/down or left/right using the right mouse button.  

Lock/Unlock Time Axis 
Zoom and pan features are often useful when time axes are locked, and the user 
wishes to align the Y axis in multiple plots. To lock or unlock the time axis of each 
graph during zooming, from the View menu, select Lock time axis when 
zoomed or Unlock time axis. 

Panning 
To pan the data in the X or Y axis: hold down the control button and drag the 
cursor using the left mouse button.  

Example only. The 
gas species on your 
analyzer may differ. 



Coordinator Software   

L21x0-i Inst/Op Manual  P/N 40035 Rev. G 79 

10. Coordinator Software 

10.1 Introduction 
To measure discrete samples or to control external peripherals and accessories a 
separate software tool (Coordinator) is used to control the sample source and match the 
corresponding real time read out with the sample source. The Coordinator programs that 
are accessible to a user are dependent on the system configuration.  

 
NOTE 

Although this section will provide an overview to the concept of Coordinators, it 
does not necessarily provide the detail on all Coordinators available on a 
Picarro water isotope system. Instead, refer to the separate User Manual 
provided with each of your Picarro accessories: 

• A0101 SDM (Standards Delivery Module) User Manual (PN 40-0005) 
• A0213 IM (Induction Module) User Manual (PN 40039) 
• A0214 MCM (Micro Combustion Module) User Manual (PN 40022) 
• A0217 CWS (Continuous Water Sampler) User Manual (PN 40003) 

10.2 How to Run Coordinator Software: 
1. First, make the required hardware connections for your system of 

interest. Afterwards, turn on the analyzer and wait for the CRDS Data 
Viewer of the analyzer’s software to open up automatically on your 
desktop screen.  

2. Next, launch the coordinator software by double clicking on the 
Coordinator Launcher icon on your desktop. 

3. After double clicking on the Coordinator Launcher icon, a window will 
appear. Choose the appropriate coordinator from the drop down menu, 
and then click the Launch button. Make sure that the chosen 
coordinator is supported by your hardware connections and that 
samples are ready to be analyzed.  

 

Figure 50: Coordinator Launcher Window 
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The look of the window may vary depending on the configuration of your analyzer. 

Figure 51: CRDS Coordinator Window 

4. After clicking on the Launch button, the coordinator window (Figure 51) 
will pop up. (Depending on the coordinator mode chosen, you may or 
may not be asked to set parameters for your analysis). From the 
Coordinator window, you will be able see results from sample analysis,  

Coordinator Window Descriptions 

 

Figure 52: Coordinator Window Descriptions 

Load Sample 
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1. Coordinator Output Filename: Can be seen in the upper left of the 
Coordinator window. It follows an automated convention of: 

model, serial number, mode, year, month, date, and time. For example: 

HIDS2316_IsoWater_20230601_194744.csv 

This means the coordinator file output was taken using analyzer 
HIDS2316 in high throughput isotopic water analysis starting on 1 June 
2023 at 7:47:44 pm. 

2. New Output File Button: Clicking on this button will save the data that 
you see on the coordinator window into a file, and then clear the data 
from the Coordinator Window. 

3. Load Sample Descriptions Button: Located around the upper right 
corner of the Coordinator Window. The button allows the user to include 
a description for each vial in the data file output on the coordinator 
window. 

4. Change Septum Button: Used to pause the Autosampler and the 
vaporizer in the middle of an analysis to physically change the septum 
on the vaporizer.  

In order to load the sample description file, press the button labeled Load 
Sample Descriptions. A dialog box will appear. Select the sample 
description file, and then click Open. If a certain tray (front or rear) is not 
being used, use the ‘Cancel’ button to dismiss the dialog.  

5. Upper Portion of The Window: Each row represents the analysis 
results from a single injection. The types of columns are pre-selected by 
Picarro to include the most useful values for isotopic water analysis and 
for diagnostic indications. 

The values for the columns, unless otherwise noted, are the average 
value for time period of the injection, which was marked in red on the 
CRDS Data Viewer. Values of the form *_SD are standard deviations for 
that same time period. The time period is selected by trigger thresholds 
based on the water vapor concentration. The analyzer is characterized 
and specified based on the factory default trigger thresholds—changing 
these values is not recommended, please contact Picarro if you feel this 
is necessary.  

6. Lower Portion Of The Window (labeled “Log”): This window displays 
the action that is currently taking place. For those actions that take 
some time to complete, a period is displayed each second and a new 
line is started every thirty seconds to show progress. 

  



   Coordinator Software 

82 P/N 40035 Rev. G L21x0-i Inst/Op Manual 

10.3 How to Make the Sample Description File 
The sample description file should be in CSV (comma separated value) format. 
Use the supplied NotePad++ software. Write the sample descriptions in the format 
as shown below.  

Tray,Vial,Identifier 1,Identifier 2 

1,1,Picarro 00,standard 

1,2,Picarro 11, standard 

1,3,Picarro 22, standard 

1,4,WA 1,first sample from Washington 

1,5,WA 2,second sample from Washington 

1,6,CA 1, first sample from California 

1,7,CA 2, second sample from California 

1,8,Picarro 00, standard 

 

Figure 53: Sample Description Example 

After the first line (which should contain the column heading), each line should 
represent a sample description for the analysis results from a single injection. The 
lines in the file may be arranged in any order. The capitalization and spacing of 
the first line must exactly match the provided example. MS Excel can be used if 
the file is saved in CSV format. It is recommended to generate the file using 
Windows operating systems (as on the analyzer) as there are differences in CSV 
format between different operating systems. It is permissible to load the sample 
description files at any time during the data collection. The output file is rewritten 
to use the new sample descriptions, so that the most recently loaded descriptions 
are always used. 
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10.4 Parameters Recommended for Standard, Express, 
and Survey Modes 
The widely accepted standard protocol for water isotope analysis is to run 6 
injections of the sample, and average only the last 3 data points to obtain the 
isotopic values of the sample.  

Using the Express mode, Picarro recommends running 10 injections per sample, 
and in similarity to the standard mode, averaging only the last 3 data points to 
obtain the isotopic values of the sample stage.  

Before launching the Express coordinator, please set number of injections to 10, 
and volume of sample to 1.8 µl, in the Autosampler user interface. 

Using the Survey mode requires only one injection. 

Before launching the Survey coordinator, please set number of injections to 1, and 
volume of sample to 2.5 µl, in the Autosampler user interface. 

The following table summarizes Picarro’s recommendations for processing 
samples. 

Table 6: Picarro Recommendations for Processing Samples. 

Coordinator Number of 
Injections* 

Sample 
Volume* (µl) 

Number of Injections 
to Discard** 

Standard 6 1.8 3 

Express 10 1.8 7 

Survey 1 2.5 0 

*Edits are done to the autosampler software method tab. 

**Edits are done to the ChemCorrect post processing parameters. 

When using samples with large isotopic range, more injections can be added to 
help reduce the memory effect. 

  



   Coordinator Software 

84 P/N 40035 Rev. G L21x0-i Inst/Op Manual 

10.5 Coordinator Modes Available On a Picarro Water 
Isotope Analyzer  
The CRDS analyzer needs to be equipped with the appropriate hardware to 
support a coordinator mode.  

Hardware Associated Coordinator(s) 

High Precision Vaporizer (A0211) 
CRDS Analyzer (L21x0-i) 

Manual Injection 

High Precision Vaporizer (A0211) 
Autosampler (A0340 or A0325) 
CRDS Analyzer (L21x0-i) 

L2130-i: 
• High Precision* (same as 

Standard Mode) 
• High Throughput* 
• Standard** (same as High 

Precision Mode) 
• Express** 
• Survey** 

L2140-i 
• High Precision* 
• High Throughput*  
• High Precision 17O* 
• Express** 
• Survey** 

*Only available without Coordinator 
software upgrade 

** only available with coordinator 
upgrade 

High Precision Vaporizer (A0211) 
Autosampler (A0340 or A0325) 
CRDS Analyzer (L21x0-i) 
Vaporizer Switching Valve (A0912) 

Dual Mode 
Dual Mode 17O (if L2140-i) 

High Precision Vaporizer (A0211) 
Micro Combustion Module (A0214) 
CRDS Analyzer (L21x0-i) 

MCM Manual Mode 

High Precision Vaporizer (A0211) 
Standards Delivery Module (A0101) 
CRDS Analyzer (L21x0-i) 

Standards Delivery Module (SDM) 

High Precision Vaporizer (A0211) 
Micro Combustion Module (A0214) 
Autosampler (A0340 or A0325) 
CRDS Analyzer (L21x0-i) 

MCM High Precision 
MCM High Throughput 
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Induction Module (A0213) 
CRDS Analyzer (L21x0-i) 

Induction Module 

Continuous Water Sampler 
CRDS Analyzer (L2130-i or L2140-i) 

Continuous Water Sampler 

Description of Different Coordinator Modes 
1. High Precision (same as Standard Mode): Used to measure liquid 

water samples with maximum precision. Automatically injects and 
measures liquid samples. Each injection cycle takes 9 minutes. High 
Precision and High Throughput Coordinator Modes operate in the exact 
same fashion except that the steps of sample preparation and analysis 
are faster in the high throughput coordinator. 

2. High Throughput: Used for faster measurement of liquid water 
samples with good precision. Automatically injects and measures liquid 
samples. Each injection cycle takes 4 minutes. High Precision and High 
Throughput Coordinator Modes operate in the exact same fashion 
except that the steps of sample preparation and analysis are faster in 
the high throughput coordinator. 

3. Standard* (same as High Precision Mode): Used to measure liquid 
water samples with maximum precision. Automatically injects and 
measures liquid samples. Each injection cycle takes 9 minutes. 

4. Express*: Used for faster measurement of liquid water samples while 
retaining high precision. Automatically injects and measures liquid 
samples. Here we recommend 10 injection the first 6 injections take 1.5 
minutes while the last 4 injections take 5 minutes. The first 7 injections 
will be discarded to achieve the optimal memory reduction.  

5. Survey*: Used for super-fast measurements of large sample batches at 
moderate precision and enables an efficient sample sorting. By 
rearranging samples accordingly, we can reduce the memory effect 
between adjacent sample. Automatically injects and measures liquid 
samples. Each injection cycle takes 95 seconds. For best practice, we 
recommend 1 injection per sample followed by manual sorting of 
samples according to survey results. 

*Only available with Coordinator software upgrade. 

6. Manual Inject: Used for semi-automated measurement of liquid water 
samples with maximum precision. Requires A0211 High Precision 
Vaporizer. User manually injects samples after prompt. The vaporizer 
control and the analysis of liquid samples are automated. Each injection 
cycle takes 9 minutes.  

7. Dual Liquid/Vapor: Used for measurement of ambient vapor coupled 
with automated injection of liquid calibration standards. Requires A0211 
high precision vaporizer, A0912 Dual Mode Configuration hardware and 
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software for vapor calibration and Autosampler. Alternates between 
analyzing ambient vapor and liquid standards based on user defined 
sequence. Uses high precision method for liquid calibration. Each 
injection cycle takes 9 minutes. 

8. Standards Delivery Module (SDM): Used for measurement of ambient 
vapor coupled with automated injection of liquid calibration standards. 
Requires A0211 High Precision Vaporizer and A0101 standards delivery 
module. Alternates between analyzing ambient vapor from multiple 
points and a continuous stream of vaporized standard. The alternation is 
based on user defined sequence. A calibration measurement takes 
approximately 20 minutes per concentration/standard. Before operating 
in SDM mode, set the vaporizer temperature to 140°C.  

9. IM CRDS (Induction Module): Requires the IM. Used for isotopic 
analysis of extracted water from samples such as soil, plants, or tissues 
and allows the isotopic analysis of the extracted water. This requires the 
Induction Module.  

10. Micro Combustion Module (MCM): Used to measure liquid water 
samples while destructively removing potential contaminants with 
maximum precision. Requires A0211 High Precision Vaporizer, A0214 
Micro Combustion Module and Autosampler. Automatically injects and 
measures liquid samples. Each injection cycle takes 9 minutes. In 
addition to controlling the valve sequence for injection liquid water 
samples, the MCM coordinator also control the heating of the MCM to 
ensure removal of interfering organics.  

11. Continuous Water Sampler (CWS): Used for continuous, real-time 
measurements of water. Requires A0217 Continuous Water Sampler. 
No discrete sampling is required. Automatically switches between 
calibration standards and samples using four inlet ports. 

 
NOTE 

IMPORTANT: The L2140-i can operate in four instrument modes (iH2O N2, iH2O 
Air, iH2O N2 O-17 and iH2O air O-17). Due to the high precision demands of 17O -
excess science, only the ‘High Precision’, ‘Dual Mode’ and ‘Manual Inject’ 
coordinator modes will work for the two O-17 instrument modes 

Description of Column Headers Used in Coordinators:  
The following table provides information regarding the column headers presented 
in the Coordinator output files available on a Picarro water isotope analyzer. The 
table below lists the possible fields in the coordinator results file header: 

Coordinators vary by analyzer product number, therefore not all columns will be 
visible on an individual analyzer.  
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Table 7: Column Headers Used in Coordinators 
Item Description 

Line  Line counter. Each line represents a single injection or data point 
(for vapor measurements in the dual mode).  

Analysis Sequential number of the sample run over the history of the 
analyzer. 

Time Code Time the line was recorded in “Year/Month/Day 
Hours:Minutes:Seconds.” This time stamp is linked to the local 
time of your computer’s clock.  

Port Reports the vial position on the tray where the autosampler is 
sampling from. 

Inj Nr Sequential injection number from the port (vial). 

d(17_16)Mean  The average  δ17O value, in per mil (‰), measured at that interval 
(Line). The typical raw data acquisition rate on a L2140-i is ~ 1 Hz, 
therefore this represents the average of 1 Hz data points across 
the water pulse. The averaging window is shown in red on the 
CRDS Data Viewer. The reported delta values are not calibrated. 
Post-processing is required for calibration. Only available on a 
L2140-i. 

d(18_16)Mean  The average  δ18O value, in per mil (‰), measured for that 
injection (Line). The typical raw data acquisition rate on a L21x0-i 
is ~ 1 Hz, therefore this represents the average of 1 Hz data points 
across the water pulse. The averaging window is shown in red on 
the CRDS Data Viewer. The reported delta values are not 
calibrated. Post-processing is required for calibration.  

d(D_H)Mean  The average  δ2H value, in per mil (‰), measured for that injection 
(Line). The typical raw data acquisition rate on a L21x0-i is ~ 1 Hz, 
therefore this represents the average of 1 Hz data points across 
the water pulse. The averaging window is shown in red on the 
CRDS Data Viewer. The reported delta values are not calibrated. 
Post-processing is required for calibration. 
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Item Description 

E17_Mean The average 17O-excess value, in per mil (‰), measured for that 
injection (Line). 17O-excess is the deviation the expected 
relationship between 17O/16O and 18O/16O ratios and is defined by:  

E17_Mean = 

ln[d(17_16)Mean + 1] – 0.528ln[d(18_16)Mean + 1] 

The typical raw data acquisition rate on a L2140-i is ~ 1 Hz, 
therefore this represents the average of 1 Hz data points across 
the water pulse. The averaging window is shown in red on the 
CRDS Data Viewer. The reported delta values are not calibrated. 
Post-processing is required for calibration. Only available on an 
L2140-i. 

H2O_Mean The average water concentration, in ppm, is measured for that 
injection (Line). The typical raw data acquisition rate on a L21x0-i 
is ~ 1 Hz, therefore this represents the average of 1 Hz data points 
across the water pulse. The averaging window is shown in red on 
the CRDS Data Viewer. The reported delta values are not 
calibrated. 

Ignore -1 or 0: -1 indicates the measurement should be ignored and is 
based on the first three injections from each sample vial being 
ignored due to sample-to-sample isotopic memory.  

Good 0 or 1: 1 indicates that the mean H2O concentration is within the 
required range. 0 indicates that the mean H2O concentration is 
outside the required range.  

Vapor d(17_16) Only reported when operating in Dual Mode. Populated when the 
Dual Mode is measuring ambient vapor. Raw  δ17O output from 
the analyzer with no averaging. The typical raw data acquisition 
rate on a L2140-i is ~ 1 Hz, therefore during the vapor 
measurement phase a line will be created every ~ 1 second. Only 
available on a L2140-i. 

Vapor d(18_16)  Only reported when operating in Dual Mode. Populated when the 
Dual Mode is measuring ambient vapor. Raw  δ18O output from 
the analyzer with no averaging. The typical raw data acquisition 
rate on a L21x0-i is ~ 1 Hz, therefore during the vapor 
measurement phase a line will be created every ~ 1 second. 
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Item Description 

Vapor d(D_H)  Only reported when operating in Dual Mode. Populated when the 
Dual Mode is measuring ambient vapor. Raw  δ2H output from the 
analyzer with no average. The typical raw data acquisition rate on 
a L21x0-i is ~ 1 Hz, therefore during the vapor measurement 
phase a line will be created every ~ 1 second. 

Vapor E17 Only reported when operating in Dual Mode. Populated when the 
Dual Mode is measurement ambient vapor. Raw 17O -excess 
output from the analyzer with no averaging. The typical raw data 
acquisition rate on a L21x0-i is ~ 1 Hz, therefore during the vapor 
measurement phase a line will be created every ~ 1 second. Only 
available on a L2140-i. 

Vapor H2O Only reported when operating in Dual Mode. Populated when the 
Dual Mode is measurement ambient vapor. Raw H2O 
concentration output from the analyzer with no averaging. The 
typical raw data acquisition rate on a L21x0-i is ~ 1 Hz, therefore 
during the vapor measurement phase a line will be created every ~ 
1 second.  

Identifier 1 First identifier of the sample. Only populated if a sample 
description file is loaded when the coordinator is open. 

Identifier 2 Second identifier of the sample. Only populated if a sample 
description file is loaded when the coordinator is open. 

Gas Configuration Indicates the type of gas being measured. Water isotope 
analyzers measure water vapor sample. 

Timestamp Mean Unix timestamp. 

d(17_16)_SD Standard deviation of the measured  δ17O across an injection’s 
averaging window. The averaging window is shown in red on the 
CRDS Data Viewer. Only available on a L2140-i. 

d(18_16)_SD Standard deviation of the measured  δ18O across an injection’s 
averaging window. The averaging window is shown in red on the 
CRDS Data Viewer.  

d(D_H)_SD Standard deviation of the measured  δ2H across an injection’s 
averaging window. The averaging window is show in red on the 
CRDS Data Viewer. 
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Item Description 

H2O_SD Standard deviation of the measured H2O concentration across an 
injection’s averaging window. The averaging window is show in 
red on the CRDS Data Viewer. 

E17_SD Standard deviation of the measured 17O-excess across an 
injection’s averaging window. The averaging window is show in 
red on the CRDS Data Viewer. Only available on a L2140-i. 

d(18_16)_Sl The slope of the measured  δ18O across an injection’s averaging 
window. The averaging window is show in red on the CRDS Data 
Viewer.  

d(D_H)_SI The slope of the measured  δ2H across an injection’s averaging 
window. The averaging window is show in red on the CRDS Data 
Viewer. 

H2O_SI Slope of the measured H2O concentration across an injection’s 
averaging window. The averaging window is show in red on the 
CRDS Data Viewer. 

baseline_shift The average value for baseline shift, in ppb/cm, measured for that 
injection (Line). Baseline_shift is a spectral term that is measured 
on the L2130-i and L2140-i. It is the change in the constant term of 
the fitted baseline, relative to an empty cavity baseline which is 
measured at the Picarro factory. This column can be used to track 
potential spectral interference and data integrity. See 
ChemCorrect section.  

slope_shift The average value for slope shift, in ppb/cm, measured for that 
injection (Line). Slope_shift is a spectral term that is measured on 
the L2130-i and L2140-i. It is the change in the linear term of the 
fitted baseline, relative to an empty cavity baseline which is 
measured at the Picarro factory. This column can be used to track 
potential spectral interference and data integrity. See 
ChemCorrect section. 

residuals The average value for residuals, in ppb/cm, measured for that 
injection (Line). Residuals is a spectral term that is measured on 
the L2130-i and L2140-i. This term represents the root mean 
squared residual of the least-squares fit of the measured spectra 
versus the expected spectra. This column can be used to track 
potential spectral interference and data integrity. See 
ChemCorrect section.  
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Item Description 

baseline_curvature The average value for baseline curvature, in ppm*cm, measured 
for that injection (Line). Baseline_curvature is a spectral term that 
is measured on the L2130-i and L2140-i. This term represents the 
quadratic term in the fitted baseline. This column can be used to 
track potential spectral interference and data integrity. See 
ChemCorrect section. 

interval Average of the elapsed time between each fitted spectrum for an 
injection’s averaging window. 

ch4_ppm The average methane concentration, in ppm, is measured for that 
injection (Line). This column can be used to track potential spectral 
interference and data integrity. Methane concentration is not 
calibrated and should not be used directly to determine the 
methane concentration in the water source. 

h16od_adjust This term represents an adjustment applied to WLMh16od_offset, 
a filtered and scaled frequency error derived from least-squares fit. 
h16od_adjust is only reported on the L2130-i and L2140-i. This 
column may be used to the Picarro Technical Support team in 
diagnosing wavelength locking. 

h16od_shift This term represents an adjustment applied to WLMh16od_offset, 
a frequency error derived from least-squares fit. h16od_shift is 
only reported on the L2130-i and L2140-i. This column may be 
used to the Picarro Technical Support team in diagnosing 
wavelength locking. 

n2_flag Flag for reported the measurement mode at the time of 
measurement. n2_flag will equal 1 for operation in the N2 mode, 
and equal to 0 for operation in the Zero Air mode. 

DAS Temp Temperature measured at the DAS board in the Picarro analyzer. 

Tray .Tray name (a number for the older versions of the Autosampler) 

Sample Vial sample number. 

Job Line in the autosampler job queue. 

Method Autosampler method that is associated with the autosampler 
sequence.  

Error Code Error code associated with Autosampler operation. 
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11. Calibration 

11.1 Introduction 
Calibrating your Picarro water isotope analyzer involves three steps: 

• Measuring the isotopic composition of known standards 

• Determining the relationship between the measured value and the known value 

• Adjusting the settings on the analyzer to account for any difference between the 
measured and known values, so that the on-screen readings are accurate.  

Picarro recommends calibrating your Picarro L21x0-i analyzer using liquid water 
samples. All water isotope standards should have accepted values for δ18O and 
δ2H. If applicable, the standards should also be calibrated for 17O-excess. Picarro 
recommends referencing all isotope data back to the internationally-recognized 
VSMOW-SLAP scale.  

 
NOTE 

Upon manufacturing, Picarro guarantees the performance of your analyzer with 
respect to precision. The system is also calibrated using isotope standards, 
however Picarro does not certify the analyzer for accuracy. It is the 
responsibility of the instrument user to verify the factory-calibration and to 
calibrate the instrument for accuracy. 

11.2 Primary and Secondary Standards 
The isotopic composition of a water sample is typically determined relative to the 
known value in a standard using the delta notation and expressed as per mil (‰): 
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These delta values can be used to construct secondary parameters: 

Deuterium-excess (expressed as per mil (‰)): 

𝑑𝑑 − 𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒 =  𝛿𝛿 𝐻𝐻2 − 8 × 𝛿𝛿 𝑂𝑂18  

17O-excess (expressed as per mil (‰)):  

𝑂𝑂 − 𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒𝑒 = 1000 × 𝑙𝑙𝑙𝑙 �
𝛿𝛿 𝑂𝑂17

1000 + 1� − 0.528 × 1000 × 𝑙𝑙𝑙𝑙 �
𝛿𝛿 𝑂𝑂18

1000 + 1�17  

There are three international “primary” standards:  

• VSMOW2 – Vienna Standard Mean Ocean Water 2 

• SLAP2 – Standard Light Antarctic Precipitation 2 

• GISP – Greenland Ice Sheet Precipitation 

The GRESP standard is replacing the GISP standard that was available until 
2012. The table below shows the isotopic compositions of each standard: 

Table 8: Isotopic Compositions of VSMOW2, SLAP2 and GRESP Standards 

 δ18O (‰) δ2H (‰) 17O-excess (‰) δ17O (‰) 

VSMOW2 0 ± 0.02 [1] 0 ± 0.3 [1] 0 [2] 0 [2] 

SLAP2 -55.50 ± 0.02 [1] -427.5 ± 0.3 [1] 
0 [2] 

−0.015±0.005 [3] 
-29.6968 [2] 

−29.741±0.100 [3] 

GRESP 
-33.40 ± 0.04 [1] 
-33.45 ± 0.034 [4] 
-33.426 ± 0.028 [5] 

-258.0 ± 0.4 [1] 
-257.87 ± 0.52 [4] 
-258.20 ± 0.08 [5] 

0.025 ± 0.005 [4] 
0.038 ± 0.008 [5] 

-17.7784 ± 0.02 [4] 

[1] IAEA,  [2] Schoenemann et al. (2013), [3] Wostbrock et al. (2020), [4] Vallet-Coulomb et al. (2021), [5] Keinan and Goldsmith (2023) 

The  δ18O and  δ2H values are defined based on publications by the International 
Atomic Energy Agency (IAEA): 

VSMOW2 and SLAP2: 

https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Document
s/ReferenceMaterials/StableIsotopes/VSMOW2/VSMOW2_SLAP2.pdf 

GRESP: 

https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Document
s/ReferenceMaterials/StableIsotopes/Gresp/RS_GRESP-2021.pdf  

There is no consensus on the δ17O reference values for SMOW2, SLAP2 and 
GRESP. The table above provides an overview of the commonly assigned values 
as suggested by Schoenemann et al. (2013), Wostbrock et al. (2020),  
Vallet-Coulomb et al. (2021), and Keinan and Goldsmith (2023). 

https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/ReferenceMaterials/StableIsotopes/VSMOW2/VSMOW2_SLAP2.pdf
https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/ReferenceMaterials/StableIsotopes/VSMOW2/VSMOW2_SLAP2.pdf
https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/ReferenceMaterials/StableIsotopes/Gresp/RS_GRESP-2021.pdf
https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/ReferenceMaterials/StableIsotopes/Gresp/RS_GRESP-2021.pdf
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Picarro provides a Secondary Water Isotopes Standard Kit (part number C0356) 
that is based on standards provided by the United States Geological Survey 
[USGS]: 

Table 9: USGS Standards 

Standard δ18O (‰) δ2H (‰) 

USGS46 –29.80 ± 0.03 –235.8 ± 0.7 

USGS47 –19.80 ± 0.02 –150.2 ± 0.5 

USGS48 –2.224 ± 0.012 –2.0 ± 0.4 

Since the IAEA and USGS primary and secondary standards are expensive and 
sample limited, each laboratory should develop their own working standards. 
Example sources of working standards include: 

• Local precipitation (variable isotopic composition) 

• Local tap water (variable, related to local precipitation) 

• Kona Deep, Destiny Deep Sea Water (~ 0 ‰) 

• Snow or ice from your favorite alpine region (depleted) 

• Tap water from your colleagues across the globe (variable) 

The isotopic composition of a secondary standard should first be measured 
against a primary standard. Once calibrated with respect to the VSMOW-SLAP 
isotope scale, it can be used for routine, daily calibration. About 1.2 L of 
secondary standard would be enough for a year’s supply. This assumes each 
standard is measured 2x per day using a standard 2 mL autosampler vial, and 
that the analyzer is operated 300 days per year (2 mL / vial x 2 standard vials / 
day x 300 days = 1.2 L).  

References 
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of SLAP2 and GISP δ17O and proposed VSMOW-SLAP normalization for 
δ17O and 17Oexcess. Rapid Communications in Mass Spectrometry, 27(5), 
582–590.  

• Wostbrock, J. A. G., Cano, E. J., & Sharp, Z. D. (2020). An internally 
consistent triple oxygen isotope calibration of standards for silicates, 
carbonates, and air relative to VSMOW2 and SLAP2. Chemical Geology, 
533, 119432.  

• Vallet-Coulomb, C., Couapel, M., & Sonzogni, C. (2021). Improving 
memory effect correction to achieve high-precision analysis of δ17O, δ18O, 
δ2H, 17O-excess and d-excess in water using cavity ring-down laser 
spectroscopy. Rapid Communications in Mass Spectrometry, 35(14), 
e9108.  

https://store.picarro.com/Secondary-Water-Isotopes-Standard-Kit_2
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• Keinan, J., & Goldsmith, Y. (2023). A simple method for rapid removal of 
the memory effect in cavity ring-down spectroscopy water isotope 
measurements. Rapid Communications in Mass Spectrometry, 37(19), 
e9600 

11.3 Tools, Equipment and Samples Required 
1. Waters with known isotope signatures, i.e., a verified δ18O, δ2H and 17O-

excess (if applicable) value.  

• Picarro recommends all labs purchase one supply of primary 
isotope standards from IAEA or USGS. These primary standards 
should not be used on a daily basis. Instead, they can be used 
to calibrate secondary or in-house standards.  

• Secondary or in-house standards that bracket the isotope space 
of your sample set. A set of three working water isotope 
standards is also available from Picarro (part number C0350). 
These standards have been calibrated for δ18O and δ2H against 
the VSMOW-SLAP scale. 

2. 2 mL sample vials with caps. Picarro sells water isotope kits for 500 or 
1,000 samples (part number C0328 and C0329, respectively). These 
kits include 10 µL syringes, 2 mL glass vials with caps and injection port 
septa. Quantities vary based on the kit selected; visit the Picarro Store 
for more information: https://picarroinc.force.com/picarrosupport   

3. Pipette for transferring water from primary storage (e.g., pressurized 
stainless steel barrels) to secondary storage (e.g., sealed amber vials) 
and eventually into sample vials (2 mL sample vials with caps and 
septa). 

4. Permanent marker or label maker for labeling sample vials.  

5. Refrigerator (or freezer) for storing water standards. If storing waters in 
the freezer, ensure the water is either stored in an expandable container 
or that the container has ample room for water expansion upon freezing. 
Also ensure the water is completely defrosted before conducting any 
analysis or sub-sampling from the water. For additional information on 
storing water isotope standards, please see section 15.5 Sample and 
Standard Handling.  

11.4 Calibration Methodology 
You should calibrate your samples using water standards that are introduced to 
the analyzer using an identical (or as close to identical) methodology as the 
samples. 
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• For clean liquid water samples, analyze your standards using the 
same method, i.e., with the High Precision Vaporizer and 
Autosampler. 

• When using the Micro Combustion Module (MCM) to analyze plant 
waters and other contaminated waters, also analyze your standards 
using the MCM.  

• For ambient atmospheric monitoring, calibrate your system using 
liquid water standards of known isotopic composition using a 
Standards Delivery Module or dual mode kit. You can also design 
your own lab-built nebulizer or bubbler. For ambient atmospheric 
studies, calibrate for both accuracy in delta space and the 
dependence of delta value on water vapor concentration.  

• For matrix bound water analyzed using the Induction Module (IM), 
measure your liquid water standards using the sample introduction 
methodology and heating recipe.  

• For the Continuous Water Sampler, produce large volumes of tertiary 
water standards that can be analyzed on the CWS. Calibrate these 
standards using the High Precision Vaporizer and Autosampler. 

 
NOTE 

Picarro isotopic water analyzers are not calibrated for water vapor 
concentration. If high accuracy water vapor concentration is desired, calibrate 
your system with a dew point generator that can introduce vapor streams of 
known concentration. 

11.5 Performing Calibration Measurements 
Since the Picarro analyzer is extremely linear, it is only necessary to use three 
calibration standards to calibrate each isotopic species (two points define the 
calibration line and a third intermediate point is used for verification). The exact 
value of each calibration standard is not of particular importance, as long as they 
span a representative range of values over which the analyzer will typically be 
operated. Although it is not necessary to use more than three standards, 
additional standards can be used to further constrain the linear calibration 
coefficients. 

Each calibration standard should be introduced into the analyzer for an interval 
long enough for the analyzer to yield a stable measurement of that sample. In the 
case of water isotopes, it is important to ensure sample-to-sample isotopic 
memory is overcome prior to using injection pulses for calibration. For example, if 
there is a significant difference in the isotopic composition of two adjacent 
standards, it is important to increase the number of injections per vial for the 
purpose of calibration. For example, if the system is calibrated directly with 
VSMOW and SLAP, which represent the largest natural variability in oxygen and 
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hydrogen isotopes, Picarro recommends at least 10 injections are made per vial 
prior to averaging 3-5 injections for the purpose of calibration. Such a high 
number of injections is not required for samples that are more closely spaced in 
isotopic composition. 

For routine daily calibration, secondary standards can be interspersed with 
samples during a given run. The order in which you run the standards can provide 
information about parameters, such as drift and sample-to-sample isotopic 
memory, which are helpful in assessing data quality. Picarro recommends the 
following daily calibration procedure: 

• Measure three standards that bracket the expected composition of 
samples at the beginning of the autosampler run.  

• Measure one of those standards again in the middle of the 
autosampler run. 

• Measure the three same standards again at the end of the 
autosampler run. 

At the completion of the autosampler sequence, the standards can be used to 
construct a bracketed calibration. Plot the measured values of the standards on 
the x-axis, and the known values (versus VSMOW-SLAP) of those standards on 
the y-axis. A linear regression can then be used to correct your sample data to the 
VSMOW-SLAP scale. If necessary, the standard that was run at the beginning, 
middle and end of the autosampler sequence can be used to correct drift. Finally, 
remember that standard operating procedure is to discard the first three injections 
for any sample vial and then average the remaining injections to get the value of 
that water. The total number of injections made, and the number discarded can be 
optimized based on performance requirements and the sample-to-sample jumps 
in isotope space. It is possible to correct sample data to the VSMOW-SLAP scale 
by post-processing the Coordinator output data. Alternatively, Coordinator data 
can be analyzed using ChemCorrect™. Finally, if there is a desire to update the 
on-screen readings, the Picarro software can be updated by following the 
instructions given in the next section.  

11.6 Updating the Instrument Calibration for Accurate 
On-Screen Readings 
Once you have measured your standards, you can use either of the two methods 
described below to calibrate the analyzer. Method 1 requires you to make a graph 
(known standards versus measured standards) to calibrate the analyzer. 
Method 2 does not require you to make a graph; however, the effect of this 
calibration is harder to reverse than Method 1. 
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Method 1: Using the CRDS Data Viewer to Update the On-
Screen Readings 
For isotope standard measurements, plot the analyzer’s reported isotope value on 
the horizontal (x) axis and the standards’ known isotopic composition on the 
vertical (y) axis. This graph will help you to determine the linear relationship 
between the known calibration values and the analyzer’s reported values.  

Calculate a linear best-fit equation from the data. The slope and intercept of the 
best-fit line through these points are the two values that are used to calibrate the 
analyzer. Determining the linear relationship between the known values and the 
analyzer’s reported values enables the calculation of a calibration offset (slope 
and intercept). This adds a correction term to the analyzer’s factory or previous 
calibration. 

The analyzer’s calibration is intended to be altered infrequently. Instead of 
recalibrating frequently to increase the accuracy of the data, users often verify the 
calibration by measuring three or more water standards and using the same 
regression procedure described here to calculate an offset by which to correct 
their data offline (see previous section). In the calibration example data below, 
fitting the three standards yields the linear equation y = 0.9866x + 5.2658 with the 
slope m = 0.9866 and the intercept b = 5.2658. This equation would be used with 
x = raw data measured by the analyzer (labelled “CRDS Reported”) to give y = 
corrected data (labelled “Certified” value). 

Table 10: Calibration Example Data 

 CRDS Reported Value Certified Value 

Calibration Point #1 200.1 202.7 

Calibration Point #2 600.3 597.6 

Calibration Point #3 400.0 400.0 

 
 
 



Calibration   

L21x0-i Inst/Op Manual  P/N 40035 Rev. G 99 

 

Figure 54: Linear Calibration Example  

Enter these calibration values into the software by selecting User Calibration 
from the Tools menu on the CRDS Data Viewer. Enter the slope and intercept for 
each species. This is a password-protected function, with the default password 
“picarro." 

 

Figure 55: User Calibration Dialog 
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After the calibration is entered, it will take effect immediately after clicking OK. 

To return to the factory calibration, simply set the slope to “1” and the intercept to 
“0” for each species. 

This calibration approach and functionality is available across all Picarro 
analyzers. In the example data given above the species measured were CO2, CH4 
and H2O concentration. The same method applies for isotope data, including  
δ18O,  δ17O,  δ2H.  

Method 2: Using the “Picarro Data Recalibration Tool” to 
Calibrate the Analyzer 
This tool can be used after you have performed the calibration measurements of 
standards with your Picarro analyzer. 

The Picarro Data Recalibration (“Data Recal” icon) software can be found in the 
Picarro Utilities folder in the desktop, and it can be used to recalibrate the data 
analyzed by Picarro analyzers.  

 

 

Figure 56: Data Recalibration Tool 
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1. Double-click the Data Recal icon to pull up the window to the left. 

2. Click on Clear Entries to reset the values in the “Picarro Data 
Recalibration” window. 

3. Enter data values into the Certified (expected delta values) column. 

4. Enter data values into the CRDS Reported (delta reported by Picarro 
analyzer) column. 

5. Check the boxes in the Used for Recal column that you want the 
software to base the calibration on. 

6. Click the Compute button located at the bottom of the window.  

The recalibrated values will appear in the rightmost column called 
Recalibrated. 

7. Click Apply New Cal if you want to apply the calibration to your future 
measurements. 

8. The default User Calibration Password is “picarro.” Click OK to 
continue. NOTE: This action cannot be undone from the “Picarro 
Data Recalibration Window,” but it CAN be undone in Method 1 in 
the “User Calibration” window. 

 

Figure 57: Password Window 

9. Review the values in the window (Figure 58), and click YES to confirm, 
then OK to continue. 
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Figure 58: Confirmation Windows 

10. A Save Calibration Dialog window appears giving the option to save 
your calibration settings. Click Cancel if you don’t want to save your 
new calibration setting. 

 

Figure 59: Save Calibration Dialog 
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11. You have now calibrated your analyzer. The next time you do any 
sample measurements, the on-screen measurement readings will be 
based on the new calibration setting. 

11.7 Literature and Other Useful Resources 
There are many useful resources regarding calibrating systems for accurate water 
isotope measurements. A non-exhaustive list is below:  

• Gröning, M. (2018). TEL Technical Note No. 03. Stable isotope internal 
laboratory water standards: Preparation, calibration, and storage. 

https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared 
Documents/Publications/TechnicalNotes/TELTechNote03_WaterInternalL
aboratoryStandards.pdf 

• Hachgenei, N., Vaury, V., Nord, G., Spadini, L., & Duwig, C. (2022). Faster 
and more precise isotopic water analysis of discrete samples by predicting 
the repetitions’ asymptote instead of averaging last values. MethodsX, 9, 
101656.  

• Keinan, J., & Goldsmith, Y. (2023). A simple method for rapid removal of 
the memory effect in cavity ring-down spectroscopy water isotope 
measurements. Rapid Communications in Mass Spectrometry, 37(19), 
e9600.  

• Terzer-Wassmuth, S., Wassenaar, L. I., Araguás-Araguás, L. J., Stumpp, 
C., & Terzer, S. (2023). Balancing precision and throughput of d17O and 
Δ’17O analysis of natural waters by Cavity Ringdown Spectroscopy. L.I. 
Wassenaar, L.J. Araguás-Araguás et Al. MethodsX, 10, 102150.  

• Vallet-Coulomb, C., Couapel, M., & Sonzogni, C. (2021). Improving 
memory effect correction to achieve high-precision analysis of δ17O, δ18O, 
δ2H, 17O-excess and d-excess in water using cavity ring-down laser 
spectroscopy. Rapid Communications in Mass Spectrometry, 35(14), 
e9108. 

https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/Publications/TechnicalNotes/TELTechNote03_WaterInternalLaboratoryStandards.pdf
https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/Publications/TechnicalNotes/TELTechNote03_WaterInternalLaboratoryStandards.pdf
https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/Publications/TechnicalNotes/TELTechNote03_WaterInternalLaboratoryStandards.pdf
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12. ChemCorrect™ Software 

12.1 Principle of Operation 
Picarro CRDS has become a de facto standard for many water sample research 
areas, such as ice core, watershed, and aquifer studies. For various reasons, 
samples can contain a variety of chemical contaminants, which in some cases 
can lead to spectral interference that can degrade the accuracy of results. It is 
difficult to eliminate these contaminants from water samples without fractionating 
the isotope ratios and diminishing sample fidelity.  

Proprietary software, called ChemCorrect, comes pre-loaded on your Picarro 
water isotope analyzer. This program solves the problem of data degradation and 
fidelity resulting from water samples contaminated with trace hydrocarbons. The 
software makes the a priori assumption that your standards are clean waters that 
do not contain any contamination. Then the program compares a number of 
features in the spectra from the samples and the standards, applies a statistical 
test to see if the samples are different from the standards, and assigns flags 
based on the statistical differences. These flags alert you to artifacts, potentially 
from contamination, which may affect the accuracy of your results. Finally, the 
software uses a linear regression to correct your samples to an isotope reference 
scale by comparing the measured values of your standards to their accepted 
values. For more information on organic interferences, see the Picarro application 
note: Plant Water: Accurate Water Stable Isotope Analysis of Organic 
Contaminated Water. 

How Contaminants Impact The Optical Spectrum 
Contaminants fall into one of the following three categories, based on the nature 
of the distortion to the optical spectrum:  

1. Compounds that do not affect the spectrum (at concentrations up to 10-
20% of the water sample). Most compounds fall into this category. In the 
presence of these contaminants, Picarro analyzers will report accurate 
and precise isotope values without bias or increase in noise.  

2. Large compounds (with more than about 6-8 atoms) contribute a broad, 
spectrally unresolved absorption baseline beneath the target molecules. 
To first order, this baseline will cause no systematic bias to the reported 
values. Because optical absorption is a linear, additive process, the 
water vapor spectrum will ‘float’ on top of the contaminant baseline. The 
linearity and wide dynamic range of CRDS makes the technique 
particularly insensitive to these baseline offsets.  

3. In some cases, however, this baseline offset is accompanied by a tilt of 
the spectrum with wavelength. This larger offset, if uncorrected, can 

https://www.picarro.com/support/library/documents/an040_plant_water_accurate_water_stable_isotope_analysis_of_organic
https://www.picarro.com/support/library/documents/an040_plant_water_accurate_water_stable_isotope_analysis_of_organic
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cause bias in the measurements and degrade the precision of the 
instrument.  

4. Small compounds (with fewer than 6-8 atoms) have spectrally resolved 
absorption lines that can interfere with the lines from the observed water 
vapor. This can lead to systematic errors in the reported isotope ratios. 
One example of such a molecule is methanol, which has a particularly 
complex absorption spectrum in this spectral region.  

ChemCorrect software uses known spectral interferences or general 
spectral patterns to identify trends due to contamination. 

ChemCorrect on the L2130-i and L2140-i:  
The L2130-i and L2140-i, when operating in ‘normal’ measurement mode (δ18O 
and δ2H), also measure spectral indicators that can be used to determine the 
integrity of the spectra and resulting data.  

Using the spectral indicators listed below, the ChemCorrect software performs 
statistical tests to determine how those spectral features differ between the 
samples and the standards.  

• RESIDUAL: The root mean squared residual of the least-squares fit to a 
spectra, in units of ppb/cm, is used to screen for potential small molecule 
contaminants, e.g., methanol.  

• BASELINE SHIFT: The spectral baseline is a good early indicator of a 
potential issue with a sample. The baseline shift term is a change in the 
constant term of a fitted baseline, in units of ppb/cm.  

• BASELINE CURVATURE: The spectral baseline is a good early indicator 
of a potential issue with a sample. The baseline curvature team is a 
change in the quadratic term of a fitted baseline, in units of ppb*cm. 

• SLOPE SHIFT: The slope of the spectral baseline or change in the linear 
term of the fitted baseline, in units of ppb/cm, although not unique is also a 
useful indicator for moderately-sized molecules, e.g., ethanol that can 
interfere with nearby spectral features.   

The software flags these indicators if they deviate from the thresholds set in 
ChemCorrect. 

For example, a red flag can be triggered by any of the following:  

• The sample residual being 1.5 σ away from the mean of the 
standards residual 

• The sample baseline shift being 18 σ away from the mean of the 
standards baseline shift 

• The sample baseline curvature being 3 σ away from the mean of the 
standards baseline curvature  
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Sometimes the software generates false positives by flagging features that do not 
arise from contamination. To reduce the number of false positives, the notification 
thresholds can be changed to be less stringent. This can be done by editing the 
ChemCorrect Instruction Set. If a user edits the Instruction Sets, we recommend 
changing the name of the Instruction Set so that it is possible to revert to the 
original set supplied by Picarro.  

If a flag is raised, a number of things can be done. First, try some offline sample 
treatment methods, such as the use of activated charcoal. Second, if you suspect 
alcohols may be present in your samples, you can utilize Picarro's Micro 
Combustion Module (MCM) to remove those artifacts. Third, and as a last resort, 
you can analyze your samples using an alternative technique, such as Isotope 
Ratio Mass Spectrometry (IRMS). IRMS is not susceptible to spectral interference 
from alcohols; it can, however, introduce other analytical artifacts and have other 
interferences, such as mass interference, which can affect accuracy.  

12.2 Analysis of Coordinator Output Files 
The following Coordinator output files can be post-processed using ChemCorrect: 

• High Precision 

• High Throughput 

• Manual Injection 

• Standard 

• Express 

• Micro Combustion Module 

ChemCorrect cannot be applied to data δ17O and 17O-excess data. Nor can it be 
applied to Coordinators generated during SDM, IM, Dual Mode, or Continuous 
Water Sampler Setups.  

12.3 Preparing the Run Sequence 
1. Each run needs at least 2 standards (3 is recommended but more is 

better) with known δ18O and δ2H values. These values create a linear fit, 
which is used in calibration of the samples. 

2. The standards must be run one after another at the beginning of each 
sequence to be analyzed. The post processing software works 
sequentially and therefore requires the linearity of the known standards 
before it can correct the unknown values of the samples. It is 
recommended to include standards in the middle and end of the sample 
set as controls. An example is shown (Figure 60), vials with the CYAN 
stars indicate the standards: 
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Figure 60: Run Sequence with Standards 

3. Due to memory, the first two to three injections of each vial should be 
ignored. Because of this, a minimum of six injections should be run per 
vial. The number of injections is set using the Autosampler Controller 
software (A0340 or A0325). 

12.4 Files Required to Run ChemCorrect 
ChemCorrect requires a standards file, an instruction set, and a source file (data 
output from the coordinator software that is in C:\IsotopeData). Each of these files 
are provided in .csv formats. To ensure the standards file format is preserved, 
Picarro recommends editing the file using Notepad++ which is provided with the 
analyzer.  

A sample data file along with the standards and instruction files can all be found in 
the ChemCorrect main folder C:\Picarro\ChemCorrectExe. 

Standards File 
The standards.csv file must contain the name and known δ18O and δ2H values of 
each standard (relative to an isotope reference scale, typically VSMOW-SLAP for 
water isotopes). The names in the standards.csv file must match (case-sensitive) 
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the names in the source file under “Identifier 1”. If they do not match, standards 
will be treated as samples.  

 

Figure 61: Standards CSV File Example   

Instruction Set  
The instruction set is provided by Picarro. 

• L2130-i / L2140-i Instruction Set: chemcorrect_inst avg_orgeval_10.csv 

Source File  
This is the output file from the Coordinator (stored in C:\IsotopeData). Before 
closing the Coordinator at the end of an Autosampler Sequence, it is advised to 
load the sample description file. Below is an example of a sample description file. 
Ensure that the “Identifier 1” for standards is identical to the “Standards Name” list 
in the standards file. 

 

Figure 62: Sample Description File 



ChemCorrect™ Software   

L21x0-i Inst/Op Manual  P/N 40035 Rev. G 109 

12.5 Running ChemCorrect 
1. Double-click the ChemCorrect icon on the analyzer desktop. The 

ChemCorrect program will now open. 

2. The top four boxes are the required fields: the most recent Source file 
name (sometimes empty), Instruction Set name, Standards File and 
the number of Injections to Ignore. You also have an option to plot 
additional graphs for other parameters.  

3. To choose a different source file to be analyzed, click the Source button 
located on the bottom of the window. Then use the finder window to 
locate the desired raw data file and click Open. 

4. To select a different instruction file than the one displayed, click the 
Instruction Set button located on the bottom of the window. Then use 
the finder window to locate the desired instruction file and click Open.  

5. To change the number of injections to be ignored, highlight the existing 
number and type in the preferred one (required 2 but 3 is 
recommended). Do not leave this field blank. 

6. When the correct source and instruction files are shown, click the OK 
button at the bottom of the window to start the ChemCorrect analysis. 

 

Figure 63: ChemCorrect Window 

Different Instruction Sets 
and Standards files are 

used for different 
analyzers. 

Make sure there is a 
number here. Do not 

leave blank. 
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12.6 Example Analysis 
See the Figure 64 below. 

1. Select HBDS01_IsoWater_20100604_180843.csv (which Picarro has 
provided in C:\Picarro\PostProcess\ChemCorrectExe\) as the source, 
and chemcorrect_inst avg_orgeval_10.csv as the instruction file. Then 
click OK. 

2. The first display is called the Summary. Contained here are: the 
calibrated isotope values and visual indicators as to the severity of 
contamination by sample. 

3. The CYAN rows are standards. 

4. The GREEN rows are samples that have been determined to have little 
to no contamination. 

5. The YELLOW rows are samples that contain trace values of 
contamination that may slightly shift the isotope values. 

6. The RED rows are samples with severe contamination leading to 
inaccurate  δ2H and  δ18O readings. 

7. A star next to a sample indicates a problem, e.g. missing rows in the 
source file resulting in an inaccurate calculation. 

8. Red/yellow rows display relative contamination due to methane, 
methanol, or “other” hydrocarbons in the respective columns on the 
right. 

 

Figure 64: ChemCorrect Analysis 
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9. There are other tabs that can be accessed by clicking on them in the top 
left corner of the window: 

10. Detail: Summons a list of summarized charts by injection and sample 
chronologically. The un-calibrated and calibrated values, as well as the 
measurements taken to calibrate the values are included per injection. 
Below each chart is a summary. 

11. Source: Displays the original raw data file without any changes or 
calibration. 

12. Instructions: Displays the raw instruction file used by ChemCorrect as 
well as comments on the far right of each instruction. 

13. Additional plots for visualizing your data. 

14. At the bottom of the ChemCorrect window are additional buttons OK, 
Export Spreadsheet, and Exit buttons.  

15. OK: Each time you reload the source and instruction sets, you can click 
OK again to process more data without closing and re-opening 
ChemCorrect. Once you make your edits, export the result to save your 
processed data.  

16. Export Spreadsheet: Creates an excel spreadsheet complete with all 
the information contained in the four tabs in the ChemCorrect main 
window as well as all the data sets and formulas used to calibrate the 
isotope values. 

17. Exit: Quits ChemCorrect.  

18. The standards.csv file can be amended if needed, but the format must 
remain the same. To edit, simply open the file, make the desired 
changes, and click save. For the changes to be reflected in 
ChemCorrect, click the OK button at the bottom of the ChemCorrect. 

19. For more advanced users, Instruction Sets can be edited to perform 
your required calculations. NOTE: If editing the Instruction Set, we 
recommend changing the name of the Instruction Set so that it is 
possible to revert to the original set supplied by Picarro.  

 
NOTE 

Picarro recommends running the post processing within 7 days of initially 
acquiring the data. If a sample is flagged as contaminated, the post processing 
software will automatically set aside the associated spectral files. These files can 
be sent to Picarro for further analysis and spectral library development. Once set 
aside, these files will not be affected by the automatic file management software 
which is running on the analyzer. 

Due to the large amount of data generated by the analyzer a buffer of approximately 
10 GB of spectral files are kept, after which point, they are erased. This 
corresponds to approximately 2 weeks of operation. Running the post processing 
ensures that any spectra associated with contamination are not erased. 
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13. File Management 
The Picarro analyzer generates ASCII-format text output files that are updated after 
each batch of concentration measurements is complete. The data files are stored 
primarily in UserData folders and are also mirrored in folders which retain more 
situational data. Some analyzers also produce discrete measurements stored in 
separate isotope data folders. All user data is archived, compressed, and retained, either 
shortly after the measurements or at a later point, to optimize space on the hard drive. 

13.1 User Data Folder 
The User Data folder is located at: 

C:\UserData\DataLog_User - with files arranged by year\month\day\hour. 

The User Data files are in a simple text format (white-space delimited) with a DAT 
file extension. By default, each file stores one hour of data. 

Using the Setup Tool, the user can select and customize the data columns, file 
length, total storage size and folder structure for the user data logs. Setup Tool is 
described in more depth in APPENDIX A – Setup Tool and Communication. 

Certain instruments may contain additional sub-folders under C:\UserData\ 
relating to time synced file formats, soil flux, or GPS data, among others. If the 
user has any questions about this file structure, they can contact Picarro Support. 

13.2 Data File Name 
The file name is generated from the analyzer serial number, the date, and the 
time when the file was started. The specific time stamp will depend upon the time 
the instrument was started and began measuring sample gas, so files seldom 
begin exactly at the top of the hour. For example: 

 

Figure 65: Example Data File Name 

• CFADS2101 is the analyzer serial number 

• 20210201 is the date, in format yyyymmdd (to allow chronological sorting 
of data files). 

Instrument Serial 
Number 

Date Time (Local) 

CFADS2101-20210201-224542Z-DataLog_User.dat 
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• 224542 is the time the file was started in the computer’s Local Time as 
displayed in the lower right hand side of the Windows OS  screen, 
22:45:42, formatted as hhmmss using a 24-hour clock. Note that the time 
stamp of samples within the file is usually recorded in UTC (GMT) relative 
to the local time. For example, an analyzer in California will usually have a 
time stamp (UTC) within the file that is 8 hours ahead of the time stamp in 
the file name itself (UTC - 8).  

13.3 Data Archive  
The archive directory is: 

C:\Picarro\G2000\Log\Archive\  

and has subdirectories: 

DataLog_Private, DataLog_EventLogs, and DataLog_Mailbox. 

DataLog_Private 
These data files contain a comprehensive list of system parameters such as 
instrument temperatures and pressure, set points and spectroscopy. This 
additional information is not broadly relevant to the user for day-to-day operation 
but can be useful for diagnostic purposes. Files are stored by the convention: 

C:\Picarro\G2000\Log\Archive\DataLog_Private \[year]\[month]\[day]\[hour] 

The archive files are in a more efficient HDF5 format, with extension .h5. 

DataLog_EventLogs 
Event logs contain records of the operation of the instrument, the performance of 
the wavelength monitor and lasers, and record exceptional events like pressure or 
temperature instability. This is also a critical resource for Support to diagnose or 
troubleshoot an issue with an analyzer. Files are stored by the convention: 

C:\Picarro\G2000\Log\Archive\DataLog_EventLogs 
\[year]\[month]\[day]\[hour] 

DataLog_Mailbox 
The Mailbox folder contains individually zipped files which have been compressed 
to allow automated transfer via email. Unlike the folders above, this folder is not 
subdivided by year, month, and day. Email synching is described in greater detail 
in APPENDIX A – Setup Tool and Communication. 
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13.4 User Data Folder 
The User Data folder C:\UserData\ contains one or more subfolders associated 
with real-time instrument data.  

DataLog_User (all instruments) 
Raw user data is contained in the DataLog_User folder, with format: 
C:\UserData\DataLog_User\[year]\[month]\[day]\hour 

This is the most relevant folder for users of non-isotopic instruments, as this 
provides the real time data output in its most digestible form. These data files 
reflect the native time interval of the instrument, typically between 0.1Hz and 10 
Hz.  

DataLog_Sync  
Some instruments will also contain a (C:\UserData\DataLog_Sync\...) directory, 
which includes data that is evenly spaced in time as specified by the user in the 
Setup Tool, covered in APPENDIX A – Setup Tool and Communication.  This 
format is preferred by some users who need e.g., 1Hz data exactly, or who prefer 
to record smaller data files with data spaced, e.g., every 60 seconds.  

DataLog_GPS 
Instruments may come with the ability to log GPS data, which can be found in this 
subdirectory. 

DataLog_SFP 
Instruments may come with the soil flux processor software. Associated data files 
may be found in this subdirectory. 

13.5 Isotopic Data 
Isotopic instruments use Coordinator programs to produce discrete isotopic 
values for individual samples or injections. Each time a Coordinator is opened, a 
data file will be produced in one of two places, depending on the peripheral used, 
either: 

C:\IsotopeData (sometimes called C:\IsotopicData)   

or  

C:\Picarro\IsotopicData (sometimes called C:\Picarro\IsotopeData) 

While the coordinator program is running, individual sample value outputs will be 
populated as a new line into the coordinator window, and the respective data file.  
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13.6 File Archiving 
Picarro instruments will not delete data. Some instruments will, however, 
compress and archive older data to conserve hard drive space. Raw data file 
archiving frequency and details can be modified in the file:  

C:\Picarro\G2000\AppConfig\Config\Archiver\Archiver.ini. 

 
CAUTION 

To avoid losing data, discuss with Picarro support before attempting any 
changes to the Archiver.ini file. 

For each file type, there are various items along with some recommended default 
settings which may vary by file type: 

• Directory = C:/UserData/DataLog_Sync 

Optionally specifies which directory to find files to archive. 

• MaxCount = -1 

Specifies how many files to keep. A setting of -1 indicates that there is no 
maximum number of files. Generally, -1 is used in conjunction with a 
maximum size limit, below. 

• MaxSize_MB = 1500 

Specifies that a maximum of 1.5 GB of data is to be kept before the 
system begins to archive old data. 

• Compress = True/False 

Specifies if archived files are to be zipped – recommended setting is true 
to save hard drive space. True means files are zipped, false means files 
are not zipped. 

• AggregationCount = 0 

If compression is set to TRUE, specifies how many files to be included in 
each zip archive. 

• StorageMode = FIFO 

First in first out. Specifies that old data is archived first. 

• Quantum = 4 

Generally, should not be changed. Specifies the files be sorted by 
year\month\day\hour in the archived directory structure. 
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13.7 Measuring Time in Picarro Data Files 
Since measurements performed by Picarro analyzers are asynchronous (they 
require a variable and unpredictable amount of time to complete) data reported by 
the analyzer is time stamped. Each independent measurement is given a time 
derived from the Windows™ computer’s system clock (reference 
http://en.wikipedia.org/wiki/System_time). This time can be reported by one or 
many of the following variables. 

Table 11: Time Measuring Variables 

Variable Name Description Units 

DATE The calendar date formatted as YYYY-MM-DD 

Example: August 24, 2023 is formatted as 2023-08-24 

-NA- 

TIME The time of day formatted as HH:MM:SS.SS on a 24-
hour clock 

Example: 4:18:53.12 PM is formatted as 16:18:53.12 

-NA- 

FRAC_DAYS_SINCE_JAN1 The number of days since midnight January 1 of the 
current year  

Example: at 3:00:00 PM on January 12 the value is 
11.625 

days 

FRAC_HRS_SINCE_JAN1 The number of hours since midnight January 1 of the 
current year  

Example: at 3:00:00 PM on January 12 the value is 
279.0 (=FRAC_DAYS_SINCE_JAN1*24) 

hours 

JULIAN_DAYS The number of the day of the current year  

Example: at 3:00:00 PM on January 12 the value is 
12.625 (=FRAC_DAYS_SINCE_JAN1+1) 

days 

EPOCH_TIME The number of milliseconds since midnight January 1, 
1970 

Example: at 3:00:00 PM on January 12 the value is 
1421074800000 (= time) 

ms 

timestamp The number of milliseconds since midnight January 1, 1 
if the current Gregorian calendar was extended back to 
that time 

Example: at 3:00:00 PM on January 12 the value is 
63556671600000 

ms 

http://en.wikipedia.org/wiki/System_time
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Variable Name Description Units 

time The number of milliseconds since midnight January 1, 
1970 

Example: at 3:00:00 PM on January 12 the value is 
1421074800000 (= EPOCH_TIME) 

ms 

ymd The calendar date formatted as YYYYMMDD 

Example: August 24, 2023 is formatted as 20230824 

-NA- 

In the table above, all times are reported in GMT (also known as Zulu time and 
very closely related to UTC – reference: 
http://en.wikipedia.org/wiki/Greenwich_Mean_Time). We express these 
timestamps in GMT to avoid complications during Daylight Saving Time or when 
instruments are moved across time zones. The accuracy of the times are, of 
course, only as good as the accuracy of the Windows™ clock. To learn how to 
automatically synchronize the computer’s clock to a time standard, see section 
A.2 Remote Data Access located in APPENDIX A – Setup Tool and 
Communication There are many online calculators (for example, 
http://www.epochconverter.com) that convert Epoch Time to local time at any time 
zone, as well as many functions in commonly used data analysis programs that 
perform the same calculations. 

 

http://en.wikipedia.org/wiki/Greenwich_Mean_Time
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14. Performance Verification 

14.1 Drift and Precision Testing 
Precision and drift tests for δ18O and δ2H (δ2H) are recommended every 6 to 12 
months throughout an analyzer’s lifetime. This will allow you to verify a new 
installation, track performance as the instrument ages, determine if it is time for a 
Factory Refresh, and perhaps identify a small problem before it becomes a major 
setback. These tests can also be performed when data quality suddenly and 
inexplicably deteriorates.  

The drift and precision test for a L2130-i and L2140-i is conducted by measuring 
water from the wash station, instead of vials. These analyzers are precise enough 
to detect small variability in the composition of water from individual vials, even if it 
was sourced from the same supply. By running the drift and precision test from 
the wash station, vial to vial noise is avoided.  

The following instructions contain sections specific for each of the Picarro 
Autosamplers (model number A0340 or A0325), covering small setup and 
software settings differences.  

1. Fill a wash station jar with water and screw on the cap. The water 
should be pure deionized water, with no organics or salts, although tap 
water, bottled water, or one of your secondary standards can be used. 
Because of the large volume required, we do not recommend using 
primary standards for this test. The sample should be filtered if it 
contains particulate matter.  

2. Autosampler (A0340) – Users place the wash station jar in either one 
of the two wash station jar positions. (Picarro_DIW_Analysis_Station in 
the software) The software is instructed to pull from the correct jar.  

Note: In Autosampler (A0340) the was station are designated 1 and 2 
from front to back. Contrary in older models this designation is reversed. 

Autosampler (A0325) – Users place the wash station jar in the rear 
wash station jar position (Wash Station 1).  

3. Double-click on the desktop icon Autosampler Control. This opens the 
program that controls the Autosampler.  

4. Autosampler (A0340) – Create a job with 210 injections from the 
position of the Picarro_DIW_Analysis_Station that you want to measure. 

Autosampler (A0325) – In the top row of the sample list, check the box 
to the right of the Clear button. Then use the keyboard command ‘Ctrl 
+ i’ to switch to the wash station test mode. 
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Note: This is a run sequence that will only draw water out of wash 
station 1. Select the method Picarro from the drop down list and enter 
210 into the box underneath the column ‘#Inj.’. This will set up a run of 
210 injections from the wash station.  

 

Figure 66: Autosampler Control Window 

5. Click Run. 

6. Minimize the Autosampler window and double-click on the desktop icon 
Coordinator Launcher.  
This will open the window ‘Picarro Coordinator Launcher’ with a 
dropdown menu ‘Select Coordinator.’  

7. Select High Precision and click Launch.  

Once the ‘CRDS Coordinator’ window is open, it will start to run through a 
series of checks, which include cleaning the vaporizer by opening and 
closing valves.  

8. Once the vaporizer cleaning has finished, the Coordinator will initiate the 
first injection from the Autosampler. Then it will run through the entire 
Autosampler queue that was set up in step 5. The complete 
Autosampler queue will include 210 injections and it will take 
approximately 24 hours.  
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You can monitor the progress of the run in the CRDS Coordinator 
window. Please check to ensure that H2O concentrations of the first few 
injections fall within about 15,000 to 20,000 ppm, and that the injection 
concentrations are within about ± 1,000 ppm of each other. You can now 
leave the system to run for 24 hours, during which time it will collect the 
necessary data to test the precision and drift of the instrument. 

9. When the run is complete, navigate to the file C:\IsotopeData and 
identify the Coordinator output file. The correct file name can be found in 
the CRDS Coordinator window in the Filename box, and the file will 
have the format .csv (comma-separated values). Move this file to 
another computer with Microsoft Excel or similar spreadsheet program. 

10. Open the .csv Coordinator output file. Then copy and paste data from 
the columns labeled d(18_16)Mean and d(D_H)Mean into a drift and 
precision test analysis spreadsheet that can be downloaded here: 

 https://picarro.box.com/s/f660al39eiacqvmss40bt57tuq47dbfy 

The spreadsheet is set up to calculate precision and drift and record the 
values in table provided. Within the spreadsheet, you will find a table 
labeled Report. Review this table and check the cells underneath the 
column State. If these cells read pass, the instrument passed the 
standard drift and precision test. If any boxes are labeled fail, you should 
contact Picarro’s Technical Support team at support@picarro.com. 
Please be prepared to provide the serial number of your analyzer.  

14.2 Leak-Free Operation with a High Precision 
Vaporizer (A0211) 
Following an injection of liquid into the water isotope analyzer, the shape of the 
square "pulse" in the water concentration versus time graph provides information 
about the quality of the injection and any potential problems that can lead to poor 
data.  

One potential problem is a leak between the vaporizer and the analyzer. These 
leaks can be detected by plotting the water concentration along with the “outlet 
proportional valve” setting during the analysis. The outlet valve performance 
provides a way to identify unexpected pressure changes in the system, and it is a 
useful indicator of vaporizer performance. Here’s why: The vaporizer converts a 
liquid sample into gas. At the beginning of sample analysis, one of the vaporizer 
valves is opened to the analyzer to allow gas to pass from the vaporizer into the 
analyzer cavity. During analysis, the pressure in the cavity steadily decreases 
because the gas is leaving the fixed volume of the vaporizer. To keep the cavity 
pressure constant, the outlet proportional valve slowly adjusts to compensate for 
the pressure change at the inlet. 

For additional background on the operation of the High Precision Vaporizer, you 
can review the following Picarro Community post online: 

https://picarro.box.com/s/f660al39eiacqvmss40bt57tuq47dbfy
mailto:support@picarro.com
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http://www.picarro.com/community/picarro_community/vaporizer_a0211_operatio
n_schematic (Access requires user login; If you do not yet have an account, 
please send an email to: support@picarro.com to request access to documents 
and manuals.) 

14.3 Viewing the Outlet Valve Position 
To access the outlet valve position plot within the CRDS Data Viewer GUI, go to 
Settings > Change GUI Mode. When asked for a password, use the default 
Picarro password (“picarro”), and press OK. Now you can select the Outlet 
Proportional Valve plot. 

The outlet valve position is also recorded in the Private Data Log files (see section  
13 File Management  for details on how to access these files). If you would like 
the data stored in the User Data, you can refer to Setup Tool to include the outlet 
valve in your user data files. 

  

http://www.picarro.com/community/picarro_community/vaporizer_a0211_operation_schematic
http://www.picarro.com/community/picarro_community/vaporizer_a0211_operation_schematic
mailto:support@picarro.com
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14.4 Typical Appearance of Water Concentration and 
Outlet Proportional Valve Graphs 
For all of the following plots, the water concentration is the top graph and outlet 
proportional valve position is on the bottom. Ideally, the water pulse should be 
square, and the outlet proportional valve position should gradually decrease at the 
flat top of the water pulse, as shown below. These features correspond to the 
outlet valve gradually closing during the analysis of the pulse.  

 

Figure 67: Ideal Water Concentration and Outlet Proportional Valve Graphs 

For a proper analysis, the concentration of the dry gas (between the pulses) 
should be < 500 ppm H2O. The peak height of the pulse should be reproducible 
(within ± 1,000 ppm) and between approximately 17,000 and 23,000 ppm.  
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14.5 Water Concentration and Outlet Proportional Valve 
Graph Problems and Potential Causes 
Problem: Extra Pulses after the Main Sample Pulse 
The image below shows extra little "pulses" after the main sample pulse. Note that 
the peaks for the main pulses appear normal, and the outlet valve is operating 
normally. The problem is during the cleanout cycle of the vaporizer, not during 
sample delivery. 

There are three potential causes of this problem: 

1. Leaky vaporizer septum. This should be changed after every ~ 300-400 
injections. 

2. Bad vaporizer vacuum pump. The pump may be starting to fail if it has 
more than 10,000 hours of use. 

3. Bad connection between the vaporizer vacuum pump and the vaporizer. 
Check the tubing and swage connections for cracks near the metal 
connections. Be careful not to over-tighten the swage fittings. 

 

Figure 68: Extra Pulses after the Main Sample Pulse 

 
NOTE 

When reattaching 1/4” Swagelok fittings, the nut should be hand-tightened and 
then turned an additional 1/8 of a turn using a wrench. 
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Problem: Extra Peaks Before and After the Main Sample 
Pulse 
The water concentration graph below has two abnormalities: an extra little peak 
after the main peak, and a "spike" at the beginning of the main peak. Note also 
that the outlet proportional valve is flat. This indicates that the outlet valve is 
constant during the time the analyzer is drawing air from the vaporizer's internal 
fixed volume. Because the outlet valve is constant, the pressure on the inlet of the 
analyzer is not changing. This indicates there is a leak between the analyzer and 
the vaporizer.  

The spike at the beginning of the main pulse could be moist ambient air entering 
through the leak. In this particular example, the spike peaks at ~ 12,000ppm. In a 
dry environment, a leak might look like a slope going upwards from left to right 
with a dependence on the ambient conditions relative to the nominal 20,000 ppm 
concentration of the vaporized sample. A very leaky septum could also look 
similar. 

 

Figure 69: Extra Peaks Before and After Main Sample Pulse 
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Problem: Decreasing Concentration in the Main Pulse 
In this example, the outlet valve is constant during the pulse, but the pulse has a 
decreasing concentration. This is consistent with a leak of lower-concentration 
ambient air into the analyzer during analysis. This leak is likely at the connection 
from the vaporizer to the analyzer.  

 

Figure 70: Decreasing Concentration in Main Pulse 
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Problem: Water Pulse Is Sloped 
The slope of the main pulse in the water concentrations, particularly one going 
upwards as in the first example shown below (Figure 71), indicates poor mixing 
inside the vaporizer. This can happen if the valve that injects dry gas into the 
vaporizer is not working perfectly. In this case, the outlet valve position is normal 
and therefore a leak between the vaporizer and analyzer is excluded as the cause 
of the problem.  

In the second example (Figure 72 below) however, note the change in the 
nominal outlet valve position. This shows the vaporizer is filling to different 
pressures with each pulse, so there is inconsistent filling of the vaporizer.  

If you see either: 

• Variation in the nominal stopping position of the outlet valve, or 

• Large increases in water concentration during a pulse 

Contact Technical Support (support@picarro.com) and we can help diagnose and 
repair the fault, if necessary. Please always provide your analyzer and vaporizer 
serial number when contacting Picarro.  

 

Figure 71: Water Pulse Sloped – Poor Mixing in Vaporizer 

mailto:support@picarro.com
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Figure 72: Water Pulse Sloped – Inconsistent Filling of Vaporizer 

Problem: Variability in Measured Water Concentration 
The measured water concentration should consistently be near 20,000 ppm 
(±1000 ppm). The circled areas in the water graph below shows values that are 
higher or lower than expected. The outlet valve behavior is normal.  

This can happen if the syringe is clogged, causing inconsistencies in the injected 
volume. Another problem is an inconsistent gas supply, perhaps due to a failing 
regulator or another piece of equipment using the same dry gas supply. This 
causes inconsistent pressure or flow at the inlet dry gas supply.  

Other problems associated with sample delivery are: 

• Overfilling or pressurizing the liquid in the vials 

• Significant contamination of the samples 

• Insufficient needle depth resulting in the collection of air, rather than liquid 

• Variable volume bubble in the syringe  

A test injection is recommended before each run, when you change a syringe, or 
if water concentrations during the pulse are consistently outside of the ideal ~ 
17,000 to 23,000 ppm range. It is possible to scale the injection volume by the 
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appropriate percentage to target the ideal water concentration range (see section 
15.2 Adjusting Injection Volume in section 15 Best Practices and Operational 
Tips). 

 

Figure 73: Water Pulse Sloped – Water Concentration Variability  
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Problem: Water Concentration Suddenly Decreases 
In this example, the measured water concentration drops to near the baseline. 
This can happen if the needle penetration depth into the vaporizer changes and is 
not deep enough to get the sample into the vaporizer. The tall peak at left is a 
partial injection, but the subsequent peaks indicate that little water was injected 
into the vaporizer. 

 

Figure 74: Water Pulse Sloped – Sudden Decrease in Water Concentration  
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Problem: Baseline of Water Concentration and Outlet Valve 
Change 
This is what happens when a normal analysis runs out of dry air from the dry air 
cylinder. The same behavior is also possible if there is a large gas leak in your 
cylinder. As the cylinder gas pressure goes to zero, the vaporizer is forced to take 
in moist room air, either from the leak or backwards through the Wavelength 
Monitor (WLM) purge line. The result is that the nominal dry baseline rises to the 
level of the room air. Also, the outlet valve position decreases since the vaporizer 
experiences less pressure from the cylinder gas. 

 

Figure 75: Baseline of Water Concentration and Outlet Valve Change 
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Problem: Water Pulses Split Into Multiple Peaks 
The final example shows what happens if the analyzer's solenoid valve sequencer 
is running at the same time the coordinator is. The solenoid valve sequencer 
should be disabled by default for Picarro water isotope analyzers. If the sequencer 
runs at the same time as the coordinator, the two components send conflicting 
signals to the valves that control the vaporizer. In this example, the sequencer is 
turned off following the third pulse, and the final pulse returns to normal. 

 

Figure 76: Water Pulses Split Into Multiple Peaks  
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15. Best Practices and Operational Tips 

15.1 Pulse Customization 
Pulse Analysis  
There is a delay of a few seconds at both the beginning of the pulse and the end 
of a pulse where the pulse analysis ignores incoming data. Therefore, only the 
most stable center portion of the pulse is included in the pulse analysis. Although 
the default settings should be adequate for most uses, one can adjust the delays 
by editing the appropriate Coordinator .ini script. Please be sure to keep a copy of 
the original file in case of any mistake. The example below is for the High 
Precision Mode Coordinator on a L2130-i with a Picarro Autosampler. 

• Edit the validTimeAfterTrigger or validTimeBeforeEnd fields in 
the following file: 

C:\Picarro\G2000\AppConfig\Config\Coordinator\CoordinatorLIMS_G2000
_A0340.ini (Note: for A0325 Autosampler, find file “…G2000_A0325.ini”) 

The default settings are: validTimeAfterTrigger = 100, 
validTimeBeforeEnd = 15 

• One can similarly adjust the level that triggers a pulse analysis event by 
changing the 6500 value in the upslope or downslope trigger in the 
following file: 

C:\Picarro\G2000\AppConfig\Config\Coordinator\ 
CoordinatorLIMS_G2000_A0340.ini  (Note: for A0325 Autosampler, find 
file “…G2000_A0325.ini”) 

The default settings are: thres1Pair = [6500, 30000] and 
thres2Pair = [5500, 30000] #this is the downslope 
trigger 

15.2 Adjusting Injection Volume 
For best results, liquid sample injections should be provided to the instrument at a 
concentration of 18,000 ± 3,000 ppmv (parts per million by volume). Each 
liquid injection will be labelled as “good” in the coordinator if this concentration is 
between 15,000 - 21,000 ppmv. If the concentration is significantly above or 
below this range (i.e., < 15,000 ppmv or > 25,000 ppmv) or if the dry background 
is > 500 ppmv, the pulse will not be analyzed, and the data will not appear in the 
coordinator.  
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To achieve the appropriate injection concentration:  

1. Dry nitrogen or zero air (< 50 ppmv water concentration) should be 
supplied to the instrument at 2.5 ± 0.2psi (17.2 ± 1.4kPa), with a flow of 
approximately 200 sccm (Standard Cubic Centimeters per Minute). If 
Drierite (or similar) is used for the dry air (rather than a nitrogen or zero 
air tank) supply, a measured background level of ~ 100-200 ppmv will 
produce satisfactory data. Remember to select the Measurement Mode 
appropriate to your background gas matrix (see the section Switching 
Between Measurement Modes.)  

2. Sample injection volume (controlled by Autosampler) should be set  
at ~ 1.8μL.  

If the resulting concentration peak after the 2nd or 3rd liquid injection is 
substantially different from 20,000 ppmv:  

1. The injection volume may need to be scaled appropriately: For 
example, if the resulting concentration peak of an initial ‘test’ injection is 
16,000 ppmv, then the injection volume needs to be adjusted by the 
factor 20,000/16,000 = 1.25. To accomplish this, multiply the current 
injection volume in the Autosampler method by 1.25.  

2. The injection quality may need improvement. Bad Injections can 
cause incorrect injection concentrations. Bad injections can be from a 
clogged needle, damaged vaporizer septum, or incorrect dry gas 
pressure/flow restriction. 

 
NOTE 

Five failed injections will lead to a Time Out: Every time there is a liquid injection 
into a vaporizer by the Autosampler, a pulse of water vapor should enter the 
cavity and be analyzed. If something goes wrong (e.g., syringe breaks), and the 
pulse analysis fails, the software will try injecting five times in a row. After 5 
failed injection pulses, the coordinator will time out. You will need to restart the 
coordinator to continue the experiment. This is a built-in safety mechanism that 
helps prevent un-intended sample contamination following multiple pierces of 
the vial septum. 

15.3 Syringe Lifetime 
A common failure in liquid water analysis is syringe breakage. These consumable 
parts, although replaceable, can be expensive. We recommend the following best 
practices for enhancing syringe lifetime.  

Summary 
• Recommended syringe size: 10 µL  

• Manually clean syringe between each autosampler run with 
deionized water 
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• Make sure plunger moves smoothly in the barrel 

• Use a lubricant, like N-Methyl-2-pyrrolidone (NMP), if necessary 

• Use the Autosampler Training program (rather than the Autosampler 
Controller program) to change the syringe  

• Check syringe injection and fill speed, and the injection depth  

Syringe Details 
Picarro analyzers ship with 10 µL syringes from SGE Analytical Science (10 µL 
syringe part # 002982, 10RC/T5/0.47C). The thicker plunger on these syringes 
makes them more robust than 5 µL syringes. 

Samples with Precipitates 
The High Precision Vaporizer can operate with liquid waters containing as much 
as approximately 200 g/kg total dissolved solids (TDS). In principle, water 
samples can be analyzed without filtration, especially if the precipitate has settled 
and the syringe is collecting water from near the top of the vial. However, running 
samples with high TDS will decrease syringe life, require more vaporizer 
maintenance, and possibly decrease the lifetime of the vaporizer valves.  

Therefore, samples should be filtered or centrifuged when possible. The "purer" 
the liquid being injected into the vaporizer, the longer the syringe, septa, and 
vaporizer can go without replacement or maintenance.  

Dissolving the precipitate by lowering the pH of the fluid is not recommended for 
these reasons: (1) the sample will fractionate, and (2) introducing acid to the 
vaporizer, stainless steel tubing, and potentially the cavity, may result in corrosion 
that requires repair. 

15.4 Memory Effect 
Memory refers to the effect of the previous sample on the current measurement 
due to carryover of trace amounts of the previous sample. Water is especially 
subject to this effect because it adheres to surfaces even at temperatures well 
above the boiling point. It is a common problem encountered by all methods of 
isotopic analysis. 

In Picarro analyzers, the memory is a function of the entire assembly (vaporizer, 
connection to the analyzer, and the analyzer itself). It is commonly accounted for 
by performing multiple injections of the same sample. 

The simplest way to correct for memory is to ignore the first 2 or 3 injections of a 
sample and only use the later injections. For waters with closely clustered isotopic 
values, this usually means running 6 injections per sample and ignoring the 
results of the first two injections. In more extreme cases, running 8 injections and 
ignoring the first 3 or 4 will yield better results.  
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The effect of memory is stable over time. This means that the same percentage of 
the previous sample is carried over to the new sample each time.  

However, memory should be characterized every one to two months, particularly if 
samples with high levels of insoluble material or high dissolved solids are 
frequently analyzed. These materials build up in the vaporizer and can increase 
the retention of old sample.  

This effect can be quantified using the following procedure: 

1. Inject a sample of water at least 20 times (40-50 times is preferable).  

2. Switch to a new sample with significantly different (> 100‰ for  δ2H) 
isotopic value and inject the new sample the same number of times as 
the previous sample.  

3. Switch back to the original sample and again measure that multiple 
times.  

4. Calculate the ‘true’ value of each sample by averaging the last 5 to 10 
injections of that sample.  

5. Then subtract an individual injection from the ‘true’ value of the previous 
sample and divide this by the difference in isotope space between the 
‘true’ value of the current sample and the previous sample.  

This will yield a memory coefficient (in percent) for each injection, x, 
where, for example 99% means that 99% of the true isotope difference 
between two samples of water has been attained after x injections. The 
first injection of sample will be in the range of 94% to 97%. By the 4th 
injection, it will be approximately 98% for  δ2H and 99% for  δ18O. 
Typically, the memory effect is larger for  δ2H than for  δ18O. 

15.5 Analyzing Samples with High Total Dissolved 
Solids 
Picarro’s High Precision Vaporizer can be used to measure saline samples. 
However, these samples present two unique challenges to instrument 
performance and lifetime: 

1. Salty samples generate residue in the syringe, which decreases syringe 
lifetime. See previous section 15.3 Syringe Lifetime for more 
information on increasing syringe lifetime when running salty samples. 

2. Upon vaporization, dissolved solids create a residue in the vaporizer, 
which can increase the memory effect and influence data quality. 

If you are running salty samples and you see a decrease in the memory 
coefficient, Picarro recommends cleaning the vaporizer. The vaporizer might need 
cleaning every 200 mg of salt injected, and the cleaning will take about 12 hours 
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of downtime. Contact Picarro to receive instructions on cleaning the vaporizer, or 
to order the Vaporizer Cleaning Kit (part number C0211).  

 
NOTE 

Although vaporizer cleaning will improve the performance of your High 
Precision Vaporizer, salt build up can decrease the lifetime vaporizer valves and 
eventually lead to valve failure. This is particularly true if salts get into the 
valves themselves, preventing good seals at the valves. 

15.6 Sample and Standard Handling 
Sample Storage 
Whenever samples should be stored in sealed vial in a refrigerator or freezer. If 
samples are frozen prior to analysis, it is essential to have sufficient headspace in 
the vial to prevent breakage during phase change, and to ensure the entire 
sample is returned to liquid form prior to isotope analysis. Parafilming the cap of 
the storage container is also recommended. If samples are stored in 2 mL 
autosampler containers, the cap with septa should be replaced once pierced.  

Two types of autosampler vial are recommended for use with your Picarro 
Autosampler: 

• 2 mL glass vial with cap and septa (Picarro part number C0322, or as 
part of a consumables kit, C0328 or C0329) 

• If samples or standards are limited, it is also possible to use 2 mL 
vials with 250 µL inserts. These vials act to limit headspace for small 
samples. Picarro recommends the use of fixed inserts to avoid water 
vapor passing between the insert and the wall of the larger 2 mL vial. 
For example, Agilent LS Screw Vial (Agilent part number 5188-6591, 
available from Fisher Scientific).  

Storage of Secondary Isotopic Water Standards 
Selecting the proper containers for long term storage is critical to avoid any 
change of isotope composition with time due to evaporation or exchange. The 
following is a list of storage methods for isotope standards.  

Glass ampoules: The most reliable containers are glass ampoules that are 
sealed with a gas torch, such as those provided by the International Atomic 
Energy Agency with VSMOW2 and SLAP2. After filling and sealing, ampoules can 
be sterilized by heating the ampoules to about 105°C overnight. This will eliminate 
the possibility of the growth of algae or other biological activities. Leaking 
ampoules should be discarded.  

Stainless steel barrels: Internal laboratory standards can be stored in stainless 
steel barrels (25 to 50 liters). These barrels can be obtained from suppliers for the 
juice, wine, and beer processing industries. When using this method, water 
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standards should be kept under a slight overpressure of argon or nitrogen gas. 
The dispensing system ideally consists of a valve with a tube down to the bottom 
of the barrel to extract the water and a second valve with a manometer and tube 
connector to keep a headspace overpressure of inert gas in the barrel. Due to the 
overpressure in the barrel, water can be dispensed by opening the first valve. The 
laboratory standard has no contact with the atmosphere and therefore no risk 
exists of any evaporation during storage. 

Amber vials and glass bottles: For routine work, a 250 mL glass bottle can be 
filled from the appropriate internal laboratory standard barrel. 2 mL aliquots of 
these standards can then be moved to a standard autosampler vial with septa cap 
for routine, daily calibration. Glass bottles should be filled from their source on a 
regular basis (every few weeks), without discarding the remaining portion of the 
standards. This handling method minimizes isotope fractionation during 
evaporation and exposure to air while the bottle is open.  

 
NOTE 

Picarro recommends that once an autosampler vial is pierced by a needle, the 
vial should be discarded and not used repeatedly. For example, if a multi-day 
autosampler run is set up, the first standard water should not be used again for 
the last standard water in the sequence. Exceptions can occur if the cap with 
septa is replaced between the first and last analysis. Once a septa is pierced the 
sample is susceptible to isotopic fractionation due to evaporation and loss of 
the water through the cap. 

Recommended Reading: 

Groening, M. (2018) "TEL Technical Note No. 03 Stable Isotope Internal 
Laboratory Water Standards: Preparation, Calibration and Storage", 
Terrestrial Environment Laboratory, International Atomic Energy Agency, Vienna, 
Austria. 

https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/Publications/TechnicalNotes/TELTechNote03_WaterInternalLaboratoryStandards.pdf
https://nucleus.iaea.org/sites/AnalyticalReferenceMaterials/Shared%20Documents/Publications/TechnicalNotes/TELTechNote03_WaterInternalLaboratoryStandards.pdf


   Troubleshooting 

138 P/N 40035 Rev. G L21x0-i Inst/Op Manual 

16. Troubleshooting 
The following section lists problems that may be encountered during installation and 
operation of the analyzer. The corresponding step-by-step procedures provide resolution 
in most cases. If, after attempting these procedures, the problem remains unresolved, 
contact Picarro Customer Service at (408-962-3991), EU Technical Support  
(31-85-888-1650) or support@picarro.com. 

16.1 Power LED on Analyzer Does Not Illuminate 
Context: Turning on the analyzer by momentarily depressing its front panel power 
switch should apply power. The green power LED is illuminated when it detects 
the correct power levels. 

1. Check that the AC power cord is attached and plugged into a working 
outlet. 

2. Check that the rear on-off switch near the AC power cord is in the ON 
position ( I ). 

3. Press and hold the front panel power switch for at least 5 seconds as 
the analyzer may take several seconds to respond. 

16.2 User Interface Program Does Not Start 
Context: The computer may be configured to start the instrument and the 
associated user interface program automatically after it completes its boot-up 
sequence, or the program may be launched using the “Start instrument” icon on 
the desktop.  

Communications problems with the analyzer may occur if the analyzer fails to 
initialize correctly on power up. Should the analyzer initialization process not 
complete correctly, shut down the instrument by shutting down the Windows 
operating system on the control computer: 

 
NOTE 

Do not simply restart Windows by selecting “Restart” in the drop-down box on 
Step 3, since this does not cycle the power to the analyzer. 

1. Using the Start menu, select the red Shut Down button and select “Shut 
down” in the drop-down box under “What do you want the computer to 
do?”  

2. Wait for the shutdown to complete normally and for the computer and 
analyzer to turn off completely.  
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3. After a few seconds, restart the computer by momentarily depressing 
the power button.  

16.3 Sample Pressure not Controlled to Appropriate 
Value for Concentration Measurements 
Context: Under normal operation, the cavity pressure is automatically locked to 
the correct value by means of electronically controlled inlet and outlet valves. The 
message “Pressure Locked” on the front panel display and the user interface 
indicates that the cavity pressure is at the appropriate value. Should either of the 
messages “Pressure high” or “Pressure low” be displayed, the cavity pressure is 
out of its correct operating range.  

1. The “Pressure low” message indicates that there is insufficient gas 
available at the inlet of the analyzer. Check the inlet plumbing to the 
analyzer and ensure that the pressure at the inlet is within the 
specifications. Check for blockages in the lines, or regulators that are 
turned off, especially by removing all items upstream of the inlet to see if 
the pressure returns to the spec. If removing plumbing from upstream of 
the instrument inlet doesn’t work, the inlet particulate filter may need to 
be replaced. See section 17, Maintenance for more information. 

2. The “Pressure high” message indicates that gas cannot be removed 
from the analyzer at a sufficient rate. Check the vacuum line between 
the analyzer and the power vacuum unit for leaks. Failure of the vacuum 
pump, injecting dilution gas at excessive pressure, or excessive 
pressure at the inlet can also cause this problem. 

16.4 User Interface Program “Freezes”/Won’t Update 
Graphs as Data are Collected 
Context: The computer may become unresponsive causing the programs that 
control the analyzer to stop functioning. The computer and analyzer should be 
shut down and restarted. 

If the computer responds to the mouse, a normal Windows shutdown may be 
carried out: 

1. Using the Start menu, select the red Shut down button and select “Shut 
down” in the drop-down box under “What do you want the computer to 
do?”  

2. Wait for the shutdown to complete normally and for the computer and 
analyzer to turn off completely. 

3. After a few seconds, restart the computer by momentarily depressing 
the power button. 
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If the computer does not respond to the mouse:  

4. hold down the power switch on the front panel for a few seconds until 
the computer and the instrument turn off.  

5. After another few seconds, restart the analyzer by momentarily 
depressing the power button. 

16.5 ChemCorrect Troubleshooting 
This section lists solutions to a common problem that may be encountered while 
using the ChemCorrect software.  

ChemCorrect Processing Software Hung Up (frozen).  
Recommendation: Check that you ran a coordinator compatible with 
ChemCorrect. Coordinators for the 17O-excess mode are not compatible with 
ChemCorrect. Coordinator output csv files should contain columns with 
baseline_shift for L2130-i and L2140-i. 

If the above checked out, the other usual cause is syntax error and/or 
missing/empty row(s) in the coordinator output file. The three files listed below are 
user-editable: 

• Instruction Set: C:\Picarro\ChemCorrectExe\chemcorrect_inst xx.csv  

The instruction set is usually not edited unless you’re an avid user. 

• Standard Library: C:\Picarro\ChemCorrectExe\standards file.csv  

The standards file syntax is not too complicated to follow. 

• Coordinator Output csv file or source file: HIDSxx _CC_IsoWater_xx.csv 

The most common errors occur in the Coordinator Output file. These are the items 
to check: 

• The number of injections that you set ChemCorrect Analysis to ignore has 
to be less than the total injections/sample. 

• There can’t be any empty row or blank value (as a result of broken/bent 
needle, or sample ran out of liquid). This is not an issue if you have 
ChemCorrect version 1.2.0 or later. 

• “Line” column has to be sequential and start at 1  

• “Time Code” column has to be chronological. 

• Port number should correspond with the correct sample number. 
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17. Maintenance 
The advanced, rugged design of Picarro analyzers provides stable, long-term operation 
with minimal service or maintenance. With the exception of the following items, the 
analyzer and pump are not user serviceable. Should either appear to malfunction, 
please refer to the Troubleshooting Guide or contact Picarro Support.  

As described below, users may obtain preventive maintenance components as part of a 
service plan, as part of a designated PM kit, or individually from the Picarro store.  

17.1 Service Plans 
In addition to basic telephone and email support and remote diagnostics, service 
plans include an annual preventive maintenance kit and can be purchased by 
contacting sales@picarro.com. The three service plans are as follows: 

• W3101 Essential Service Plan: Free yearly maintenance kit; 50% 
discount on Field Replaceable Parts; 10-20% Discounted factory repair. 
See data sheet for complete terms and conditions.  

• W3102 Premium Service Plan: Free yearly maintenance kit; Extended 
warranty; Free factory repair; Free Field Replaceable Parts. See data 
sheet for complete terms and conditions. 

• W3103 Commercial Service Plan: Free yearly maintenance kit; 
Extended warranty; Free factory repair; Free Field Replaceable Parts; 
Loaner instrument; Free yearly prevention maintenance visit; 
Complimentary remote refresher training. See data sheet for complete 
terms and conditions. 

17.2 Preventive Maintenance Kits 
Preventive maintenance kits can be purchased by contacting 
support@picarro.com. The maintenance kits all include the following elements: 

Replacement CPU Fan; particulate filter (Stainless Steel or Teflon); dust filter; 
replacement screws for instrument cover panels; Ball-Point Hex L-Keys; Anti-
Static Wrist Strap. 

The kits come in three forms depending on the instrument being serviced. 

• S3092: Yearly Maintenance Kit for GHG, L2xxx, and EtO 

mailto:sales@picarro.com
mailto:support@picarro.com
https://www.picarro.com/support/library/documents/s3092_quick_start_guide_for_ghg_l2xxx_and_eto_analyzers
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17.3 User-replaceable Hardware – Individual 
Components 
Inlet Particulate Filter 
The inlet particulate filter is user-replaceable. Use the following links to order 
replacements and to find an instructional video and supporting maintenance 
document. 

Picarro Store Ordering Links: 

• Stainless Steel Filter: For all models except those that measure HF, NH3, 
CH2O, HCl and H2O2  

S1020 Particulate Filter Kit – If viewing this manual as a paper hard 
copy, enter the following URL in your browser: 

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-
except-HF-NH3.html 

Filter Replacement Instructional Video and Document: 

• Filter Replacement Instructional Video: https://vimeo.com/375518688 

This video covers replacement of both stainless steel and Teflon filters. 
Note that this video does not currently cover replacement of externally 
mounted particulate filters. 

• Filter Replacement Maintenance Guide: 
https://www.picarro.com/support/documents/inlet_particulate_filter_mainte
nance_guide 

This guide covers replacement of both stainless steel and Teflon filters for 
analyzer models that have either internally or externally mounted filters. 

A2000 Pump Rebuild Kit 
The pump rebuild kit is the only component not currently sold as part of a 
preventive maintenance kit because the replacement frequency is not strictly 
annual (frequency depends on pump usage).  

The A2000 pump diaphragms and valves are user-replaceable. Use the following 
link to order rebuild kits and to find the instructional video and supporting 
maintenance document. 

• Pump Rebuild Kit: Used with SI2xxx, G2xxx analyzers (except Flight and 
Flux analyzers) 

S2009 Rebuild Kit for A2000 Vacuum Pump – If viewing this manual as 
a paper hard copy, enter the following URL in your browser: 

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-
vacuum-pump.html 

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
https://vimeo.com/375518688
https://www.picarro.com/support/documents/inlet_particulate_filter_maintenance_guide
https://www.picarro.com/support/documents/inlet_particulate_filter_maintenance_guide
http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-vacuum-pump.html
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17.4 A0211 Vaporizer Injection Port Septum 
Replacement 
For instructions on replacing the injection port septum and salt liner (if used), refer 
to the Maintenance section in the A0211 High-Precision Vaporizer User Manual 
(PN 40-0044). 

17.5 Cleaning 
Clean the outside of the analyzer with a clean dry cloth. Only certified service 
technicians should access or clean the inside of the analyzer. 
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18. Transportation and Storage 
If the analyzer will be transported or stored, use the following procedure to prepare and 
repack it into the original packaging. 

 
CAUTION 

When shipping or relocating the analyzer, it is important to protect it from 
mechanical shocks. Failure to do so can compromise its performance. When 
shipping the analyzer, use its original packaging only. 

18.1 Shutdown and Preparation 

 
CAUTION 

A flow of clean, relatively dry gas should always be directed to the instrument 
for several minutes prior to shutting down. Trapping a high-moisture content 
gas sample in the cavity can cause condensation damage to the mirrors as the 
instrument cools from its operating temperature. See section 7.2, Shutdown for 
specific shutdown instructions for your model analyzer. 

1. Click on the Shutdown button located on the left side of the Data 
Viewer window. 

2. A window will pop-up (Figure 77) prompting the user to confirm the 
shutdown. Once confirmed, the analyzer software and hardware will turn 
off. 

 

Figure 77: Shutdown Confirmation Pop-Up Dialog 

3. Manually turn off the pump(s) and dry gas (if used). 

4. Disconnect all tubing and electrical connections from the analyzer. 

5. To prevent contamination and possible damage to the connector 
threads, place protective caps on all gas connections. 
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18.2 Packing 
1. Place the analyzer in a plastic bag with a package of desiccant.  Seal 

the bags with tape. If shipping the pump, do the same for it. 

2. Pack the analyzer and pump in the original shipping containers ensuring 
that all the foam pieces are in place to protect the analyzer during 
shipping. 
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APPENDIX A – Setup Tool and 
Communication 

A.1 Setup Tool 
In the desktop folder called Picarro Utilities, the Picarro Analyzer Setup Tool 
can be launched by double clicking on its icon. This tool allows the user to 
configure data file saving details, including which data elements are written to 
data files, digital data output (via serial port or TCP/IP), remote data delivery (via 
email), and general GUI properties.  

Seven tabs of the Setup Tool Window are explained in the next pages in brief. A 
more in-depth description of the material is provided in the subsequent section. If 
you have any questions about the Setup Tool, please contact Picarro or refer to 
Picarro Community for further details. 

https://www.picarro.com/support/community 

 
NOTE 

Before running the Setup Tool, the instrument software and drivers must be 
stopped. 

From the desktop, open the Diagnostics folder, double-click on the Stop 
Instrument icon. The Stop CRDS Software window appears. Select the radio 
button “Stop software and driver,” then click the Stop button. 

 

Data Logger Tab 
Configuring Data File Saving Details with Data Logger 

The Data Logger tab (Figure 78) allows the user to configure various data file 
saving details, including which data elements are written to data files.  

• Data Columns: Controls which data elements are written to data files.  

• Hours of Each Log File: Controls the size of each data document.  

https://www.picarro.com/support/community
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• Enable Mailbox Archiving: Enables archiving of data in the mailbox 
folder – C:\Picarro\G2000\Log\Archive\DataLog_Mailbox 

• Archived Directory Structure: Specifies part of naming convention for 
data documents.  

• Total User Log Storage Size (GB): Specifies the size of storage allowed 
for User Data (Recent Data).  

• Mode: Changes the way the analyzer fits and displays data in the data 
viewer on the basis of gas matrix, species reported, precision, and 
dynamic range. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 78: Data Logger Setup Window 

Port Manager Tab 
Managing Ports for Digital Data Output/Input and Serial Communication with Port 
Manager 

The Port Manager tab (Figure 79) allows you to control digital data output/Input 
via serial port or TCP/IP.  
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On this window, you can specify: 

• Data Streaming: The port you want your data to stream through 
(COM1/COM2/Off),  

• Valve Sequencer MPV (Multi Position Valve): The port you want to 
connect your MPV to (COM1/COM2/Off) 

For more information on the configuring for external valves, contact 
Picarro Support. 

• Command Interface: (COM1/COM2/TCP/Off).  

Make sure there are no COM port conflicts before clicking Apply. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

To learn more about Serial Communication, see Remote Data Access in 
APPENDIX A – Setup Tool and Communication. 

 

Figure 79: Serial/Socket Port Manager Window 
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Data Delivery Tab 
The Data Delivery tab (Figure 80) allows the user to schedule remote data 
delivery (email). 

• Delivery Start Time: Time of the day when data will be sent.  

• SSL: Depending on the sender’s email server, the sender can activate the 
Secure Sockets Layer (SSL).  

• Use Authentication: Turning this on will require the receiver to provide a 
password and a username to access data. Set up the password and 
Username from this window. 

• From: Sender’s email 

• To: Receiver’s email.  

• Subject: subject line of the email.  

• Data Directory: Location of the data you want email.  

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 80: Data Delivery Settings Tab 
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GUI Properties 
The GUI PROPERTIES tab (Figure 81) allows you to set the number of graphs 
displayed and to enable the control of Valve Sequencer from the main GUI.  

Number of Graphs: Set the desired number of line graphs to be visible on the 
main GUI.  

Enable Control of Valve Sequencer: To make the Valve Sequencer menu item 
visible under the Tools menu of the main GUI: 

3. Click on Settings of the Setup Tool window, and then Switch to 
Service mode.  

4. Choose Yes next to Enable Control Valve Sequencer drop down menu 
on the GUI Properties tab.  

5. Click Apply to put changes into effect and then Exit to close the 
window. 

You should now be able to access the Show/Hide Valve Sequencer GUI menu 
from the main GUI under the Tools menu. 

 

Figure 81: GUI Properties Settings Tab 
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Command Interface – Specifying Digital Data Output 
The COMMAND INTERFACE tab allows you to specify the data elements that 
are sent via COM port/TCP (specified in the PORT MANAGER tab). Two types of 
data can be specified here:  

Output Data Source: 

• Datalog_User 

• DataLog_User_Sync (Relevant only for Flux G2311-f analyzers). 

Output Data Columns:  

• The data columns are output in the order they are checked, e.g., CH4, 
comes before CO2. Command Interface enables an external device to 
send a set of predetermined commands to a Picarro analyzer. The Picarro 
returns data or metadata on the basis of the command received. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 82: Command Interface Settings Tab 
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Data Streaming – Specifying Digital Data Output 
The DATA STREAMING tab allows you to specify the data elements that you 
want to send via COM port (specified from the PORT MANAGER tab). Two types 
of data can be specified here:  

Output Data Source: 

• Datalog_User  

• DataLog_User_Sync (Relevant only for Flux G2311-f analyzers). 

Output Data Columns: 

The data columns are output in the order they are checked, e.g., CH4, comes 
before CO2. Command Interface enables an external device to send a set of 
predetermined commands to a Picarro analyzer. The Picarro returns data or 
metadata on the basis of the command received. 

Data Streaming outputs data continuously, whereas the Command Interface 
needs commands to output data. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 83: Data Streaming Settings Window 
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Electrical Interface – Customizing Analog Output Channels 
The Picarro analyzer may be optionally configured with an Electrical Interface 
Card (EIC) that provides up to 8 analog signals available to the user for 
monitoring various measurements results and analyzer parameters. 

The ELECTRICAL INTERFACE tab (Figure 84) allows you to customize each 
analog output channel.  

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 
NOTE 

This tab will be disabled if your analyzer was not configured to work with an 
analog peripheral. 

 

 

Figure 84: Electrical Interface Settings Window 
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A.2 Remote Data Access 
Picarro Serial Communication 
The analyzer supports an RS-232 physical command interface, which can be 
used to control the instrument and to retrieve concentration data. Not all features 
of the instrument are available on the serial interface.  

For details on using the serial command interface, please see the Picarro 
analyzer Remote Interface Programming Guide. 

To Download: 

1. Go to https://www.picarro.com/.  

2. Under the Support tab (near the home page upper-right corner), select 
Document Library.  

 
NOTE 

Registration/Login Required: Access to online User Manuals is available to all 
registered Picarro customers with login credentials. If you do not yet have an 
account, please email us at support@picarro.com to request access to the 
document library. 

3. When the Document Library page opens, enter the search terms, 
“Remote Interface” in the Search field.  

4. In the results, click on the link titled “Remote Interface Programming 
Guide 40-0063” to open the manual in your browser. From there you 
can also download and save it to your PC. 

This command set may also be used across a TCP/IP interface through an 
Ethernet connection. Please contact Picarro for further details if needed. 

Remote Data Access 
Using the RemoteAccess.ini file, the analyzer can be configured to automatically: 

• Send data from the instrument to a list of e-mail accounts. 

• Measure the offset of the host computer system clock from a set of 
Internet time servers and (optionally) to resynchronize the clock based on 
this information. 

The Internet connection need not be permanent and may be a dial-up connection 
accessible via a user-supplied USB modem. The task of sending data and/or 
synchronizing the clock on the analyzer is performed using the 
C:\Picarro\G2000\HostExe\RemoteAccess.exe program. This program can be set 
up to run periodically using the Windows task scheduler at a user-configurable 
frequency. If a dial-up connection to the Internet is employed, it is used only on 
demand to minimize the connection time. 

https://www.picarro.com/
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Each time that the RemoteAccess.exe program runs, it appends information to a 
log file, which keeps a record of the results of the time synchronization and of the 
files sent by e-mail. The RemoteAccess.exe program is configurable by means of 
an initialization file, which includes information such as the login credentials for 
the dial-up connection, the e-mail account, and the list of time servers. 

The initialization file is: 

C:\Picarro\G2000\AppConfig\Config\UtilitiesRemoteAccess\RemoteAccess.ini 

It should be placed in the same directory as the executable RemoteAccess.exe. 
The file has one required section named LOGGING and optional sections named 
NTP and EMAIL. The logging section has a single key Logfile whose value is the 
path to the log file. Once this log file exceeds 64 Kbytes in length, it is backed up, 
appending a numeric extension to the file name, and a new file is opened. A total 
of ten backup log files are kept. 

NTP 
The NTP section controls querying the Internet time servers using the SNTP 
protocol (RFC4330) and the resetting of the clock on the host computer. If the 
section is not present, time synchronization is not carried out. The keys Server1, 
Server2, etc., are used to specify the URLs of the time servers. If the UpdateClock 
key is set to “true,” the offset is applied to the host clock. Otherwise, the offset is 
recorded, but the host clock is not changed. 

Email 
The EMAIL section controls the sending of the data files as e-mail attachments. If 
the section is not present, e-mail messages are not sent. The key Directory 
specifies the directory that contains the data files. When the program is run, files 
in this directory are sent to the specified recipients and the files are deleted. To 
avoid problems with incomplete files, programs that place files into this directory 
should do so using an atomic operation, such as a rename. The Server key is set 
to the name of an RFC2821- compliant SMTP server that sends the e-mail 
messages. 

The From key is the e-mail address from which the messages are sent. Note that 
some SMTP servers check that the source is permitted to send email while others 
allow any name in this field. The collection of e-mail addresses to which copies of 
the e-mail is sent is specified by the keys To1, To2, etc. The Subject key is used 
to fill the subject field in the email header and may be set to any string. Depending 
on the SMTP server, it may be necessary to use authentication before e-mails can 
be sent, as described in RFC2554. If such authentication is not needed, the key 
UseAuthentication is set to false. If this key is set to true, two additional keys 
Username and Password must also be specified for the e-mail account.  
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APPENDIX B – Data File Viewer 

B.1 Quick Start Guide 
The following sections introduce the user to all functionalities of the Data File 
Viewer in detail. This section describes the most common, simple use case. 

The Data File Viewer software allows the user to concatenate multiple one-hour 
files into one larger file, enabling the user to observe trends over several days of 
measurements. 

1. To start, translate the UserData files from DAT to H5. The Batch Convert 
option (B) allows users to select any folder containing instrument data 
from a given day. 

  

Figure 85: Batch Convert DAT to H5 – Navigation 
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2. In the source folder there are now copies of the original files translated 
into the H5 format.  

3. From File menu select Concatenate H5 Files (C) to combine the H5 
files into a time series. Take care to select exactly the same folder in the 
file viewer window. 

4. In the Select Variables window, click All to move over all variables for 
concatenation. If concatenating very long records, the user can instead 
select only a few variables by clicking the variable name on the left 
dialogue, and clicking the double arrow button. Confirm by clicking OK. 
(Figure 86). 

 

Figure 86: Selecting Variables for Concatenation 

5. The user will then be asked to confirm the file name for the 
concatenated data. The default location will be in the parent folder for 
the selected day, and the filename will by default describe the time span 
of the measurements within. Successful concatenation will lead to the 
filename automatically being displayed in the main data file viewer 
window. 
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Figure 87: Concatenated Output .h5 Filename 

 
NOTE 

You can concatenate several days into one larger file, either by following steps 
1-3 for selected folders, or by copying all their DAT files into a new folder and 
performing steps 1-5 just once. 

6. With the file now opened, the user can select how many Time Series to 
display on the screen. 

 

Figure 88: Time Series Selection Options 

7. In the new window that appears, select the variables from the Var Name 
dropdown on the right of each plot. Deselect Autoscale y if the data 
stream has a large amount of variability in the Y-axis. 

8. Please read the following sections to learn more about features of the 
Data File Viewer. 
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B.2 Data File Viewer Overview 
The Picarro Data File Viewer software is located on the desktop of the Picarro 
instrument. The software allows the user to graph and to conduct statistical 
analysis of the raw data. Additional functions include Allan Variance plot and 
quadratic or polynomial fittings. The Picarro Data File Viewer includes two main 
menus: File and New (Figure 89).  

 

 

Figure 89: Picarro Data File Viewer – File and New Menus 

B.3 File Menu 
This section describes the functions available from the Data File Viewer File 
menu. 

Open H5 
File > Open H5 File: Opens a Picarro data file (HDF5 format) for data analysis 
and visualization. After opening the data file, you can create a new time series 
plot. Refer to section B.4, New – Time Series Plot for more information. 
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Load Config 
File > Load Config: Loads a configuration file (ini format) to restore parameters 
of a workplace. Refer to Save Configuration on Page 165 for more information. 

Unpack Zip File 
File > Unpack Zip File: Use to concatenate all H5 files inside the zip file into a 
single H5 file. Refer to Concatenate H5 Files below for details. 

Concatenate H5 Files 
File > Concatenate H5 Files: Use to concatenate multiple files and zip archives 
of H5 files into a single H5 file. Navigate to the desired folder or use the Define 
Date Range button to specify a date range of files to concatenate. (See next 
section.) 

After selecting the path of the data files, Data File Viewer will automatically search 
an H5 file in the specified zip/folder and look for all available variables in the H5 
file. The variables are then listed in the Select Variables window in the left panel 
(as shown in Figure 90), and users can use the “>>“ button to move variables to 
the right panel for concatenation.  

 
Note: This screenshot is for example only. The species selections shown on your analyzer 
may vary.  

Figure 90: Select Variables Form 
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Define Date Range 
Data File Viewer can search data files within the desired date range and then 
concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were taken 
elsewhere, select the time zone where data were taken. 

Select File > Concatenate H5 Files, then click Define Date Range to specify the 
desired date range as shown in Figure 91.  

 

Figure 91: Define Date Range Dialog 

Data files are saved in directory trees named by date and time option.  

Picarro software saves data in a directory tree that is named by the creation year, 
month, and day as shown in Figure 91. Select this option if the target folder has 
this file structure. This way, Data File Viewer will only search folders within the 
desired date range, which can substantially reduce processing time.  

 

Figure 92: File Structure of Data File Viewer 
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NOTE 

To save processing time, Data File Viewer does not open data files, but only 
determines data acquisition time based on the file name. 

 

  
CAUTION 

Do not define a time range for data files whose names have been changed. 

 

  
NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range, so the resulting dataset normally has a wider time range 
than the user specification. 

Convert DAT to H5 
Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 format. 
These formats are described below: 

• DAT format: DAT files accepted by DatViewer store tabular data (numbers 
and text) in plain text. 

• Each line of the file is a data record. Each record consists of one or more 
fields separated by whitespaces. 

• The first line of the data file indicates column names. 

• There must be a field “EPOCH_TIME” to store the acquisition epoch time 
(expressed as seconds since Jan 1, 1970) of the data. Otherwise, the first 
and second fields must be “DATE” and “TIME.” The “DATE” field must 
have the format “mm/dd/yyyy” or “yyyy-mm-dd,” and the “TIME” field must 
have the format “HH:MM:SS(.sss)” where (.sss) is an optional fraction of 
seconds. 

• HDF5 Format: HDF5 is a data model, library, and file format for storing 
and managing data. (See the HDF5 Home Page on the HDF Group 
website https://www.hdfgroup.org/ for more information.) When converting 
DAT to HDF5 format, Data File Viewer creates a table named “results” to 
the contained data. 

  

https://www.hdfgroup.org/
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Convert H5 to DAT 
Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. 
These formats are described in Convert DAT to H5. 

   
NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range.  

Interpolation 
Interpolation describes the method for constructing data points with a range of a 
discrete set of known data points. Select File > Interpolation to perform 
interpolation on a time grid with a constant interval. 

Block Average 
Select File > Block Average to divide a dataset into small blocks based on a 
user-defined block size. The average is calculated for data in each block, and the 
results are saved in a new H5 file. 

  
NOTE 

The specified block size must be greater than the average data interval. 

Because the data interval is normally not a constant (unless interpolation is 
performed), fluctuations in the data interval will affect block averaging if the block 
size is comparable to the average data interval. 
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B.4 Time Series Plot 
You can create a time-series plots with one, two, or three frames. The additional 
plots display in the Time Series Viewer.  

 
Note: This screenshot is for example only. The species shown on your analyzer may vary. 

Figure 93: Time Series Viewer 

The next section describes the options available on the Time Series Viewer menu 
bar. Refer to The Time Series Viewer Canvas on Page 89 for more information on 
the Time Series Viewer UI features and options. 

B.5 Time Series Viewer Menus 
The Time Series Viewer form includes the following menus:  

 

Figure 94: Time Series Viewer Menus 
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Time Series Viewer File Menu 
Use the File menu to save a configuration or take a screenshot.  

 

Figure 95: Time Series Viewer – File Menu 

Save Configuration 
Click File > Save Configuration to open the Feature Capture form. With this 
form, you can save figure properties, expressions, filters, and other settings to a 
configuration file so that it can be easily loaded in the future.  

 

Figure 96: Time Series Viewer – Feature Capture 

  
CAUTION 

If a feature is not captured, it will be omitted when the configuration file is 
loaded. 

Depending on the features captured, loading a configuration file can have different 
effects. For example: 

• If all features are captured, a saved workplace is reproduced. 

• If Data file is not captured, saved parameters will be applied to the data file 
in memory. 

• If Expression is not captured, plots will not be transformed. 

• If X (Y) range is not captured, figures will be auto-scaled on the x (y) axis. 

Take Screenshot 
Use File > Take ScreenShot to take a screenshot of the Time Series Viewer and 
save it as a .png to a specified file. 
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Time Series Viewer Analysis Menu 
Use the Analysis menu to calculate statistics, generate a histogram, and to plot 
correlations and Allan Standard deviations.  

 

Figure 97: Time Series Viewer – Analysis Menu 

Statistics 
Use Analysis > Statistics to calculate mean, standard deviation, and peak to 
peak for all plots in the current window. 

Histogram 
Use Analysis > Histogram to generate a histogram of data as shown in Figure 
98 below.  

 

Figure 98: Histogram Window – CH4 
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Histogram Window Features 

• Red Line: A Gaussian function fitted to the histogram. Fitting results of μ 
and σ are shown in the top-left corner of the plot. 

• Bin: Specifies the number of intervals that the range of values is divided 
into. 

• Normalized: When selected, the sum of the histograms is normalized 
to 1. 

• Save data: Saves histogram data to a CSV file. 

• Save image: Saves the histogram image as a JPEG/PNG/PDF file. 

Correlation Plot 
Use Analysis > Correlation Plot to plot Y-axis data in one frame versus that in 
the other. This can be used when two or more frames exist in the current Time 
Series Plot window. See the section, Correlation Plot on Page 167 for details. 

Allan Standard Deviation Plot 
Use Analysis > Allan Standard Deviation Plot to create an Allan Standard 
Deviation plot (versus a standard deviation plot) for data in the current window. 
See Allan Variance Wikipedia page for more information. 

Time Series Viewer View Menu 
Use the View menu to view X-axis information in date-time, minute, or hour 
format.  

 

Figure 99: Time Series Viewer – View Menu 

 

  
NOTE 

When switching from Datetime to Minute or Hour, the X-axis data is subtracted 
from the earliest point shown in the panel and then converted to the desired 
unit. 

The Time Series Viewer Canvas 
The Time Series Viewer canvas (Figure 100 below) is comprised of interactive 
graphs and a variety of configuration options. 

https://en.wikipedia.org/wiki/Allan_variance
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Mouse Options and Graph Transform 
The following mouse actions can be used in the canvas graphs: 

• Left click and drag: Zooms into the selected area of the plot. 

• Left click and drag with the SHIFT key down: Pans the plot. 

• Left click and drag with CTRL key down: Zooms out from the plot. 

• Left click and drag with ALT key down: Stretches the plot. 

• Right-click: Opens an additional menu. Refer to the Right-click Menu 
below in the next section. 

 
Note: this screenshot is for example only. The species shown on your analyzer may vary. 

Figure 100: Time Series Viewer Canvas 

Right-click Menu 
Right-clicking on the canvas opens a pop-up menu:  

 

Figure 101: Canvas Right-click Pop-up Menu 
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Export Image: Exports the current plot as a jpeg, png, or pdf file. 

Export Data in Current View: Exports only date/time and the selected variable in 
the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range: Exports all variable columns of the 
selected dataset in the current time range to an HDF5 file. Refer to Concatenate 
H5 Files on Page 81 for more information. 

Edit Plot properties: Opens the Image Editor form (Figure 102 below), where 
the following options can be specified. 

 

Figure 102: Image Editor Form 

Image Editor Form Options: 

• Title: Edits the title of the plot. 

• Line: Specifies the line pattern of the plot. If None is selected, the data 
points will be plotted without connecting lines. 

• Marker: Specifies the marker type to indicate data points. If None is 
selected, data points will not be shown. 

• x-Axis: Min and Max: Specifies the minimum and maximum of date range 
for the X-axis. 

• x[0]: Sets the earliest time of the dataset as the minimum of the X-axis. 

• Time zone: Sets the time zone for date/time variables. This defaults to the 
local time zone. 

• Label: Specify labels for the X-axis and the Y-axis. 

• y-Axis: Min and Max: Specifies the minimum and maximum of data 
displayed on the Y-axis. 
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Dataset Name and Var Name 
An HDF5 file can store one or more tables. Each of these tables is called a 
Dataset. A table can contain one or more columns. Each column is called a 
variable (Var). 

Use the Dataset name drop down (Figure 103) to select the dataset that will be 
used for this time series graph. Use the Var name drop down to select the column 
in the dataset to use in the graph. 

 

Figure 103: Time Series Viewer Dataset Options 

Autoscale Y 
When the Autoscale Y option is selected, the Time Series Viewer will autoscale 
on the Y-axis to make sure that all data within the range of the X axis is displayed. 
This feature can make it hard to see small signals when large signals blow the Y 
axis out, so it is often advisable to deselect this checkbox for dynamic or spikey 
datasets. 

Average 
If Block is selected, a block average is calculated when you click the Do average 
button. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a moving 
average, Size specifies subset size in unit of data points.  

 
REMINDER 

Averaging is performed after the Filter and Expression are performed. 
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Mean, Std Dev, and Peak to Peak 
The Mean, Std dev (Standard deviation) and Peak to peak fields (Figure 103) 
provide all the statistical information of data in the current view. 

Correlation/XY Plot 
The Correlation/XY Plot window (Figure 104) includes two menu items: File and 
Analysis. For details about the File menu, see Save Configuration on page 165. 

 
REMINDER 

The canvas in this plot is interactive. For details about the plot canvas, see The 
Time Series Viewer Canvas on Page 167. 

 

 

Figure 104: Correlation XY Plot 
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Analysis Menu 
The Analysis Menu (Figure 105) includes three options: Fitting, Integration, and 
Statistics. 

Fitting allows you to specify one of four fitting methods to include in the 
Correlation/XY plot: 

1. Linear fit: Specifies to fit to linear function: 

y = c1x + c0 

2. Quadratic fit: Specifies to fit to quadratic function:  

y = c2x2 + c1x + c0 

3. Polynomial fit: Specifies to fit polynomial function of degree n:  

y = Σcnxn 

4. Curve fit: Specifies to use non-linear least squares to fit an arbitrary 
function to data.  

 

Figure 105: Analysis Menu 

Integration calculates area under the curve using the composite trapezoidal rule. 

Statistics calculates mean, standard deviation, and peak to peak for data in the 
current view.  

After applying any of the above Analysis options, the results, statistics, or fitting 
function with coefficients are displayed in the lower portion of the Correlation Plot 
window (Figure 106).  

 

Figure 106: Results of Quadratic Fitting 
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APPENDIX C – Introduction to CRDS 
Technology 

Picarro analyzers use time-based, optical absorption spectroscopy of the target gases to 
determine concentration in a sample. They are based on wavelength-scanned cavity 
ring-down spectroscopy (WS-CRDS), a technology in which light travels many times 
through the sample, creating a very long effective path length for the light to interact with 
the target gas, thus enabling excellent detection sensitivity in a compact and rugged 
instrument.  

The Picarro analyzer is comprised of two modules: 

• The analyzer contains the spectrometer, sample chamber, and a computer with a 
hard drive to store and analyze data. The single analyzer module controls the 
operation of the system and converts spectroscopic measurements into gas 
concentration data. 

• The External Vacuum Pump draws the sample gas through the instrument. 

C.1 Cavity Ring-Down Spectroscopy (CRDS) 
Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) uniquely 
absorbs specific wavelengths of near-infrared light. The strength of the light 
absorption is related to the concentration of a molecule in a sample and the 
distance that light travels through the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to detect 
trace gases at levels in the part-per-million. Cavity Ring-Down Spectroscopy 
(CRDS), on the other hand, is one thousand to one million more times sensitive.  

The increased sensitivity of CRDS is due to the design of the sample cavity and 
the time-based measurement. In the cavity, a series of mirrors reflects the infrared 
light through the sample, increasing the path length. For a Picarro cavity of only 
25 cm in length, the effective path length of the cavity can be over 20 kilometers.  

In Picarro analyzers, light from a single-frequency laser enters a cavity where 
three mirrors reflect the laser light as seen in Figure 111. The light enters through 
the mirror closest to the laser, bounces off the angled mirror in the lower right 
corner of the cavity, travels to the hemispherical mirror at the top of the cavity, 
bounces toward the mirror in the lower left corner of the cavity, and then returns to 
the first mirror. This motion becomes a continuous traveling light wave, which is 
represented by the dark orange path in Figure 111. 
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Figure 107: Schematic of Picarro CRDS Analyzer Cavity 

When the laser is on, the cavity quickly fills with laser light. A small amount of the 
laser light is transmitted through the mirror closest to the photodetector, which 
turns the incident light into a signal that is directly proportional to the light intensity 
in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 
microseconds), the laser is turned off. The light contained within the cavity 
continues to bounce between the mirrors (about 40,000 times). Since the mirrors 
have slightly less than 100% reflectivity (99.999%), the light inside the cavity 
steadily leaks out of the cavity. The intensity of the light reaching the detector 
decreases, falling exponentially until it reaches zero. This decay, or “ring-down,” is 
measured in real time by the photodetector. 

C.2 Relating Ring-Down Time to Absorption 
Intensity 

The time it takes to ring-down is inversely related to the total optical loss in the 
cavity, including the strength of molecular absorption at a given wavelength of 
light. For an empty cavity, the time it takes for the intensity to decrease by a given 
percent is determined solely by the reflectivity of the mirrors. A cavity containing 
gas that absorbs light will have a shorter ring-down time than an empty cavity. As 
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the light circulates in a cavity with a gas sample, the molecular absorption by the 
gas results in a decrease of the light intensity. 

Determining absorption intensity at a specific wavelength requires comparing the 
ring-down time of an empty cavity to the ring-down time of a cavity that contains 
gas (Figure 112). A cavity can be empty if it contains no gas; it will also appear 
empty if the molecules of the sample inside the cavity do not interact with the 
specific wavelength of light.  

Picarro instruments gather measurements from an “empty” cavity by switching the 
light to wavelengths that are not absorbed by the target molecules. The analyzer 
subsequently measures ring-down times at wavelengths that are absorbed by the 
target gas. The analyzer automatically and continuously compares these two 
types of ring-down times, and the software uses those comparisons to calculate 
absorption intensities. 

 

Figure 108: Light Intensity as Function of Time in CRDS System 

C.3 Converting Absorption Intensity to 
Concentration 

Plotting the absorbance at each measured wavelength generates an optical 
spectrum. This spectrum contains absorbance peaks that are unique to each 
molecule in the sample. The height of a particular absorption peak is proportional 
to the concentration of a molecule that generated the signal.  
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The height of the peak is calculated by subtracting the maximal absorbance from 
the baseline absorbance. Figure 73 shows a plot of ideal optical spectra with a 
clean, uniform baseline on either side of the absorption peak. 

 

Figure 109: Absorption Spectral Curve 

However, optical spectra often contain several absorption lines, nested closely 
together. A particular absorption peak may be visible between lines, but the 
absorption may not return to the baseline before it rises in response to another 
molecule.  

Picarro analyzers calculate the baseline underneath a poorly resolved peak by 
modeling the absorption peaks from other surrounding molecules and subtracting 
contributions from neighboring peaks to the absorption intensity.  

C.4 Spectral Precision and High Sensitivity 
Measurements 

Picarro analyzers contain two features that provide high spectral precision:  

• A proprietary wavelength monitor (WLM) that measures the absolute laser 
wavelength to a precision that is a few orders of magnitude narrower than 
the spectral linewidth: Picarro’s patented WLM measures absolute laser 
wavelength to a precision more than 1,000 times narrower than the 
observed Doppler-broadened linewidth for small gas-phase molecules. 
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The instruments lock the laser to the WLM, and then the monitor tunes to 
wavelengths known to be maximally and minimally absorbed by the target 
molecule. The result is closely clustered absorption intensities, measured 
at wavelengths just before peak absorption, at peak absorption, and just 
after peak absorption, as the absorbance returns to the baseline.  

• Precise temperature and pressure control in the sample cavity: Accurate 
absorption measurements at precisely known wavelengths account for 
little unless the temperature and pressure of the CRDS measurement 
cavity are known. The observed line intensity and shape depend on the 
temperature and pressure inside the sample cavity. Small temperature 
and pressure instabilities can result in large concentration errors due to 
fluctuating peak heights and baselines. To completely minimize instrument 
measurement drift, temperature and pressure must be actively stabilized 
to constant values.  

For precise temperature control, the sample cavity is surrounded by layers of 
thermally insulating material to provide a high degree of passive thermal stability. 
The cavity is further actively stabilized by means of a solid-state heating system 
locked to the output of a thermal sensor. This enables the temperature of the 
cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-
linearity pressure transducer. The system computer uses this pressure data in a 
feedback loop to control proportional valves that adjust the inlet and outlet gas 
flow of the cavity. 
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APPENDIX D – Limited Warranty 
Picarro, Inc. warrants its Products to be free from defects in material and workmanship 
and to perform in the manner and under the conditions specified in the Product 
specifications for twelve (12) months from shipment. 

This warranty is the only warranty made by Picarro with respect to its Products and no 
person is authorized to bind Picarro for any obligations or liabilities beyond this warranty 
in connection with its Products. This warranty is made to the original Purchaser only, is 
non-transferable and may only be modified or amended by a written instrument signed 
by a duly authorized officer of Picarro. Sub-systems manufactured by other firms, but 
integrated into Picarro Products, are covered by the original manufacturer’s warranty 
and Picarro makes no warranty, express or implied, regarding such sub-systems. 
Products or parts thereof which are replaced or repaired under this warranty are 
warranted only for the remaining, un-expired portion of the original warranty period 
applicable to the specific Product replaced or repaired. 

WARRANTY DISCLAIMER 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL, OR IMPLIED, AND SHALL BE THE 
PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN CONTRACT 
OR OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product shall be to have 
Picarro repair or replace such defective Product or credit the Purchaser’s account, 
whichever Picarro may elect in its sole discretion. If it is found that any Product has been 
returned which is not defective, the Purchaser will be notified, and such Product returned 
at the Purchaser’s expense. In addition, a charge for testing and examination may, at 
Picarro’s sole discretion, be made on any Product so returned. 

These remedies are available only if: 1) Picarro is notified in writing by the Purchaser 
promptly upon discovery of a Product defect, and in any event within the warranty 
period; 2) Picarro’s examination of such Product discloses to Picarro’s satisfaction that 
such defects actually exist and the Product has not been repaired, worked on, altered by 
persons not authorized by Picarro, subject to misuse, negligence or accident, or 
connected, installed, used or adjusted otherwise than in accordance with the instructions 
furnished by Picarro. 

The following warranty conditions shall apply to all Picarro, Inc. products unless 
amended by a written instrument signed by a duly authorized officer of Picarro: 

ADJUSTMENT – No electrical, mechanical, or optical adjustments to the product(s) are 
permitted. 

PARTS AND LABOR - New or factory-built replacements for defective parts will be 
supplied for twelve (12) months from date of shipment of the product. Replacement parts 
are warranted for the remaining portion of the original warranty period. There will be no 
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charge for repair of products under warranty where the repair work is done by Picarro, 
Inc.  

NOT COVERED BY THE WARRANTY – Damage to any optical surface from improper 
handling or cleaning procedures. This applies specifically to those items subjected to 
excess laser radiation, contaminated environments, extreme temperature, or abrasive 
cleaning. Damage due to ESD, abuse, misuse, improper installation or application, 
alteration, accident, negligence in use, improper storage, transportation, or handling. No 
warranty shall apply where the original equipment identifications have been removed, 
defaced, altered or where there is any evidence of alterations, adjustments, removal of 
protective outer enclosure, any attempt to repair the product by unauthorized personnel 
or with parts other than those provided by Picarro, Inc.  

DAMAGE IN SHIPMENT - Your analyzer should be inspected and tested as soon as it is 
received. The product is packaged for safe delivery. If the product is damaged in any 
way, you should immediately file a claim with the carrier or, if insured separately, with 
the insurance company. Picarro, Inc. will not be responsible for damage sustained in 
shipment. All Picarro products are F.O.B. origin, shipped from the Picarro factory or 
Picarro distributor. The price of all Products, unless otherwise specifically stated, is Ex- 
Works, Sunnyvale, CA as defined by Incoterms, 2020. The cost of normal packaging for 
shipment is included in the invoiced price. Where Buyer specifies special packaging, a 
charge will be made to cover any extra expense. 

CLAIMS ASSISTANCE - Call Picarro, Inc. Customer Service or your local distributor for 
assistance. Give our representative the full details of the problem. Helpful information or 
shipping instructions will be provided. If requested, estimates of the charges for non-
warranty or other service work will be supplied before work begins. 

RETURN PROCEDURE - Customers must obtain a Return Merchandise Authorization 
Number from Picarro, Inc. prior to returning units. Products being returned for repair 
must be shipped in their original shipping cartons to avoid damage. 



 

 

 
 
 

 
 
 

 
About Picarro 
Picarro is a leading provider of solutions to measure greenhouse gas (GHG) concentrations, 
trace gases, and stable isotopes across many scientific applications, along with the energy and 
utilities markets. Our patented Cavity Ring-Down Spectroscopy (CRDS) is at the heart of all 
Picarro instruments and solutions, enabling the detection of target molecules at part per billion or 
better resolution. 

Product Support 
Utilize Picarro support resources for product support. Join the Picarro community to ask 
questions and get answers, search the document library for datasheets and user manuals, 
download software, and purchase products and replacement parts.  

 

Access to online User Manuals is available to all registered Picarro customers with 
login credentials. If you do not yet have an account, please email us at 
support@picarro.com to request access. Note must be a registered user and logged in 
to access the following resources: 

• Picarro Document Library 

• Picarro Community (Forums) 

• Picarro Software Downloads 

• Picarro Literature (Scientific Resources) 

• Picarro Web Store 

 
Contact Picarro for questions regarding specific applications and additional information. 

Customer Support – Environmental 

USA  International 

Email: support@picarro.com   Email: support@picarro.com 

Phone: + 1 408 962 3991  Phone: +31 85 888 1650 

 

https://www.picarro.com/support/documents
https://www.picarro.com/support/community
https://www.picarro.com/support/downloads
https://www.picarro.com/support/literature
https://www.picarro.com/support/literature
mailto:support@picarro.com
mailto:support@picarro.com
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